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1 Introduction 
The DesignBuilder software is an advanced graphical user interface that has been 
specially developed to run EnergyPlus simulations. For UK and Republic of Ireland 
users the DesignBuilder interface can also be used to produce Energy Performance 
Certificates (EPCs) and to show compliance with the Building Regulations. 

Overview 
This Training Manual will guide you through the basic of using DesignBuilder with a 
view to promoting understanding of the software. It is intended that you work your 
way through the material from the beginning to the end sequentially because some of 
the explanations and worked examples build on models created in earlier examples. It 
is not intended to be an exhaustive source of information on the software. You should 
refer to the program help at www.designbuilder.com/helpv1 for more 
‘encyclopaedic’ documentation. 

http://www.designbuilder.com/helpv1
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2 DesignBuilder Interface 
 

2.1 Opening screen 
The opening screen has three tabs – Recent Files, Component Libraries and 
Template Libraries.  

Recent Files: This tab lists the recently used files. Double-click on one to open it.  

Component Libraries: This tab lists the components available. Components 
represent individual building elements such as constructions, glazing and materials 
and can be referenced from other components, templates or model data.  

Template Libraries: Templates are used as a source of generic data for loading into 
building models. For example, construction templates provide data on the 
construction of external walls, roofs, floors, partitions, roofs etc and air-tightness data.  

Library Components and Templates are loaded into the model at the time the file is 
created and from then on they are associated specifically with the model and so are 
known as Model components and templates. Any later change made to the Library 
components or templates do not affect existing building models because they 
reference their own set of components and templates.  

In general, the contents of the templates, for example constructions, loaded into the 
model must be edited to represent the systems, structures etc for the actual building. 

This is best done by first making a copy of the template using the copy tool  in the 

tool bar, renaming it and then editing the content using the edit tool . 

More information is given on Templates and Components later.  

Learning mode: In Learning mode, the right hand panel displays useful information 
and common task operations relevant to the current screen. It is recommended that 
new users leave learning mode on until they are familiar with the program at which 
point it can be turned off by going to Tools > Program options... and deselecting 
Learning. 

Instructions in the training assume that you have Learning mode switched on. 

Tutorials : This appears in the right hand panel. Click on it to access the tutorial. It is 
recommended that users view the tutorial before coming on the training course. You 
must be connected to the Internet to access the tutorials. 

Help: Use the toolbar Help to select one of the help options, or press F1 while in the 
program to bring up relevant help. There is also a search facility in the index. 

By default DesignBuilder uses the WebHelp format, which requires an Internet 
connection, but you change to using a Local help system in the Program options. You 
will need an Internet connection to download the local help the first time and 
thereafter you can use the help without.
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3 Create Building Geometry 
This chapter explains how to create a building geometry using drawing blocks. 

Create a new project 
Select File > New Project to add a new project. This opens a new window with two 
tabs: 

Location tab 
• Click in the Untitled box, and enter the project title. 

• Click on the arrow by the default location box. Select the location from the list  
that appears. 

• Set analysis type to EnergyPlus 

Template tab  
Shows a list of existing template models that can be used as the basis for the new 
project you are creating.  

Leave default Blank for a completely new site, or select one of the template buildings 
if you wish to base the new project on an existing model (to load an example building 
for example). 

Click OK. The file loads and opens in a split screen. Note the new tool bar. 

Add a building 
A building can be created with or without reference to a 2-D drawing file created from 
a CAD system or by scanning a plan of the building. In either case, the building 
geometry is defined by entering one or more blocks. 

Click on the Add building toolbar button or click on Add building in the right hand 
Info pane, to add a new building. A screen will appear requiring data to be entered 
under a number of headings. 

Note that for the Add building buttons to be available, you must be in the top Site 
level of the Navigator, Site option in Navigator on the left hand side of the screen.  

Provide the information required under each of the headings on the Building tab. 

• Model type: select the appropriate model type from the list in the right hand 
pane – this can be changed later 

• Project details: The details required may vary from country to country. 

• Assessor details: Enter details as required, requirements may vary form 
country to country 

• Occupier details: enter occupier details here 
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On the Default data tab you can select templates to be used as an initial source of 
default data to load into the new building. You do not need to make any settings here 
as you can load data from template later.  

Click on the OK button to add the building. 

Note that the program automatically activates the Draw Block tool and the Drawing 
Option panel appears in the lower right hand corner of the screen. You can start 
drawing the first block in the building right away.  
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4 Drawing Options 
Use the Drawing Options panel in the lower left hand corner of the screen to set the 
block type, form, height and wall thickness. It is important that the wall thickness is 
set before drawing the block as it is used to calculate the internal dimensions used in 
the calculations. However wall thickness can be reset after the block has been created 
by first selecting the block from the navigation pane and then going to model options 
which will automatically open in the block tab to allow the wall thickness to be 
changed. We are now ready to add a block using the drawing tool in the middle pane. 

 

 

 

There are three Block types: 

• Building Blocks are used to create the model. 

• Outline Blocks are used to help in the creation of the building and do not 
affect the model. 

• Component Blocks are used to create visual and shading structures, ground 
structures and neighbouring buildings. 

See help under block type for illustrations. 

Block form 

• Extruded block form  is probably the most useful. A general extrusion block 
can be created by drawing a perimeter using a number of pre-defined shapes 
and then extruding the perimeter by whatever distance is required. Extrusions 
in both horizontal and vertical planes (or even in sloped planes) can be created 
using the polygon perimeter shape. 

• Sloping walls block form is used to create blocks on horizontal planes with 
uniformly sloping walls. Sloping wall blocks can be created using any 
perimeter shape (polygon, rectangle or circle). 

• Pitched roof block form automatically generates a pitched roof from a 
perimeter drawn on a horizontal plane. Pitched roof blocks can be created 
using any perimeter shape (polygon, rectangle or circle): 
The slope of the roof is defined using the Roof slope setting in the Drawing 
options data panel. A pitched roof can be created with hips or gable ends using 
the Gable Roof setting:when a pitched roof is drawn on top of an existing 
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block, the overhang or the depth of the roof eaves can be set using the Roof 
overlap setting. 

• Dome block form is used to create hemispherical blocks and can only be 
created using the circular perimeter shape. 

Block height – Defining block dimensions 

 

 

 

The block height is the same as the floor-to-floor height, also referred to as the zone 
height. For the top floor, the block height is from the underside of the floor slab to the 
underside of the ceiling or roof slab. For the ground floor the height should be 
measured for the ground surface to the underside of the floor slab above as illustrated.  

Block widths in DesignBuilder are from an outside surface of an outer wall to the 
outside surface of another outer wall or to the mid-point of an internal partition wall. 
DesignBuilder uses the wall thickness to calculate internal dimensions and it is 
therefore important that the correct wall thickness is specified before creating a block. 

Enter the block height in the Height box in the Drawing Options panel. The height of 
a block can be changed later using the Stretch or Drag Face tool. 
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Wall thickness 

The wall thickness is used to generate the geometric thickness of the external wall 
elements of a building block. It is a significant parameter because zones are generated 
from the internal dimensions of the block which are derived from the external block 
geometry and the block wall thickness. Therefore, the value of wall thickness used 
influences the size and shape of zones, especially roof zones (see tip below). 

The default setting is automatically generated from the overall thickness of the 
external wall construction set in the Construction Model data panel but can be 
overridden by typing in the required value. The constructions that determine the 
thermal characteristics of the walls can be edited in the Constructions Model data 
panel without changing the wall thickness used for determining internal dimensions. 

The wall thickness is uniform for all surfaces in a particular block, though each block 
can have a different wall thickness. 

The wall thickness does not affect the thermal properties of the wall. Wall thermal 
properties are based purely on the construction data specified for the wall. The wall 
thickness is also entered when converting an Outline block to a Building block. 

Tip: Enter a low value of wall thickness if: 

The block is a roof with a low roof slope angle sloping roof elements. Using a Wall 
thickness 0f 0.01m (the lowest allowed) gives good results as the roof zone covers 
most of the block floor area  

The block is mainly glazed. A small wall thickness gives rise to a small corner 
column, allowing the glazing to cover most of the wall. 

You wish to work with internal block dimensions. 

 

See examples in help under Wall thickness. 

Perimeter 

Blocks are generally created by drawing a perimeter and extruding it to the required 
height or length. 

• Polygon allows multi-sided blocks to be drawn and is the most useful general 
form. 

• Rectangle allows rectangle to be drawn with a click and drag action. 

• Circle allows circle to be drawn with a click and drag action. 

Line type 

There are two line types: 

• Straight line – default straight line 

• Arc  – can specify sweep angle and number of segments to approximate an arc 
with a series of straight lines. 

 

Using the drawing tools 
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To add or create a new block, click on the Add new block tool. The Add new block 
tool is automatically activated, if a new building has just been created. A block is 
most easily created by drawing the base perimeter of the block using one of the 
perimeter shapes such as a polygon. 

The dimensions of the block are those measured from the outside, the height of the 
block is the floor-to-floor height. Once the perimeter is completed by snapping on to 
the start point, (a green square appears as shown below) the block is automatically 
generated. The block construction, glazing and HVAC will be those set in the default 
templates based on the age and type of building. 

  

The building model is built up by adding blocks. These can be added using the 
drawing tool as above but there are other tools which can be used to speed up the 
process. 

Direction snaps 

In the Drawing Options panel, open the dialog box for Direction Snaps. 

 

 

The axis snap check boxes are displayed under Direction Snaps in the Drawing 
Options data panel when the various drawing commands are active. The axis snap is 
used to draw lines parallel with the major axes of the active drawing plane.  

As you move the cursor around to draw a line, the line changes colour to that of the 
axis to which it is parallel and stick slightly. 

See help on axis snap for a full description of all the features. 
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Point snaps 

In the Drawing Options panel, open the dialog box for Point Snaps. 

 
End point snap snaps lines to the end-point of an existing edge. A green indicator is 
displayed when the mouse cursor is within the snap range of an end-point. 

Mid-point snap snaps lines to the mid-point of an existing edge. A light blue 
indicator is displayed when the mouse cursor is within the snap range of an end-point. 

Edge snap snaps to any point on the edge of an existing object. The edge snap can be 
used in conjunction with the increment snap to enable a point to be located along an 
edge by moving it in defined increments. A red indicator is displayed when the mouse 
cursor is within the snap range of an edge and distance indicators are also displayed to 
help in locating a point a specific distance from either end of the edge. 

DXF snap only applies when DXF snap has been imported from an external file. The 
DXF snap snaps to the end-points of DXF lines. 

Increment snap applies to any process that involves moving a point or a surface in a 
particular direction. Such processes include drawing block partitions or perimeter 
lines which have an active direction snap or dragging the surface of a block normal 
to the original surface position. The increment snap moves a point in a particular 
direction by defined increments. You can think of the increment snap as acting in the 
same way as a conventional CAD drawing grid. In fact if you were just to use the axis 
snaps it would have the same effect, however the increment snap is more powerful in 
that it provides this type of incremental snap along any defined vector not just the axis 
vectors. 

Drawing guides 

In the Drawing Options panel, open the dialog box for Drawing Guides. 

 
The X- and Y-axes drawing guides are best left selected as they help to complete 
rectangular blocks by showing a construction line parallel to an axis to place the final 
wall so that it connects with the starting point. 

Cloning tool 

 

• Go to the building level in the navigation menu and then select the block to be 
cloned by clicking on it – it turns pink.  
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• Select the clone tool. 
The Drawing options menu appears.  

• Check that the point snaps are turned on. 

• Hover the cross hairs over a convenient corner at the bottom of the selected 
block until the green snap indicator appears, then click.  

• Move the cross hair to the top corner and hover until green snap appears, then 
click. 
A clone of the selected block is added on top of the selected block. 

In this way a multi storey building can be quickly built up, but note that if storeys 
have similar internal partitions it would save time to insert the partitions in the lower 
storey. 

The Clone tool can also be used to copy other objects such as internal partitions, 
courtyards and surface openings. 

See help under move. 

Stretch tool 

 
Building, outline and component blocks can be stretched (or scaled) at the building 
level. To stretch a block: 

Select the block. 

• Click on the Stretch tool or select Stretch from the right-click menu. 
Only one block can be stretched at a time. When the Stretch tool is activated, a 
wire frame is displayed around the extent of the block and as the cursor is 
moved across the faces of this frame, each face is highlighted in the colour of 
the axis to which the face is normal. 

• Click on one of these highlighted faces, to stretch the block along the axis 
normal to the face. If the increment snap is switched on, the block can be 
stretched in increments. This is useful for re-setting the height of a block that 
has been cloned, and for stretching a circular block into an elliptical one. 

See help under stretch. 

Drag face 

 
The topology of a block can be edited using the Drag face tool which allows you to 
select a block surface and drag it along an axis, normal to the surface. To edit a block 
topology: 

• Select the block to modify. 

• set increment snap to 0.1m 

• Click on the Drag face tool. 
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• Move the mouse cursor to the surface to be moved. 
As the cursor is moved across the block surfaces, each surface is highlighted 
to help in selecting the required surface. 

• When the mouse cursor is over the required surface, click to start dragging it: 

• Drag the surface using the mouse and click again or key-in the distance to shift 
the surface by the required amount. 

See help under drag face. 

Cut block along plane 

 

Blocks can be cut using the Cutting Tool. Blocks are divided using a plane which is 
defined using one of two methods: 

• Draw plane – the plane is defined by clicking on 3 points. 

• Select plane – the plane is defined by selecting an existing plane in the model. 

See help under cut block for comprehensive instructions. 

This tool is particularly useful for creating complex roof geometries where different 
roof shapes intersect. As the geometry is complex it is recommended that outline 
blocks are used with polygon selected as the perimeter. The outline block can be 
converted to a building block when the cutting process is complete. In some 
circumstances, resulting blocks may not be able to be converted to building blocks 
due to geometrical limitations. In this case, the block is displayed in a sepia colour to 
indicate that it cannot be converted. 

See also Using outline blocks below. 

Draw void perimeter (courtyard tool) 

 

To create an external courtyard within a block: 

• Go to the required block by clicking on the navigator entry or double-clicking 
the block in the Edit screen. 

• Click on the Draw void perimeter tool. 
 

The perimeter shape and required wall thickness are set in the Drawing Options data 
panel. 

Adding roof block 

The four different forms of blocks are listed in earlier. For other than flat roofs, it may 
be convenient to use either the sloping wall block form or the pitched roof block form 
to add a roof block. In each case the roof is automatically generated from a perimeter 
drawn on a horizontal plane. The roof space may be occupied and therefore assume to 
be conditioned or it may be unoccupied and therefore assume to be unconditioned. 
 
When the pitched roof form is selected in the drawing option, there is an option to tick 
the box for ‘Roofspace occupied’ or to leave this blank for an unoccupied space. 
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Note that this option is only used at the point the block is first created. To change the 
nature (heated/unheated) of an existing block use the Zone type data on the Activity 
tab of the block. 
 
If the sloping wall block form is selected it will be necessary to open the activity tab 
and set the zone type to ‘Standard’ for an occupied roof space or to ‘Semi exterior 
unconditioned’ for an unoccupied roof space. 
 

Tip : In some cases when drawing roof blocks it is best to set wall thickness to 
0.01m.  

Using outline blocks 

An outline block is created and edited in exactly the same way as a building block 
but is just a 3-D shape without associated building elements such as walls, floors, 
roofs, etc.  
  
Because outline blocks are not part of the model they do not appear in the Navigator 
panel and in visualisations. 
 
Outline blocks are very useful in the creation of more complicated models especially 
complex roof geometries. Because they are relatively simple objects, they are much 
faster to create, copy, move, etc. than conventional building blocks and can be 
manipulated freely without worrying about intersections. Once the required geometry 
has been established, outline blocks can be converted to conventional blocks. You can 
remove all outline blocks from a model by selecting Remove all outlines from the 
Edit  menu. 
 
For detailed guidance on how to use outline block to create more complex geometries 
see help under Outline blocks. 

Using component blocks 

There are 3 types of component block:  

• Standard - used for shading, reflection and visualisation.  
• Ground - used for setting ground adjacency, shading, reflection and 

visualisation. Ground component blocks can be used as a convenient way to 
set the adjacency of any building block surfaces as being adjacent to ground. 
Particularly useful where part of a building may be below ground level 

• Adiabatic - used for setting adiabatic adjacency, shading, reflection and 
visualisation. Adiabatic component blocks can be used as a convenient way to 
set the adjacency of any building block surfaces to 'adiabatic'. Adiabatic 
surfaces do not transfer heat beyond their outer surface and are often used for 
modeling boundaries with other spaces that can be considered to be at roughly 
the same temperature as the zone. For example a party wall between the 
building being modeled and an adjoining occupied building. 
 

For more details on component blocks see help under Component blocks. 
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Construction lines 

 

Construction lines have numerous applications in forming temporary attachment 
points during the creation of precise geometry. To draw a construction line, click on 
the 'Place construction line' tool and start drawing the first line by clicking anywhere 
in the active drawing plane then move the mouse cursor and click to place the line 
end-point, you can use point snaps, direction snaps, drawing guides and the protractor 
to help with alignment. Continue placing construction in this way. If at any time you 
want to cancel the last line that you placed, you can press the ESC key or select 'Undo 
last point' from the right-click menu. 

See help under Drawing Construction Lines for more details 

Measure length and angle 

 

Select the measure tool and set the quantity to be measured in the drawing options 
box. The measure tool allows you measure distance, angles and areas on single planes 
in the model: 

• Distance - Click twice on a plane to define the length between the 2 points. 
• Angle - Click three times on a plane to define the area between the 2 lines. 
• Distance - Draw an enclosed polygon by clicking with the mouse on a single 

plane. 

 The requested data is displayed highlighted in the Drawing Options panel on the left 
of the screen.  

Import 2-D Drawing file 
DesignBuilder allows the building geometry to be loaded from 2-D drawing files as 
DXF files created by CAD systems or scanned images from any other source of 
building plans. Most common formats are supported. All that is required is the 
building outline and internal partitions. It is therefore recommended that where 
possible DXF files are simplified in the CAD environment by turning off unwanted 
layers before exporting the DXF file. Block heights are also required so the Energy 
Assessor may find it useful to mark these on the CAD drawing or a print of the 2-D 
drawing file to refer to when drawing the building blocks. 

• Do not click on add building. 

• Click on import 2-D drawing file and select file type from drop down menu 

• Find the file in the Design Builder Data folder using the browse button … 
It is recommended that 2-D drawing files are saved in this folder as this is the 
default folder accessed by DesignBuilder, but the browser can be used to load  
files from any folder.  

• For DXF files the units need to be set independently. For scanned images see 
scaling instructions below 

• Click on Next. 
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• Turn off unwanted layers in DXF file – be sure to keep all walls – unwanted 
details can be removed later. 

• Click on Finish. 

It will generally be necessary to align scanned images with the XY axes. Select Edit > 
Set axis for imported Bitmap. In plan view, click on both ends of a line that should 
be parallel to the X axis. The plan is then automatically orientated to be parallel to the 
X-axis.  

Now select Edit >Scale bitmap floor plan. Click on both end of a major dimension in 
the plan. A blue line appears with a dimension. If the known dimension is different 
simply type in the known dimension and press enter. The plan is automatically scaled.  

Now click Add building or Add block 

To add a block trace around the 2-D outline: 

• Use the central wheel on the mouse for zoom and orbit 
• Use pan control to move around building 
• Leave point snaps and direction snaps for DXF files on initially. There are no 

snap points for scanned images 

When the perimeter is complete, the block is generated automatically. If there are 
small external details on the DXF plan which are not significant, turn off the DXF 
snap in order to be able to trace across them.  

Tip : It can be easier to switch off DXF snap, especially when drawing 
partitions because it ensures that the partition lines are snapping to the block 
perimeter and not just to a DXF line close to it. 

It is advisable to use the measure tool to check that the dimensions have been properly 
defined. For example, to check that the measurement are in the same units as on the 
original drawing. 
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5 Model Options 
DesignBuilder models can be configured in many different ways and all of the 
settings related to the level of detail plus many calculation, display and drawing tool 
options can be found and changed on the Model options dialog. The model options, 
including the project details referred to above, can be reviewed and edited at any time 
by clicking on the model option icon (the spanner). 

Click on the spanner icon to view the Building model options. 

 

The data tab  
Allows the amount of detail in various aspect of the model to be set using a series of 
slider controls – see below. 

 

 

 

Scope control can be used to switch between 'whole building' and 'single zone' 
modes. 

The Construction and glazing model option controls the way construction templates 
are loaded on the construction model data tab. When the option is set to Pre-design 
you can load construction templates using the Insulation and Thermal mass slider 
controls. When set to General, templates are loaded by selection from a list in the 
usual way. 
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Gains options: 
• Lumped - all internal gains including occupancy, computer, office equipment, 

miscellaneous, catering process and lighting gains are lumped together into a 
single value. Solar gains are still calculated in the usual way. Note that with 
Lumped gains you cannot generate Temperature distribution and Comfort 
simulation output data.  

• Early  - gains can be defined separately under various categories (see above).  
• Detailed - gains are specified by defining each individual item of equipment 

in each zone on the Equipment tab. If you select this option then 
DesignBuilder will automatically set the Timing model option to Schedules. 
Note that this option was developed for creating very detailed models of 
existing buildings based on survey data. Entering this data for a large building 
is very time-consuming and in most cases you will be better served by the 
Early gains option above.  

Timing options 
 

• Typical workday - the timing is defined by a start time, end time, working 
days per week and seasonal variation. This approach is intended for easy early 
stage modelling of non-domestic buildings.  

• Schedules – where Schedules can either be defined for each day of the week 
and each month of the year using daily Profiles or by using Compact Schedule 
format. Schedules are more flexible and can be used in other projects but they 
take longer to set up.  

HVAC options 
 

• Simple - the heating/cooling system is modelled using basic loads calculation 
algorithms. For convective heating systems and all cooling systems the 
EnergyPlus 'Purchased air' system is used to calculate heating and cooling 
loads. 'Purchased air' supplies hot/cold air at predefined temperature and 
humidity for heating and cooling. See topics on Heating and Cooling for more 
on defining the condition of the supply air. Mechanical ventilation loads are 
calculated locally for each zone. When using Radiant/convective the heating 
system type the EnergyPlus 'High Temp Radiant System' system type is used 
to calculate heating loads.  

• Compact - the heating/cooling systems are defined in DesignBuilder using 
Compact HVAC descriptions but modelled in detail in EnergyPlus.    

 
In both cases heat generator (boiler) and chiller fuel energy consumption is calculated 
from loads as a post-process using efficiency factors. 
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Natural ventilation 
  

• Scheduled - the ventilation rates are predefined using a maximum air change 
rate modified by operation schedules.  

• Calculated - the ventilation rates are calculated using wind and buoyancy-
driven pressure, opening sizes and operation, crack sizes etc.  

  
You should generally use the Scheduled natural ventilation model option because it is 
quicker and easier to enter the related model data and also because the simulations run 
more quickly.  However if you need to calculate natural ventilation rates which can be 
achieved with a particular configuration then you should use the 'Calculated' option. 
 

Advanced tab - Lumping and Merging 
Simulations can be simplified and speeded up (sometimes quite significantly) by 
lumping zones, walls and windows. The following options are available: 

 
• Merge zones of same activity 
• Merge zones connected by holes 
• Lump similar windows on surface 
• Lump similar cracks 
• Lump walls and windows (developer option) 

 
See DesignBuilder help function for more details on these and the other options on 
this tab. 
 

Heating Design tab 
Key parameters set here are: 

Temperature control 
• Air temperature 

• Operational temperature 

• Other 

See also Simulation tab. 

Design Margin 
The Heating Design Safety factor is used to multiply calculated steady state heating 
loads in each zone to give a recommended heating plant size. It accounts for the 
additional heat required to bring the building up to temperature in a reasonably short 
preheat period and allows comfort conditions to be maintained in all but the most 
extreme winter conditions. 
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Cooling Design tab 
The data on this tab can also be accessed on the Cooling design calculation options 
dialog. 
 
Summer design day is set up by selecting day, month and day of week 
 

Calculation options  
Heating and cooling systems control internal temperatures to meet the setpoint 
temperatures specified on the Activity tab. These setpoint temperatures can be 
interpreted as air, operative or some other radiant fraction and DesignBuilder provides 
corresponding options to allow HVAC systems to be controlled by: 

• 1-Air temperature - control the room mean air temperature to the heating and 
cooling setpoint temperatures specified on the Activity tab.  

• 2-Operative temperature - control the room temperature using 0.5 radiant 
fraction. This is an advanced option - see notes of operative temperature 
control under help if you plan to use this option.  

• 3-Other- you can enter the radiant temperature control fraction.  

System Sizing  

Design margin: the Cooling Design margin is a 'safety factor' used to multiply 
calculated cooling loads in each zone to give a recommended maximum cooling 
equipment capacity. It accounts for the additional cooling required to cool the 
building down in a reasonably short precool period and allows you to be confident 
that comfort conditions will be maintained in all but the most extreme summer 
conditions (risk depends on the Summer Design Weather Data options selected at site 
level) 

Sizing methods available are: 

• 1-ASHRAE - standard Heat Balance method implemented in EnergyPlus.  
• 2-Unitary DX - calculations are made through a detailed EnergyPlus 

simulation using Unitary DX equipment.  
• 3-VAV - detailed EnergyPlus simulation using VAV equipment.  
• 4-Fan coil - detailed EnergyPlus simulation using Fan coil equipment.  

Tip: You should use the default ASHRAE option unless you have experience with 
Compact HVAC and understand the configuration of these system types. 

Solar options 
Solar Options allow you to control aspects of the model related to solar gains. 

The standard wall, floor, roof surfaces defining the current building provide shading 
but by default the other buildings on the site are excluded from the analysis. Check 
box Include all buildings in shading calcs to include other buildings on the site as 
shading obstructions. 
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Model reflections 
If using reflections, the program calculates beam and sky solar radiation that is 
reflected from exterior surfaces and then strikes the building. These reflecting 
surfaces fall into 3 categories described in the help function. 
 
For Advanced Calculation options and Output options see help 
 

Simulation tab 

Simulation Period 
Select the start and end days for the simulation, or select a typical period using the 
links on the Info panel. 
 

• Annual simulation - all 365 days of the year.  
• Summer design week - a week identified by the weather data translator as 

being the hottest of the year.  
• Summer typical week - a week identified by the weather data translator as 

being typical of the summer.  
• All summer - simulate the whole summer (as identified by the weather data 

translator).  
• Winter design week - a week identified by the weather data translator as 

being the coldest of the year.  
• Winter typical week - a week identified by the weather data translator as 

being typical of the winter.  
• All winter - simulate the whole winter (as identified by the weather data 

translator).   

Calculation options 

Time steps per hour: though many buildings can be successfully simulated with 1 or 
2 time steps per hour, EnergyPlus suggest 4 for non-HVAC simulations and 6 for 
simulations with HVAC.  

Temperature control: select from 

• Air temperature - control the room mean air temperature to the heating and 
cooling setpoint temperatures specified on the Activity tab.  

• Operative temperature - control the room temperature using 0.5 radiant 
fraction. See notes of operative temperature control below if you plan to use 
this advanced option.  

• Other- you can enter the radiant temperature control fraction.  

For Advanced Calculation options and controlling output data generated from 
simulations and Compact HVAC autosizing see help. 

Display tab 

Check boxes to control what is displayed on screen and in visualisation. 
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Drawing tools tab 

Check boxes to turn on direction snaps, point snaps, drawing guides, set rotation 
increment and protractor as required  

Block tab 

This tab is only available at block level and is used to change the wall thickness or 
change roof-wall transition angle if different from default of 70 degrees. 

Project details tab 

Use this tab to edit project details. 
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6 Introduction to Model Data 
This section takes an introductory look at the data in the Activity, Construction, 
Openings, Lighting and HVAC tabs. The data on these Model data tabs is further 
explored in subsequent sections. 

 

 

 

Activities 
This section explains how to partition the building into zones according to the 
activities (usage) in the building such as office, meeting room, toilet or plant room. 
Each activity has the following categories of data associated with it: 

• Zone Type (block and zone level only)  
• Occupancy  
• Metabolic rates  
• Holidays (building level only)  
• Domestic Hot Water (DHW)  
• Environmental control  
• Computer gains  
• Office equipment gains  
• Miscellaneous gains  
• Catering gains  
• Process gains  

For convenience this data is usually loaded from a predefined activity template. 
DesignBuilder contains a large number of activity templates from the UK NCM and 
ASHRAE. Some other libraries relevant to different parts of the world are also 
available from local agents. Also users can add their own templates to the library if 
necessary. 

Most of the Activity data is associated with either Internal gains or Environmental 
control.  

Internal gains 
There are 7 categories of internal gains in DesignBuilder: 

• Occupancy 
• Computer gains  
• Office equipment gains  
• Miscellaneous gains  
• Catering gains  
• Process gains 
• Lighting (data set on the Lighting tab) 
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You can define the time varying levels of sensible gains and for Occupancy, Catering 
and Process also latent gains. This is done by setting a maximum gain and applying a 
schedule to define the way the gains vary with time. You can also set the radiant 
fraction, i.e. the fraction of the heat emitted that is radiant heat. 

 

 

 

The screenshot above shows the data for Office equipment. Here the maximum office 
equipment gain is set to 15 W/m2 using a slider and the schedule is set a standard 
‘open plan office equipment operation’ schedule as specified by the UK NCM. You 
can change the schedule by making a selection from a list of predefined schedules. 
You can also add your own schedules and this process is described later. 

Environmental control 
User comfort requirements associated with the activity can be set: 

• Heating setpoint and setback temperatures 
• Cooling setpoint and setback temperatures 
• Natural ventilation setpoint temperatures 
• Mechanical ventilation setpoint temperatures 
• Minimum fresh air requirements 
• Minimum lighting levels required 

 
This data is explored further in subsequent examples. 
 

The NCM zoning process 
The object of the zoning process is to divide the building up into areas of similar 
activity uniquely defined by activity type plus the HVAC and lighting services, using 
as few zones as possible. 

• Divide the floor into separate physical areas, bounded by physical boundaries 
such as structural walls or other permanent internal walls (partitions). 

• If any part of an Area is serviced by a significantly different HVAC or lighting 
system, create a separate Area bounded by the extent of those services. This 
may require the use of virtual partitions (see below) to delineate area that have 
different access to daylight or where a large open space has perimeter heating 
with a different heating/cooling system in the central zone. 

• Attribute just one Activity (defined by the dataset above) to each resulting 
Area. If the building is speculative and the activity not fully defined, select the 
appropriate Speculative Activity for the relevant building type i.e. the activity 
it is expected to be used for. 

• Combine any contiguous Areas which are served by the same HVAC and 
lighting systems, and which have the same Activity within them, (unless there 
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is good reason not to). For example a number of cellular offices may be treated 
as one zone (see also hanging partitions and thermal Mass below). 

• Small unconditioned spaces like store cupboards, riser ducts, etc., can be 
absorbed into the adjacent conditioned spaces. Their floor area is added to that 
of the adjacent conditioned space. Larger areas should be treated as indirectly 
conditioned spaces. See Defining indirectly conditioned spaces. 

• If any resulting Zones overlap, use discretion to allocate the overlap to one of 
the Zones. 

 

Dividing the building into zones by drawing partiti ons 
After all blocks have been added and edited, blocks should be divided up according to 
the activities and zoning rules. 

• Select  and then position the pencil on the drawing screen over a wall until 
the red snap indicator appears (if snap indicator does not appear check snap 
options)  

• Click and draw in the partition in the required position. 

• Click where that internal wall ends and continue drawing further internal walls 
until the partition connects to another wall, when the model automatically 
updates by adding the partition.  

Alternatively trace over DXF internal walls. 

It is best not to create unnecessary zones – see zoning rules. Where a number of zones 
have the same activity, HVAC, lighting and access to daylight, they can be regarded 
as one zone as illustrated below for modular offices. However, if the internal 
partitions are not added the internal thermal mass of the building will be under 
represented. This is unlikely to have a significant effect on the calculations, but 
DesignBuilder offers two ways of defining additional internal thermal mass: 

• Drawing hanging partitions (i.e. partitions which do not meet other walls at 
both ends and hence do not create zones), or 

• Entering a non-zero internal thermal mass exposed area on the Construction 
tab under the Internal Thermal Mass header at zone level. 

The thermal mass defined using these methods is lumped together for each zone and 
modelled in a non-geometric way. In both cases, the construction is defined under the 
Internal Thermal Mass header on the Construction tab. 

Hanging partitions are created in the same way as ordinary partitions using the Draw 
partition tool, but are finished by pressing <Enter> (or the End partition stream 
command from the right click menu) to define the end of a partition stream. They are 
shown in blue in the illustration below. These hanging partitions do not need to be 
accurately positioned, as it does not matter where the thermal mass is added in the 
zone; it is only the total mass that matters and this is automatically calculated from the 
area and construction of the hanging partitions. Option 2 requires the user to enter the 
exposed area of the internal thermal mass. The area should be left as zero if the 
hanging partition option is used. 

See Help under Internal Thermal Mass. 
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Virtual partitions  allow zones to be subdivided without putting a physical wall into 
the space. Such partitions can be used to divide a space where there are different 
services such as lighting or HVAC within an open space to create activity zones with 
different services but which are not separated by a physical boundary. For example to 
delineate area that have different access to daylight or where a large open space has 
perimeter heating with a different heating/cooling system in the central zone. 

Daylighting modelling - offsetting electric light with daylight  

DesignBuilder uses the EnergyPlus detailed daylight method to model the control of 
electric lighting according to daylight illumination levels. 

Placing Light Sensors 
In the Lighting tab, when zone Lighting Control is  on, a light sensor will be displayed 
as a blue rectangle with the number '1' inside it indicating 'Light sensor 1'. By default 
Light sensor 1 is positioned in the geometric centre of the zone.  
  
If you now switch on the Second Lighting Area, a second light sensor will be 
displayed with a number '2' inside it: 
 
The lighting control types available are: 
 

• Linear 
• Linear/off 
• Stepped 

These tools allow the benefits of daylight controls in offsetting electric light where 
daylight is available to be modelled.  Virtual partitions  can be used to create separate 
zones where lighting in areas adjacent to windows can be switched independently of 
lighting in the central zone 

Zoning large buildings or blocks 
By default, DesignBuilder automatically generates zones as partitions are drawn. This 
can be time consuming in large blocks with many zones. To uncheck Automatic 
Block Zoning: 
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• Go to Model Option > Advanced > Miscellaneous Edit and uncheck the 
box. Partitions are then shown in blue and referred to as outline partitions. 
Outline partitions do not create new zones and are treated in the same way as 
hanging partitions.  

• After drawing all the partition for the block, convert outline partitions to 
standard partitions and rezone the block using the Rezone block command 
accessed from the Tools menu.  

• Outline partitions that do not connect at both ends, hanging partitions, remain 
in blue even after the Rezone block command. 

Alternatively, use the Rebuild command from the tools menu, to convert all outline 
partitions in the building to standard partitions and hence rezone the whole building. 
This takes longer to process than the Rezone block command as it recalculates the 
surface and adjacency geometry as well as rezoning. 

Data inheritance at block, zone and surface level 
Once all the blocks and zones making up the building model have been defined, it is 
necessary to assign Activities, Constructions, HVAC, Lighting and HVAC to each. 
DesignBuilder uses inheritance rules to make this process simple and efficient. 
DesignBuilder models are organised in a hierarchy: 

 

Default data is inherited from the level above in the hierarchy, so block data is 
inherited from building level, zone data is inherited from block data and surface data 
from zone data. This arrangement allows you to make settings at building level which 
becomes active throughout the whole building; or make settings at block level to 
change data for all zones/surfaces in the block. So for example, if the External wall 
construction is set to 'Wall 1' at building level, then this will be the default External 
wall for all blocks in the building. It is possible to change the inherited defaults in any 
of these blocks by selecting a block and making a user defined selection (say 'Wall 2') 
to ‘hard set’ the data at this level. All the zones in this block will then have external 
wall construction set to 'Wall 2' as the default.  

 The construction and opening defaults are inherited down to surface level where the 
data is actually used in the calculations. For example it is the External wall 
construction model data inherited at the surface level that defines the actual 
construction used for that external wall. The External wall model data set at zone, 
block and building level has no effect on the model (other than by providing the 
default data for the level below in the hierarchy).  
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A further significance of making a user defined selection at a particular level is that 
the data remains ‘hard set’ at that level and below even when changes are made to the 
level above. 

To assist in identifying where data is inherited from DesignBuilder uses a colour 
code. Data set at building level or user defined data ‘hard set’ at any level below will 
appear in red. All data inherited at levels below will be in blue. The simplest way of 
determining where data is inherited from is to start at the lowest level, a surface or 
opening, and go up through the levels (<F2> key is useful for this) until the data turns 
red. This then is the level from which the data has been inherited. 

To undo user defined ‘hard set’ data use the Edit > Clear to default menu option and 
select All data or Custom openings and specify level (block, zone or surface) down 
to which the data is to be cleared. 

 

Zone type 

The zone type can be set at block or zone level on the Activity tab and can be one of: 

• Standard - considered to be occupied and heated or cooled.  
• Semi-exterior unconditioned - is an unoccupied zone in the building which is 

neither heated or cooled. Examples of 'semi-exterior unconditioned' spaces are 
roofspaces, sunspaces, car parks etc).  

• Cavity - the zone is a cavity such as the glazed cavity within a double facade 
or a Trombe wall. This algorithm correctly calculates the convection 
coefficients for a narrow sealed vertical cavity based on the ISO 15099 
standard.  

• Plenum - the zone is a plenum which is unoccupied and has no heating, 
cooling, or mechanical ventilation (though of course air will flow through it to 
meet the needs of the zones it serves).  

Assigning activities 
When the building model is complete and all the blocks have been zoned, the next 
step is to assign activities to each zone. It is best to be methodical, especially in large 
buildings, and to start at the building level by setting the activity which most 
commonly occurs in the building, for example, classroom in a school or bedroom in a 
hotel. This sets this activity for all zones. Now work methodically through all the 
zones changing the activity where it is different from the default. You can also use the 
block level if most of the zones in a block have the same activity (but different from 
building default). 

• Select a zone from the navigation menu. 

• Click on the Activity tab – the screen shows the default activity. 

• Click once on Activity – a menu of all activities and sectors appears in the 
right hand pane. 
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• Click + to expand the appropriate sector and double-click on the activity. User 
defined activities can be added to the library of activities using the + or copy 
functions. 

Note that the sector is automatically assigned when an activity for the zone is 
selected.  

• The default zone type, Standard, applies to all zones in the model both 
conditioned and unheated zones. In most instances spaces with no heating 
system are assumed to be heated by the HVAC system for the surrounding 
zones. Such zones are therefore included in the model as heated i.e. standard 
zones with an HVAC system assigned to them. Where an unheated zone is to 
be included in the model select “none” form generic list of HVAC templates 

• For unheated zones, especially unheated roofspaces, set the zone type to Semi 
exterior unconditioned. See also section below on constructions. 

Each zone should be given a meaningful name to make it easy to identify during the 
analysis. This is important for larger buildings where there may be a large number of 
zones. To rename a zone: 

• Click on the zone entry in the navigation list on left of the screen, to highlight 
the zone. 

• Click again to open an edit box and type in a meaningful name such as ‘Office 
South’. The process is the same as renaming a folder in Windows Explorer.  

 

Constructions 

Defining constructions in DesignBuilder 
The following definitions apply and are illustrated in the diagram below. 
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Floor/slab/ceiling constructions 

 

External walls 
External wall construction defines the construction of walls adjacent to outside. The 
definition of walls is given by the roof-wall transition angle of 70 degrees.  

Flat roof 
Flat roof constructions apply to external horizontal surfaces. The construction used to 
represent the flat roof should include any slabs, insulation and suspended ceiling 
layers.  

Pitched roof (occupied) 
The Pitched roof (occupied) construction applies to external sloped surfaces when 
they appear in occupied zones.  

Pitched roof (unoccupied)  
The Pitched roof (unoccupied) construction applies to external sloped surfaces when 
they appear in semi-exterior unconditioned (unheated) zones.  

Internal partitions  
The internal partition construction defines the construction of internal partitions (walls 
used to divide blocks into zones) and inter-block partitions (internal walls shared with 
other blocks). Internal partitions are used where both zones are occupied. When one 
of the zones is occupied and the other is not, the Semi-exposed walls construction data 
is used (see below). 



Simulation and CFD Training Guide  

DesignBuilder copyright © 2009 29 

Semi-exposed walls  
The semi-exposed wall construction applies to walls between Conditioned zones and 
Semi-exterior unconditioned zones. They normally include some insulation. 
DesignBuilder determines which of the zones is relatively outside and uses this 
information to correctly order the material layers in the wall. The material layer 
defined in the construction as being outermost (first-in list) is the one adjacent to the 
Semi-exterior unconditioned zone. 

Semi-exposed ceiling 
The semi-exposed ceiling construction is used between Occupied zones and Semi-
exterior unconditioned (unheated) zones (such as roof spaces) above. The construction 
should include any slabs, insulation and suspended ceiling layers. DesignBuilder 
determines which of the zones is relatively outside and uses this information to 
correctly order the material layers in the roof. See discussion under ‘Pitched roofs’. 

Semi-exposed floor  
The semi-exposed floor construction is used between Occupied zones and Semi-
exterior unconditioned (unheated) spaces below. The construction should include any 
slabs, insulation and raised floor layers.  

Ground floor 
The ground floor construction is used between all internal zones and the ground. 

External floor 
External floors are floors that are adjacent to outside air, e.g. the floor of a 
cantilevered part of the building or where for any other reason there is no ground or 
other zone below. The External floor construction should include any slabs, insulation 
and raised floor layers.  

Internal floor 
The internal floor construction defines the makeup of floors between Occupied zones 
including any slabs, air gaps, raised floors and suspended ceilings. It does not usually 
contain insulation. Where the zone above is unoccupied, the Semi-exposed roof 
construction is used instead. Likewise, where the zone below is unoccupied the Semi-
exposed floor construction is used instead. 

 

Adjacency 
Adjacency means what is on the other side of a surface. By default DesignBuilder 
calculates adjacencies between blocks, partitions etc. This default adjacency 
mechanism can be overridden at surface level using the Adjacency setting on the 
Construction tab. The default setting for Adjacency is auto, but it can be set at surface 
level to be one of:  

• 1-Auto - the adjacency of the surface is determined automatically by 
DesignBuilder based on its position.  External surfaces below the ground plane 
are, by default, considered to be adjacent to ground and external surfaces 
above the ground plane are considered to be adjacent to outside conditions.  
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• 2-Not adjacent to ground - the surface is not adjacent to ground even if it is 
situated below the ground plane.  

• 3-Adjacent to ground - the surface is adjacent to ground even if it is above 
the ground plane or it is an internal surface.  

• 4-Adiabatic - the surface is adiabatic.  This means that heat is not transferred 
across in its external surface.  Adiabatic surfaces are frequently used in 
thermal modelling to represent surfaces that are between two zones at 
substantially similar conditions.  Note that thermal mass is still modelled in 
Adiabatic surfaces because heat can still be transferred into the mass through 
the internal surface. Adiabatic surfaces are often used for modelling the 
boundary between the actual building model and any adjacent buildings that 
are not to be modelled.  

You can determine which surfaces are adiabatic or adjacent to ground by looking for 
the corresponding surface adjacency markers in the Edit Screen at zone and surface 
levels.  

Entering construction details in DesignBuilder 
The model is initially created using the default construction data loaded from the 
project template. When the construction tab is first opened all construction types are 
labelled as Project… and displayed as shown below whether or not they are present 
in the building model. For example the Pitched roof construction is displayed whether 
or not there is a pitched roof in the model. 
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.  

Buildings Constructions 

For most buildings the quickest way of setting up constructions is to define them at 
building level. Go to building level and then open the Construction tab.  Double-
clicking on any of the constructions such as Wall, Flat roof etc opens a Construction 
Edit screen.   

Set the number of layers first, and then select the material and thickness for each 
layer. Constructions can have up to 6 layers. Define the layers in the same order they 
appear in the actual construction starting with the outermost layer and finishing with 
the innermost.  

The outermost layer will be positioned adjacent to outside (or in the case of Semi--
exposed walls adjacent to the semi-exposed unconditioned zone). Clicking on material 
in any layer opens a menu of materials in the right hand pane. Double click on the 
required material and specify its thickness. 

Bridging can be added to any layer to model the effect of a relatively more conductive 
material bridging a less conductive material.  For example wooden joists bridging an 
insulation layer. 
 
Note: If the material referenced is defined as a simple R-value then the construction 
thickness does not have to be entered. 
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Note: You should not include surface resistance (film coefficient) layers to represent 
the resistance of the air films adjacent to the inner and outer surfaces. These are 
included automatically by DesignBuilder. 

Image tab: This displays an image of the construction layers which is useful to check 
that the construction has been set up as required. 

Calculated tab: This tabs shows calculated values and the effect of bridging when 
present. Note that the U-values etc are not used in simulations but are useful for 
reference and for use in simplified calculations such as SBEM. 

More Complex Construction Mixes 

For more complex construction mixes, such as an old building with a number of later 
extensions of different constructions, it is useful to create a number of wall 
constructions for example, one for each construction type found. These constructions 
can then be set in the appropriate blocks and zones.  

• Open the Construction tab. All construction types will be displayed showing 
all possible constructions (external walls, Flat roof, Pitched roof (unoccupied) 
etc) whether or not they are present in the model. 

• Single click on one of the constructions, external walls for example – a menu 
of wall constructions appears on the right. 

• Select a suitable wall construction type, preferably one that will have a similar 
thermal mass to the actual construction and make a copy using the Create copy 

icon in the toolbar above . 

• To edit select this new copy and then the edit tool. Alternatively use the  
function to create your own construction 

• An edit screen appears labelled Model data.  Give it a new meaningful name 
such as “External wall main block” 

• Under ‘Source’ record where the new data has come from as part of the audit 
trail required.  It may be useful to include a brief description and possibly a 
date or revision number as constructions may change as the design evolves. 

• If necessary adjust the number of layers and then edit the materials and 
thickness data for each layer. Include bridging if appropriate 

• Click OK and new construction will be added to list of constructions 

• Now click on each of the other constructions present in the model and change 
the values as required. 

• Finally apply the new constructions created to each block and zone as 
appropriate. First select the block or zone and then in the construction tab 
select the type of structure i.e. wall roof etc to open the menu of structures. 
Select the structure required from the list that has been created by double 
clicking on it  to load it into the model. 

Sub-surfaces are useful where part of the structure is different from the rest. For 
example, glazing may have been replaced by insulating panels having a lower U-value 



Simulation and CFD Training Guide  

DesignBuilder copyright © 2009 33 

than the original wall construction. External doors are also defined at the sub-surface 
level. These can be drawn in at surface level. See help under Drawing windows. 

Pitched roofs 

Heated roof spaces are considered to be occupied and are therefore treated as normal 
zones. Note that when creating the block for a heated roof space first go to Drawing 
options, Geometry and check box Roof space occupied. 

Model infiltration 

At the bottom of the construction screen is the data for setting model infiltration. 
Open the infiltration data by clicking on the grey Airtightness header tool bar for 
setting model infiltration. 
 
If scheduled was selected in model options under natural ventilation, the ventilation is 
defined as an air change rate per hour, modified by an occupation schedule and 
controlled using a set point temperature. 
 
If calculated is selected as the ventilation option, together with compact HVAC, 
natural ventilation and infiltration air flow rates are calculated based on openings and 
crack sizes buoyancy and wind pressures. When calculated natural ventilation is 
active, the Airtightness is defined by a position on a five point scale corresponding to 
5 crack templates 
 

 
  

Openings 
The term opening is used in DesignBuilder to describe any opening in the main 
building fabric. There are five types of opening: 

• Windows 
• Doors 
• Vents 
• Holes 
• Sub-surfaces (i.e. opaque elements within the surface that have different 

properties from the main construction.) For example, lintels and lightweight 
panels can be defined as sub surfaces. 

 
In any model, go to building level. Then select the Openings tab to bring up a screen 
headed Project glazing template which shows ‘Glazing type’ and Layout which are 
initially set as the Project default  To introduce alternative values: 

• Single click on Glazing type to bring up a library of glazing types in the right 
hand pane (or alternatively click and use the browse button …).  Double click 
on the required glazing type to load it into the model. To introduce user 
defined glazing types use the Add new or copy and edit tools to create a new 
glazing type and then load it into the model. 
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• Single click on Layout to open a library of facade types. Select a façade type 
that will produce the right appearance for the model. If required the copy or 
add and edit tools can be used to create user defined facades. 

• Open the Dimensions header and set the slider to define the Window to wall 
%. The opening area includes frames. The model will automatically update 
with the new value. If the changes are made at building level this % is applied 
to all facades, provided data has not been previously ‘hard set’ at the lower 
level. If made at a wall surface level the set % applies to that wall only – see 
section on Inheritance. 

• Open the Shading toolbar and select widow and/or local shading and make 
appropriate selections for the drop down menus 

• Go through the same procedure for Roof glazing if present 

• Open the Doors toolbar. Checking the auto generate box in a surface will 
automatically generate a door. Set up the operation and schedule for the doors. 

• Open the Vents toolbar. Select the vent type and operation schedule 

• The values set in the previous steps will be applied to all surfaces if they were 
entered at building level. Where a surface requires different data you can 
select that surface from the navigation menu and repeat the steps as necessary 
to set the alternative data. 

You can use the copy and edit tools to create more than one Glazing template, which 
may be useful for example where Southerly facing facades have shading systems 
which are not present on the Northerly facing facades.  

 

Lighting 
Opening the lighting tab brings up the default lighting system from the reference 
template. To introduce alternative lighting systems start by entering data for the most 
common system at building level by selecting an appropriate lighting template. 
These templates are data sets that can be used as a source of generic lighting systems 
for loading into the building data. A single click on ‘template’ will bring up the 
library of lighting templates. Select the most appropriate, review and if necessary edit 
the data under the 3 main headers: 
 

• General 
• Task and Display Lighting 
• Control  

 
Note that the lighting gain in the default Reference Lighting template is 5 W/m2 per 
100 lux. For an office activity having 500 lux target illuminance this results in 25 
W/m2 lighting gain, which will be much too high for most modern buildings being 
designed now. 
 
When you load lighting data from template, the actual lighting internal gain is 
calculated by multiplying the W/m2/100 lux lighting efficacy data in the template by 
the required illuminance level as set on the Activity tab under Environmental 



Simulation and CFD Training Guide  

DesignBuilder copyright © 2009 35 

Conditions. Consequently you should make sure the correct activity data has been 
loaded in each zone before loading lighting templates.  
 
It can be useful to explicitly load data in each zone by checking each zone in the 
Target tab of the Load data from template dialog. This ensures that the correct 
lighting load for each zone is set. If the activity for one zone is different from that at 
building level the wrong lighting energy will be calculated for this zone if loading the 
lighting template at building level only. 
 
Lighting data generates simulation data at the Zone level.  
 
Turn on general lighting and set the installed lighting load including control gear 
using the slider.   
 
Note the lighting schedule comes from the activity for the zone 
 
Select the luminaire type from the drop down menu. This loads typical values for 
radiant and visible fractions for the luminaire type. You can override these if required. 
The convective fraction is calculated and an error is generated if the radiant + visible 
fractions >= 1. 
 

 

 

 

 

 
 
If appropriate turn on display/task lighting and specify gains and schedule. These 
gains are assumed not to be linked to any lighting control system and the lighting gain 
value does not come from the lighting template. In fact if you load a lighting template 
the Task and display lighting value is reset to zero. 

Where lighting controls are installed turn on lighting control and select from the 3 
lighting control options. Daylight control is covered in more detail on Day 2. 

The lighting specified at building level will be loaded for all zones. Where zones have 
a different lighting specification, select that zone and edit the lighting data. 
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HVAC  

HVAC can be defined in DesignBuilder using: 

• Simple HVAC where the heating/cooling system is modelled using basic load 
calculation algorithms. For convective heating systems and all cooling systems 
the EnergyPlus 'Purchased air' system is used to calculate heating and cooling 
loads. 'Purchased air' supplies hot/cold air at predefined temperature and 
humidity for heating and cooling. See topics on Heating and Cooling for more 
on defining the condition of the supply air. Mechanical ventilation loads are 
calculated locally for each zone. When using Radiant/convective the heating 
system type the EnergyPlus 'High Temp Radiant System' system type is used 
to calculate heating loads.  

• Compact HVAC where the heating/cooling systems are defined in 
DesignBuilder using fairly simple parametric HVAC descriptions but 
modelled in detail in EnergyPlus. 

   
In both cases heat generator (boiler) and chiller fuel energy consumption is calculated 
from heating and cooling loads as a post-process using efficiency factors. 

Simple and Compact HVAC system will be covered in detail on Day 2. 

Selecting and editing HVAC templates 

When this option is selected in the model options screen, data can be loaded from a 
list of generic HVAC systems.  (in the UK there is also a list of HVAC systems than 
can be used for the UK National Calculation Model). While at building level, click on 
HVAC and use the browse button to open list of generic HVAC systems. Select the 
most appropriate for the majority of the building. 

The auxiliary energy consumed by fans and pumps will be set automatically for the 
system selected. For both heating and cooling the fuel type, the system Coefficient of 
Performance, the supply air temperature and humidity will be loaded firm the 
template 

Note the schedules will be inherited for the activity. 

In general it will be necessary to edit the data on the template and in many cases there 
will be more than one HVAC system. Clicking on the + button in the right hand pane 
will open an edit screen. Give the HVAC system a recognisable name and set the 
category to project. 

For Simple HVAC system the auxiliary power can be edited 

For Compact HVAC systems the type is selected from the drop down menu. 

Tabs for ventilation, heating and cooling can then be opened and appropriate values 
set. 

The final tab allows the air temperature distribution to be set to mixed or dynamic 
gradient. 

Click OK when a prompt will appear ‘select named system as template’ selecting yes 
will load the data from this template at building level so that it is inherited down to al 
zones in the building. 
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Where a building has a different HVAC system for some blocks or zones, use the + 
button again to create a second HVCA template, give it a new name and load this into 
the relevant blocks and zones. 

DHW generator 

A DHW generator needs to be selected for all occupied zones. Depending on the 
activity and building type selected for the zone, a standard DHW demand is assumed. 
For example, there is a demand assumed to arise from the occupants of an office for 
activities such as washing hands and washing up cups. This demand is associated with 
the office rather than the toilet or tearoom. Thus, the demand from each space needs 
to be assigned to a DHW system even if the system itself is not present in the space. 
The DHW generator that needs to be specified and described should be the generator 
which accounts for the majority of this demand, from those defined in the DHW 
generator tab. 

• The default is Project DHW 

• Select Type from drop down menu 

• If Same as HVAC is selected then the HVAC system is automatically selected 
as DHW generator. 

• Specify the delivery and supply temperature and select a schedule for DHW 
demand  

• A single click on DHW template followed by selecting browse button gives 
access to other generic types of DHW. 
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7 Exercises on Geometry and Model Data 
Carry out these simple exercises to help consolidate your understanding of 
DesignBuilder geometry and model data. 

Default Model Templates 
Many of the subsequent worked examples will be based on simple single and 2-zone 
models. These will be created in this exercise and saved as templates for future use. 

Default 20x10 Single Zone 
First create the single zone model: 

1. Create a New project using any location and the Blank template. 
2. Create a New building using default options and templates 
3. Draw a block 20m x 10m with the longer facades facing North and South as 

shown in the screenshot below. Use all the default drawing options (Wall 
thickness = 0.293m and Block height = 3.5m). 

 

 
 

Tip : You can achieve the same result with even less work!  
 

4. Delete the block you have just drawn (Ctrl-Z undoes the add block command 
or select it and delete it) 

5. Select the Perimeter shape to be 2-Rectangle then move the mouse over the 
edit screen and type  
 
20 10 and press <Enter>.   
 
This ‘key in’ shortcut means “Draw a rectangle 20x10 (x direction first, y 
second)” Again delete the block and try typing:  

 
0 0 <Enter>  - go to origin 
20 10 <Enter>  - draw the 20x10 block 

 
Now save this single zone model as a template using the File > Save > Save as 
template menu option. Call the file Default 20x10 Single Zone.dsb 
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Default 20x10 2-Zone 
Now create the 2-zone model. Continuing with the previous Default 20x10 Single 
Zone model,  

1. Go down to the block level and click on the partition tool  to start drawing a 
partition. 

2. Switch on Increment snap to allow a precise positioning of the partition. 
3. Move the mouse until you are 12m from the East end of the block and 7.41m 

from the West as shown in the diagram below. Then use the mouse to draw 
the partition .  

 

 
 

4. Rename the zones East and West and go back up to the block level.  The 
model should look as shown below. 

 

 
 

Now save this 2-zone model as a template using the File > Save > Save as template 
menu option. Call the file Default 20x10 2-Zone.dsb 

 

Exercise 1 
Basic 2-storey building 
 

Create rectangular building as follows: 
External dimensions:   30 x 20m (20m along East-West X-axis) 
Wall thickness:  0.35m 
Block height ground  3.5 
Block height 1st floor  3.0 
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Hipped roof - slope 25 degrees with 0.5 m overhang 

 

 

Exercise 2 
Building with blocks side-by-side 
 
Create a building as follows: 
 

• Draw a block 20 x 20m and 6m high 
• Starting at the South west corner add a block that is 3m high and extends 12m 

along the South wall of the original block and stands out from that block by 
6m 

 
Building should look like: 
 

 
 
Now use the Drag face tool to pull the smaller block out to a distance of 10m. Note 
the dimensions shown when dragging the face are incremental (i.e. they show the 
increase/decrease in the dimension, not the total dimension). 
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Exercise 3 
Sloped roof 

 
• Using cutting and protractor tools to create a single slope roof (useful where 

occupied space extends to roof skin) 
• Continuing from exercise 2, use the drag face tool to increase the height of the 

larger block by 2m. 
• Turn on the protractor and set the increment to 5 degrees 
• Then use the Cut Block tool to cut the block across the South face at an angle 

of 5 degrees starting at a height of 5m from the South west corner. 
• Delete the cut block to create a single slope roof as shown below 

 

 
 

Exercise 4 
Extruded blocks 
 
Using extruded blocks to create more complex shapes such a more complex roof   
 

• Draw a simple block 10m x 20m and 3.5m high 
• Add a gable end roof with the geometry shown below 
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• Ridge is 2.5m above eaves and is 7m from left hand corner  

 
Tip : Use a construction line (vertical line in blue) to locate ridge position 

 
Appearance of building  
 

 

Exercise 5 
Using Outline blocks 
 

• Create a simple 2 storey building 10 x 20m and add a 30 degree pitched roof 
• Add dormer window in middle of South facing sloping roof using an outline 

block. Align vertical face of dormer outline block with wall below. 
• The vertical height of the dormer walls is 1.5m and the sloping roof sections 

are 1.5m long and at 45 degrees. 
• Cut outline block using roof as cutting plane (cutting method = Select plane) 
• Convert the dormer window outline block to a building block Wall thickness 

is 0.1m 
• Add a window 1m x 1m. 
• Cut a hole in the sloping roof and merge the dormer zone with the main 

roofspace zone using ‘Merge zones connected by holes’ Model option. 
• Copy the dormer block twice to give a dormer window over each window of 

the floor below. The hole connections are copied with the block.  
• Visualise the building and look inside – explore visualisation options. 
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Visualisation of building with dormer window created using outline blocks 

 
 

Exercise 6 
Using ground component blocks to set ground adjacency 
 

• Create a two-storey building with flat roof 15 x 15m with default 3.5m block 
heights. 

• The building is on a slope such that the ground rises along the South wall from 
floor level at the west corner to a height of 1.75m at the East corner. 

• Use a ground component block to set the adjacency for the South wall as 
shown below. 

 
Tip:  use a construction line to provide the snap point for ground block at South 
East corner 

 
Ground adjacency set by using a ground component block (green) 
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Exercise 7 
Using standard and adiabatic component blocks 
 

• Rotate model from Exercise 6 to show North face 
• Add a 4m high adiabatic block to middle of North face. This will be shown in 

red. 
• Add a standard block same height as building in front of west face. This will 

provide shading (and reflections if this Solar calculation option is selected). 
 

 
 

Exercise 8 
Zoning the building 
 

• Create a building having 10 x  20m external dimensions  
• Add 2m wide corridor down middle parallel with the longer wallInsert 

partitions to create 5 equal cellular offices along west wall - assume all have 
same HVAC system 

 
Tip : You should have created just 3 zones. Check this by looking in the 
Navigator. 
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Exercise 9 
Specify lighting 
 

• Draw simple 10 x 30m building with long dimension running North to South. 
• Divide building into 4 zones 
• Set the activity at building level as Office_OpenOff 
• Set activity for Zone 3 as Office_Reception 
• Set activity for Zone 4 as Office_Store 
• At building level select the lighting template as T8 Fluorescent, triphosphor 

high frequency control gear. 
• Set the lighting energy as 16 W/m2  
• Note schedule Office_OpenOff_Light has been set from the activity loaded 
• Select luminaire type as surface mount 
• Turn on lighting control and set control type to linear and % area covered by 

lighting area1 to 40%. 
• Now go to Zone 3, Reception 
• Select lighting template as Fluorescent compact 
• Accept default 23 W/m2 and set luminaire type as recessed 
• Turn off lighting control 
• Now go to Zone 4, Store 
• Select lighting template as Metal halide 
• Set luminaire type to Suspended 
• Turn off lighting control 
• Data inherits from building level in Zones 1 & 2 

 

Exercise 10 
Editing default constructions 
 

• Draw simple building 10 x 15 m  
• Add second floor and unheated pitched roof 
• Modify construction wall for second floor to: 
• Outer leaf  metal cladding steel 2 mm thick (look under metals) 
• Insulation polyurethane board diffusion tight 0.1m thick 
• Inner leaf concrete 1800kg/m3 concrete block, medium density inner leaf 0.1m 

thick 

 

Exercise 11 
Occupied roof space – room in the roof 
 

• Draw a 20 x 30 two storey building with a 45 degree pitched roof 
• Use construction lines to position partitions 2m for each edge of the sort 

dimension as illustrated below. 
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• Name the zones as ‘Room in the roof’ and ‘Roof void’ as shown 
• Go to building level a cut the roof block at a height of 3m to create a ceiling. 
• Select room on roof zone and set zone type to standard and set activity to hotel 

bedroom. 
 
 

Exercise 12 
Defining openings 

 
• Draw simple 10 x 30m building with long dimension running North to South 
• Change default glazing to 4-20-4 low coated air filled. 
• Edit openings to create building with: 

 
• 20% glazing in west wall with window height of 1.3m and sill height of 

1.5m. Apply local shading with 1m overhang louvre. 
• 40% glazing in East wall with window height of 2m and sill height of 1m. 

Apply window shading using venetian blinds - light, internal, always on. 
• No other glazing but door in South wall. 
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Exercise 13 
More complex geometries 

Use as many of the drawing tools as possible to create a building with more complex 
geometry such as that illustrated below. Use construction lines to provide snap points 
to position curved walls and other features. 

 
 

Exercise 14 
Free standing office in warehouse 

Sometimes it is necessary to create a smaller zone such as an office within a larger 
zone (e.g. a large warehouse space). 

The steps involved are: 
  
1. Draw the ground floor block including both office and warehouse. The block 
should be the height of the office space as the top of the block will form the ceiling of 
the office. 
 
2. Draw the 1st floor block representing the high-level warehouse space.  
  
3. Draw holes (two will be required) so as to cut away all the floor of the 1st floor 
block except that around the top of the office.  
 
4. Go to model options and on the Advanced tab switch on the ‘Merge zones 
connected by holes’ option. This will merge the upper and lower warehouse zones 
into a single zone. The upper warehouse zone should look something like the 
screenshot below.  
 
5. From the navigation tree select the first floor block and then floor element 
corresponding to the ceiling of the office. In the construction tab, open the Adjacency 
toolbar and tick “Exclude this surface area from the total zone floor area” 
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See also www.designbuilder.co.uk > Support > Knowledge base > How to include a 
single story office within a full height warehouse. It is also available as a 
DesignBuilder example file. 
 

 
 

Exercise 15 
Model used as basis for Day 2 Exercises 
 

 
 
 
 
• Draw the U-shaped ground floor block using the dimensions below. 
 

http://www.designbuilder.co.uk/
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• Copy the ground floor block up to create the first floor block. 
• Change the Block type of the Roofspace block to Pitched roof and set the block 

wall thickness to 0.05m. 
• Draw the atrium block by drawing a block perimeter on the indented south face as 

shown below and extrude to create the block. Use the protractor to create a 30º 
roof slope. The drawing guides from the mid-point of the adjacent surface will 
help position the apex of the perimeter. 
 

 
 

• The block wall thickness should be 0.01m 
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• Define the atrium block glazing by setting the % glazed = 0 or use the No glazing 
façade template. Draw large roof vents at the top of the roof surface covering the 
width with a height of 0.5m. Fill the rest of the surface with a window. Repeat for 
the other roof surface. Switch increment snap on to help with this. 

• Draw 4 windows on the atrium South-facing external surface as below: 

 
 

• The atrium is to be built using a lightweight construction so choose the Part-L 
2006 Lightweight construction template at block level (optional). 

• For visual appearance sake, set the atrium pitched roof (occupied) construction to 
use a lighter coloured material (optional). 

• Set the activity for the atrium block as ‘Office_Circulation’ and use the default 
‘Office_OpenOff’ activity for the rest of the building. 

• Draw windows and vents in each of the inter-block partitions as below, the vent is 
the purple opening at the top of the surface below. 

 

 
• The external windows for the ground floor and first floor blocks can be set up 

using the default façade mechanism. At the building level, opening tab, make sure 
the default 30% glazed windows with 5m spacing and 0.8m sill height are set. 

• Name the blocks Ground floor, First floor and Atrium using the Navigator. 
 



Simulation and CFD Training Guide  

DesignBuilder copyright © 2009 51 

Save the model as a template called Atrium example base. The model should look 
like the screenshot below.  
 

 
 

This model is completed in the next section by loading appropriate templates. 
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8 Data Management 
This section covers tools you can use to speed and ease data management tasks. 

Loading data from templates 
DesignBuilder Templates are collections of data that are useful for quickly loading 
data en masse into the model. They can be especially useful if you frequently model 
similar types of building or if you often wish to model a particular HVAC or lighting 
system for example. Create the template once and load it multiple times! 

Each template contains sufficient data to load the complete set of data displayed under 
each of the Activity, Construction, Opening, Lighting and HVAC tabs.  New 
templates made up of different sets of data can be created by using the copy or add 
and edit tools when in the templates tab on the opening screen. These data sets can 
then be loaded into the model from the new templates. 

Templates can be created: 

• with a model open, in which case the templates are stored with the model, or  

• on the opening screen, in which case the templates are stored in the 
DesignBuilder Library.  

You can copy templates and components from one project to another and to/from the 
Library using the Import/Export library data  commands accessed from the File 
menu. Export transfers the data to a .DDF file and Import allows a previously 
created DDF file to be loaded. 

Templates do not form part of the model even if they are stored in the model so an 
edit to a template will not affect simulation results until the template is loaded to the 
model. 

Example – Load data from template 
In this example you will complete the Atrium example base model started in 
Exercise 15 and learn how to use the Load data from template function. 

• Go to the Building level  and Clear all data to default using  

• Use the Load data from template tool  and on the Load data tab select the 
data to be loaded. The dialog should be as shown below. 
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• On the Target tab Set the target which is the building only. This will have 
been selected as the default target for you (because you are at building level in 
the model). 

 

Clicking OK loads the templates displayed to the parts of the building selected. The 
templates and the information in them are shown in red in the model data at the level 
in which they are loaded, but in blue at any lower level. 

Then load the templates for the atrium: 
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In larger models this process is a convenient way to load templates to parts of the 
building having similar building attributes. 

The same effect could have been achieved by going to the atrium zone and loading the 
template options at the top of the respective tabs. The most efficient  targeting strategy 
for loading the data varies from building to building. In small models you may find it 
easier to use the template in the Model data tabs but in large buildings with many 
zones the Load data from template function can be an efficient way to load the 
templates for multiple zones of the same attributes in one go. This works best if you 
label the zones in the Navigator with a name that recalls the activity. For example 
‘Store small’ would be more useful than ‘Small room’.  

 

Reload data 
Use the reload option to reload all hard-set templates (i.e. template selections shown 
in red). This will remove all red bold data where template defaults have been 
overridden. 

 

Clear data 
Is important to understand the concept of ‘clearing data’ in DesignBuilder because it 
is the mechanism by which previously hard-set user is cleared and the data instead is 
inherited from the level above in the hierarchy. This function is accessed from the 
Clear Data to Default dialog, which allows you to: 

• Clear Model data removes any hard set user data (shown in red) from the 
current object and instead default data is passed from the 'parent' object in the 
hierarchy (shown in blue). This can be done for individual model data items, 
all model data on the current tab or for all model data on all tabs. 

• Clear custom openings and revert back to default facades.  
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You can control the extent of the clearance by setting the Clear Down to data at the 
bottom. Leave this data as 'Opening level' if you want all data in the currently selected 
model object (including child objects) to be returned to a default state. Depending on 
the data to be cleared you may only be able to clear down to zone or surface level. 

 

 

 

You can clear individual items of model data by right clicking on them and selecting 
Clear to default from the menu. 

When used at building level the clear model data function actually clears all levels 
below the building level – it is not allowed the clear the building data itself because 
this is the top of the inheritance hierarchy and there is nothing else to inherit from. 

 

Export and Import Components and Templates 
You can export component and templates in DDF form and these can subsequently 
be: 

• Imported into other projects,  

• Loaded into the DesignBuilder library and also  

• Loaded onto other computers, shared with colleagues etc. 

 

This example takes you through the stages in the process.  

• Create a new project using the Default 20x10 Single Zone model template. 

• Go to the building level and the Constructions tabs. Click on External wall to 
load the Data management panel on the right of the screen.  

• Create a new external wall construction by clicking on the + Add new item 
toolbar icon. The new wall is to use a single layer of a new material which we 
will also define now.   
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In the materials dialog create the new material, looking something like: 

 

 

 

• Click OK to create the material NEW MATERIAL. 

• Then back in the Construction dialog, click the Tick icon to select the new 
material. 

• Click OK to save the new construction. 

• Select the NEW CONSTRUCTION as the building level External wall 
construction. 

You have now created a new project construction component called NEW 
CONSTRUCTION and this references the new material component NEW 
MATERIAL .  

• Now export these 2 components as a DDF file using the File > Export > 
Export library data. 

• This opens the Select Data for Export dialog. Clear all the default 
selections by clicking on the Select None button then select the 2 new 
components under Materials > Concretes and Constructions > Walls 
categories and Click OK to create the DDF file. Save the file to 
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somewhere you can find it easily. The default DesignBuilder data folder 
is a good place, as DesignBuilder will look there first when importing 
later. Save using the filename NEW COMPONENTS. 

 

 

 

• Now save this project and create a new blank project. Add a new 
building and draw any block quickly  

• Import the DDF file you just created by using the File > Import > 
Import library data menu option. 

 

 

 

DesignBuilder displays a dialog showing the components that have been 
imported. 
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• Now in the Constructions tab, click on External wall to list the 
constructions in the Data panel on the right. You should be able to find the 
NEW CONSTRUCTION that has just been imported to the project. 

• Select NEW CONSTRUCTION as the default external wall for this 
building. As an experiment once you have selected NEW 
CONSTRUCTION as the external wall, try deleting it from the project. 
You will be prevented from doing so because it is used in the model. 
Likewise you would not be allowed to delete NEW MATERIAL because 
it is used in NEW CONSTRUCTION . 

You can also import the DDF file into the DesignBuilder Library so it will be 
included with all new projects created. To do this, follow the same Import process but 
on the Opening screen. 
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9 Heating Design Calculations 
Introduction 
Heating design calculations are carried out to determine the size of heating equipment 
required to meet the coldest winter design weather conditions that are likely to be 
encountered at the site location. These design calculations are traditionally carried out 
using steady-state methods such as those offered by ASHRAE and CIBSE.  You can 
use DesignBuilder to carry out effectively the same calculation using the EnergyPlus 
dynamic thermal simulation engine. 

Click on the Heating Screen tab to view Heating Design data. If the necessary data 
has not yet been generated, a Heating Design calculation is automatically started to 
generate the data. 

Heating design simulations using EnergyPlus have the following characteristics: 

• Constant (Steady-state) external temperature set to the winter design external 
temperature.  

• Wind speed and direction set to design values.  
• No solar gain.  
• No internal gains (lighting, equipment, occupancy etc).  
• Heated zones are heated constantly to achieve the heating temperature set 

point using a simple convective heating system.  
• Includes consideration of heat conduction and convection between zones of 

different temperatures.  
The steady-state simulation continues until temperatures/heat flows in each zone have 
converged.  If convergence does not occur then simulation continues for the 
maximum number of days as specified in the calculation options. 

The simulation calculates heating capacities required to maintain the temperature set 
points in each zone and displays the total heat loss broken down as: 

• Glazing  
• Walls  
• Partitions  
• Solid floors  
• Roofs  
• External infiltration  
• Internal natural ventilation (i.e. heat lost to other cooler adjacent spaces 

through windows, vents, doors, holes) 
 

Zones can be unheated in which case they will ‘float’. 

The total heat loss in each zone is multiplied by a Design margin (safety factor) of 1.8 
by default to give a recommended heating Design Capacity. This heating capacity will 
be written directly into the Heating capacity HVAC model data to be used for 
simulations, depending on the setting of the Plant sizing model option on the Data tab 
under HVAC.  

The Heating Design margin is used to multiply calculated steady state heating loads in 
each zone to give a recommended heating plant size. It accounts for the additional 
heat required to bring the building up to temperature in a reasonably short preheat 
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period and allows you to be confident that comfort conditions will be maintained in 
all but the most extreme winter conditions. 

Why use such a high default safety factor? To ensure that the plant is large enough to 
warm the building up soon after start up on cold winter Monday mornings when the 
building has cooled down over the weekend. Use a lower margin if the preheat 
periods will be long or if some underheat on cold winter mornings is acceptable. 

 

Heating design screen 
Click on the Heating design tab at the bottom of the screen to run heating design 
calculations. The first data tab is Steady-state showing detailed steady state design 
calculation results for the currently selected object in the navigator. 

Steady-state 
The graph below shows the breakdown of the heat losses graphically which can help 
to identify any particularly poor aspects of fabric or systems. In this case the 
mechanical ventilation system dominates the heat loss. 
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Summary 
The Summary tab shows the key results for each zone. The most important heating 
design result, Design Capacity is shown in red and it gives the size of the heating 
equipment required to heat the zones and building to the inside design temperatures 
under outside winter design conditions. 

The totals for blocks and for the whole building are shown in the grid headers. 

 

The table can be exported to spreadsheet csv format using the export toolbar icon. 
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10 Cooling Design Calculations 
Introduction 
Cooling design calculations are carried out to determine the capacity of mechanical 
cooling equipment required to meet the hottest summer design weather conditions that 
are likely to be encountered at the site location. In zones that are not mechanically 
cooled, free-floating temperatures are calculated including the effects of natural or 
mechanical ventilation if these options are selected on the zone HVAC tab.  
 
Cooling design calculations are traditionally carried out using periodic steady-state 
methods such as the admittance and response factor methods provided by CIBSE and 
ASHRAE. You can use DesignBuilder to carry out effectively the same calculation 
using the EnergyPlus dynamic thermal simulation engine. 
 
Click on the Cooling design screen tab to view Cooling design data. If the necessary 
data has not yet been generated, a Cooling design calculation is automatically started 
to generate the data. 
 
Cooling design simulations using EnergyPlus have the following characteristics: 
 

• Periodic steady-state external temperatures calculated using maximum and 
minimum design summer weather conditions.  

• No wind.  
• Includes solar gains through windows and scheduled natural ventilation.  
• includes internal gains from occupants, lighting and other equipment.  
• Includes consideration of heat conduction and convection between zones of 

different temperatures.  
  
For buildings located in the Northern Hemisphere, Cooling Design calculations are 
made for the month of July and for buildings in the Southern Hemisphere they are 
made for the month of January. 
 
Simulation continues until temperatures/heat flows in each zone have converged.  If 
convergence does not occur then simulation continues for the maximum number of 
days as specified in the calculation options. 
 
The simulation calculates half-hourly temperatures and heat flows for each zone and 
determines cooling capacities required to maintain any cooling temperature set points 
in each zone. 
 
The maximum cooling load in each zone is multiplied by a Safety factor (1.3 by 
default) to give a Design Cooling Capacity. This design cooling capacity can be 
written directly into the Cooling capacity model data depending on the setting of the 
Plant sizing model option on the Data tab under HVAC. 
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Cooling design screen 
Click on the Cooling design tab at the bottom of the screen to run cooling design 
calculations. The first data tab is Analysis showing detailed periodic steady state 
design calculation results for the currently selected object in the navigator. 

Analysis 
The data on the Analysis tab gives a good overview of the heat flows, fresh air and 
comfort conditions in each zone. 

 

 

Summary 
The Summary tab shows the key results for each zone. The most important cooling 
design result, Design Capacity is shown on the left and it gives the size of the cooling 
equipment required to cool the zones and building to the inside design temperatures 
under outside summer design conditions. 

The totals for blocks and for the whole building are shown in the grid headers. 
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Parametric Cooling Design 
Use the Parametric facility for Cooling design as a tool for identifying the impact of 
changes in a maximum of 2 design variables on cooling load and maximum 
temperature. The use of parametric simulations is described in detail later under the 
Simulation section. 
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11 Simulations using Hourly Weather Data 
You can generate detailed building energy performance data based on simulations 
using measured hourly weather data. Simulations using EnergyPlus have the 
following characteristics: 
  

• Weather data comes from Hourly weather data file. 
• Includes consideration of heat conduction and convection between zones of 

different temperatures. 
• Includes solar gain through windows and shading from other buildings and 

self shading by the building itself.. 
• Simulation of HVAC equipment 
• Includes one or more warmup days to ensure correct distribution of heat in 

building thermal mass and the start of the simulation. Warmup continues until 
temperatures/heat flows in each zone have converged. If convergence does not 
occur then simulation continues for the maximum number of days as specified 
in the calculation options. 

 
Click on the Simulation tab at the bottom of the screen to view simulation data. If the 
necessary data has not yet been generated, a simulation is automatically started to 
generate the data. 
 

Calculation options 
Before the simulation starts you can change calculation options.  
 
Simulation Period 
Select the start and end days for the simulation, or select a typical period using the 
links on the Info panel. 
 

• Annual simulation - all 365 days of the year.  
• Summer design week - a week identified by the weather data translator as 

being the hottest of the year.  
• Summer typical week - a week identified by the weather data translator as 

being typical of the summer.  
• All summer - simulate the whole summer (as identified by the weather data 

translator).  
• Winter design week - a week identified by the weather data translator as 

being the coldest of the year.  
• Winter typical week - a week identified by the weather data translator as 

being typical of the winter.  
• All winter - simulate the whole winter (as identified by the weather data 

translator).   
 
The typical periods accessed from the Info panel refer to statistically derived data for 
the current hourly weather file. 

Interval 
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Selecting Monthly is required to obtain annual output. Monthly, daily, hourly and sub-
hourly data can selected by checking the appropriate boxes. 

Number of time steps per hour 
The time steps per hour is the number of times the building thermal network is solved 
per hour in the simulations. When the HVAC portion of the simulation begins it's 
solution for the current time step, it uses the basic time step as its maximum but then 
can reduce the time step, as necessary, to reach the solution. Though many buildings 
can be successfully simulated with 1 or 2 time steps per hour, EnergyPlus suggest 4 or 
6 for non-HVAC simulations and 6 or 10 for simulations with HVAC.  
 
Note: 

• In general, increasing the number of time steps improves accuracy but slows 
the simulation (and generates more data if output is requested at the 'sub-
hourly' interval). 

• When using 1 time steps per hour you will not be able to access Temperature 
distribution results 

 
Temperature control – stick with Air temperature control unless you fully 
understand the consequences of the alternative options. 
 
The other options are less frequently used. Full descriptions are given in the help. 

Model Checking Strategy 
Simulation models should go through a minimum check procedure including the 
following: 

• Check model by ensuring that data is being inherited correctly so that changes 
at building and block levels have the desired effect. 

• Run summer design week simulation generating hourly results. Study hourly 
results to check correct operation of the building, equipment operation, 
lighting, natural ventilation, mechanical ventilation, fresh air. 

• Run winter design week simulation checking same data. 

• Run annual simulation generating monthly results, requesting distribution data 
and view distribution data for key zones. 

 

Simulation Analysis 
• Create a new project based on the Default 20x10 2-Zone model with London 

Gatwick. 

• Run a simulation on this model as is changing the default simulation output 
options by requesting monthly, daily and hourly  results and some additional 
output: 

o Comfort 

o Temperature distribution 

Choose an annual simulation period (i.e. the simulation runs for the whole 
year) You should not generally request hourly results when the simulation is 
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for a whole year because large amounts of data are generated, but in this case 
it is a small model so hourly results are fine. 

• You should see results like those below when at building level you select All 
data for Hourly , Daily, Monthly  and Annual intervals. 
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Also go to the East and select Distribution as the interval and you should see the 
graph below. 
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Temperature distribution graphs can provide a useful ‘at a glance’ picture of the range 
of temperatures experienced by the virtual buildings’ occupants. Data such ‘number 
of hours at or over 28°C appear in many national codes. 

 

Parametric Simulations 
Design curves can be very useful at conceptual stages of the design process to 
understand how building performance is affected by variations. DesignBuilder allows 
you to generate curves to show how performance parameters like CO2 emissions and 
comfort vary as key elements of the building design vary. You can select up to 2 
design variables. For example you might want to plot the cooling energy consumption 
for the base design with a range of window to wall % and glazing types variations).  

The selection of the design variables is done in the Display options panel in the 
bottom left of the screen. See below. 
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The design curves are generated by automatically running multiple simulations of the 
base design (i.e. the model defined on the edit screen) with variations applied.  

The number of design variants that are tested for 2 variable tests is the number of 
variants for the first variable multiplied by the number for the second variable. The 
variations in the above example would be different combinations of Glazing type and 
Window to wall %. In all, 6 x 5 = 30 simulations would be required to generate the 
design curves in this example.  

Note in the early betas v.1.9.0 the standard base case design must be simulated 
including monthly data before going on the Parametric screen. 

Tip: Parametric simulations can take a long time to complete and 
DesignBuilder can keep grabbing focus away from the window you are 
working in as it refreshes the progress bar. To avoid this you can minimise the 
main DesignBuilder window. If you have a dual core processor, you should 
now be able to continue working while the simulations continues.  
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The graph shows the diminishing returns with extra louvre projection from 1m to 1.5.  

Typical uses for parametric simulation are: 

• Generating design curves to assist with decision making at early design 
stages. 

• As a teaching aid to help students understand the impact of variations in the 
design.  

• To help communicate concepts with non-experts in building simulation, 
clients, architects etc. Architects particularly appreciate the visual nature of 
the parametric data. 

• Design optimisation with 2 variables. The exercise below shows an example 
of this. The DesignBuilder developers are part way through a research project 
to investigate the potential for true multi-variable optimisation in building 
design. 

Exercise – Parametric simulation - Basics 
• Create a new project using London Gatwick location and the Default 20x10 

Single Zone template. 
• At building level go to the HVAC tab and switch on cooling. 
• Click on the Simulation tab and run an annual simulation. Be sure to request 

monthly results to avoid a bug in the v.1.9.0 beta. 
• When the annual simulation has finished click on the Parametric tab. The 

parametric simulation will start automatically and by default you should find 
that Window to wall %  is selected as the first variable and the second 
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variable is not selected. If so, allow the parametric simulation to complete. If 
not cancel the simulation, set the parameters as they should be and restart the 
parametric simulations by clicking on the Apply toolbar button in the 
Parametric Display options.  

• Set the criteria data to be Total energy consumption.  
• Click on the Apply toolbar icon to start the simulations. When they are 

finished should see the graph below. 
 

 

 

It shows how the total energy consumption varies with changing window to wall %. 
With very large areas of glazing, winter heating and summer cooling are both required 
which causes high energy consumption (top right of graph). Zero glazing fails to 
make best use of free winter solar gains and it doesn’t give the best solution either. 
Total energy consumption is at it’s minimum when there is between 20-40% glazing 
where the best trade off between getting some winter solar heating and avoiding 
summer cooling loads is found. 

You should understand how parametric simulations work to get the most meaningful 
results and avoid common pitfalls.   

Firstly, model variants are generated internally within DesignBuilder by creating a 
copy of the base model and overwriting the model data with the variant data at the 
building level.  

It is important to take into account how this data will be inherited to down to blocks, 
zones etc to ensure you are testing the design variants you think you are. For example 
if the Window to wall %  was hard set at block level in the above Parametric example 
model then changes in this data at building level would not influence the surfaces of 
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the design variants and the results will indicate that the Window to wall % does not 
influence results.  

Because there is no visual check on the state of the design variants the parametric 
function would normally be carried out either on: 

• Well structured and checked models that have been set up to be compatible 
with parametric analysis, that is allowing the appropriate data to inherit from 
the building level parametric changes. Or, 

• Smaller models where it is easy to see how data inherits. 

Parametric simulation results are stored with a record of the change made to the base 
case to create it and this allows new variants to be added to the study without 
invalidating previous results.  
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12 Timing - Schedules, Profiles, Holidays 
This section explains how to model the time-varying nature of building occupancy and 
operation. It also covers how holidays are modelled. 
 
The timing of internal gains, heating and cooling systems and ventilation can be 
defined in one of 2 ways depending on the setting on the Timing setting on the Model 
options dialog: 
 

• Typical workday – quick and easy but less flexible 
• Schedules - default option – takes more time to set up but is more flexible 
 

Typical workday 
This can be a very fast and convenient way to define the timing using just a start time, 
end time, working days per week with seasonal variation available for heating/cooling 
related data. The typical workday approach is intended for easy early stage 
modelling of non-domestic buildings.  
 

 

This approach can be a fast way to set up timing but it does not offer much flexibility. 
For cases where the variations are more complex, you should use schedules instead. 

Exercise –Typical workday 
• Create a new project using London Gatwick location and the Default 20x10 

Single Zone template.  
• On the Model options dialog and set the timing option to Typical workday. 
• At building level on the Activity tab, under Office Equipment change the On 

time to 8:00 and Off  time to 20:00.  
• Now run a Cooling design calculation by clicking on the Cooling design tab at 

the bottom of the screen. 
• Use default calculation options, select just 4-Internal gains results and look at 

results for Computer + Equip. 
• Notice that the maximum heat gain is the 20 W/m2 requested x floor area of 

182.7m2 = 3.65 kW. 
• The equipment timing of the Cooling design and Simulation graphs requires 

some explanation. The data displayed on the graphs is for solar time, i.e. with 
no modification for daylight saving. So at midday the sun has maximum 
altitude. Also data is displayed for the previous 30 minutes in Cooling design 
results (or previous 1 hour when viewing hourly simulation results). So 
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Computer + Equip results at 7:30 actually represent the heat gain to the space 
over the time 7:00-7:30 solar time or 8:00-8:30 local clock time. Check that 
this is correct based on the input. 

 

 
 

Schedules  
Schedules are more flexible than Typical workday and because they are separate 
components they can be exported for use in the Library and in other projects. 
 
Schedules are defined in on of 2 ways: 
 

• 7/12 Schedules – graphical interface but with limited flexibility. 
• Compact schedules – text interface with much flexibility. 

7/12 Schedules 
7/12 schedules allow you to select a different daily profile for each day of the week 
and each month of the year.  
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Profiles 
Profiles are separate components allowing a daily profile value between 0 and 100 to 
be defined over the day. This example profile show variation from 0 at night to 100% 
during the day with the times 8:00-9:00 and 17:00-18:00 being at 50% operation. The 
value can be interpreted as the % operation of the equipment (if the profile is used to 
control equipment) or % occupancy if it is occupancy being modelled etc. The profile 
can only be used as a component in a 7/12 schedule. 
 

. 
 

There are 3 types of profile: 
 

• Constant – a constant value all day. 
• Single period – a single on period define using start and end times (controls 

are like typical workday). 
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• Custom – define any variation using the mouse (instructions for editing the 
data are shown on the info panel). 

 
7/.12 Schedules are the easiest way to define schedules but lack some flexibility 
because every Monday in January must be the some (for example). 

Example – 7/12 Schedules 
• On the Model options dialog set the Timing option back to Schedules. And go 

back to the Activity tab, building level. Notice how the data has changed to 
reflect the Schedules option. 
 

 
 

• We are going to create a new schedule to control the Office equipment. 
• Click on the Office equipment Schedule to open the list of schedules in the 

Data panel on the right then click on the + Add new item toolbar icon to 
create a new schedule.  

• Give the new schedule a name e.g. Occupancy schedule. If the schedule may 
also be used to describe the timing of other equipment or occupancy, give it a 
correspondingly general name (e.g. My Project Occupancy Schedule). 

• Leave the type as 7/12 Schedule. Leave the Design days data too. This data 
describes how the schedule should behave if you use the (default) 
SummerDesignDay Day of week in Cooling design calculations and when 
autosizing Compact HVAC equipment before the main simulation. You can 
read up on this topic in the program help. 

• The Profiles data has a grid with days of the week along the top and months 
down the left. This grid of days and months gives rise to the name 7/12 -7 days 
per week and 12 months per year. 

• Profiles are selected for cells in the grid by first selecting the cells to be 
defined then by clicking on the Edit selected cells link on the right.  

• So first click on the Month cell in the top left to select all cells, i.e. all 
weekdays in all months.  

• Then click on Edit selected cells to open a list of existing profiles. Select the 
profile 8:30 - 16:00 and press OK to select this as the profile for all cells in the 
grid. 

• Now set the weekends to be switched off. To do this select the weekends by 
clicking on the Select all weekends link on the right. You could also have 
done this by clicking on the column headers for Saturday and Sunday.  Now 
click on Edit selected cells and set the profile to be Off . The schedule grid of 
profiles should look like this: 
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• Press OK to create the Schedule. 
• The program should ask you if you would like to select this new schedule. 

Respond ‘Yes’. If it does not ask then select it in the usual way. 
• Now run another Cooling design calculation by clicking on the Cooling 

design tab at the bottom of the screen. Note that because we have edited the 
model since the last set of results were generated the results are deleted and 
the Calculation options dialog is shown. 

• You should see results like those below. 
 

 
 

• Check that these results correspond with your input. 
 

Compact Schedules  
Compact Schedules directly use the EnergyPlus Schedule:Compact data format to 
provide a very flexible way to define time-varying quantities. 
Compact Schedules are defined using a slightly modified version of the standard 
EnergyPlus Schedule:Compact format documented below. It can be easy to make a 
mistake in format so Compact schedule data is checked for correct syntax in the 
dialog. 
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Using the Compact Schedule definition all the features of the schedule components 
are accessed in a single command. Each Compact Schedule must cover all the days 
for a year and it must have values for all 24 hours and all values for all day types.  
 
ScheduleType 
ScheduleType should generally be Fraction even for schedules to be used for 
temperature setpoint definition.  
 
You can enter Any Number to enter values greater than 1 but do bear in mind:  
 

• The maximum gains values (e.g. people/m2) are multiplied by the values in 
the schedule to obtain the actual value to use at each time step in the 
simulation. So if you enter large schedule values the actual maximum value in 
the simulation will be higher than the 'maximum' value entered in DB. There is 
no problem with this, just a methodological concern that if the Interface 
indicates that the maximum occupancy density is say 0.1 people/m2 but the 
schedule has values > 1 then the simulation results will, at first sight, appear 
incorrect. If you come back to the model 6 months later you may not 
remember the reason.  

• Temperature set-point schedules should only have values 0, 0.5 or 1.0.  
 
So generally we recommend using Fraction Compact schedules for clarity. 
 
Field-Set (Through, For, Interpolate, Until, Value) 
Each Compact Schedule must contain the elements Through (date), For (days), 
Interpolate (optional), Until (time of day) and Value.  
 
Field: Through 
This field starts with 'Through:' and contains the ending date for the schedule period. 
You may define multiple schedule periods in this way, for example to define seasonal 
variations. If there are no seasonal variations then enter: Through: 31 Dec, to indicate 
that the data that follows applies to the whole year.  
 
Note that only Month-Day combinations are allowed for this field.  
 
Field: For 
This field starts with 'For: ' and contains the applicable days. Multiple choices may be 
combined on the line.  
 
Choices are:  
 

• Weekdays,  
• Weekends,  
• Holidays,  
• Alldays,  
• SummerDesignDay,  
• WinterDesignDay,  
• Sunday,  
• Monday,  
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• Tuesday,  
• Wednesday,  
• Thursday,  
• Friday,  
• Saturday,  
• CustomDay1,  
• CustomDay2.  

  
In fields after the first 'For', 'AllOtherDays' may also be used. 
 
Note: EnergyPlus has limit of line length of about 60 characters so lines like: 
 

For: Weekdays SummerDesignDay WinterDesignDay 
Weekends Holidays AllOtherDays, 

 
should be changed to: 
 

For: AllDays, 
  
Field: Interpolate (optional) 
Schedule values are input to the simulation at the zone time step, so there is also a 
possibility of 'interpolation' from the entries used in this object to the value used in the 
simulation. This field, if used, starts with 'Interpolate:' and contains the word 'Yes' or 
'No'.  
 
Field: Until 
This field contains the ending time for the current days and day schedule being 
defined. The data should represent clock time (standard) in the format HH:MM. 24 
hour clock format (i.e. 1pm is 13:00). Note that 'Until: 7:00' includes all times up 
through 07:00 (7am).  
 
Field: Value 
Finally, the value field is the schedule value for the specified time interval.  
 
Note: you can use 0 for Temperature type Compact Schedules to indicate that the 
heating/cooling system is switched off during the specified period. See Example 2 
below. 
 
Example 1 - Operation Schedule 
 

SCHEDULE:COMPACT,  
Office_CellOff_Light,  
Fraction,  
Through: 31 Dec,  
For: Weekdays SummerDesignDay WinterDesignDay,  
Until: 07:00, 0,  
Until: 19:00, 1,  
Until: 24:00, 0,  
For: Weekends,  
Until: 24:00, 0,  
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For: Holidays AllOtherDays,  
Until: 24:00, 0;  

 
This schedule could be used to describe the lighting operation in an office. It 
indicates:  
 

• Schedule is a fraction (0-1).  
• No seasonal variation.  
• Weekdays and cooling and heating design days the schedule is 1 (i.e. 'on') 

between 7am and 7pm and 0 (i.e. 'off') other times.  
• Weekends, holidays and all other days the schedule is 'off'.  

 
Example 2 - Temperature Setpoint Schedule 
 

SCHEDULE:COMPACT, 
Bedroom_Cool,  
Temperature,  
Through: 31 Dec,  
For: Weekdays SummerDesignDay WinterDesignDay,  
Until: 05:00, 0.5,  
Until: 09:00, 1,  
Until: 17:00, 0.5,  
Until: 24:00, 1,  
For: Weekends,  
Until: 05:00, 0.5,  
Until: 24:00, 1,  
For: Holidays AllOtherDays,  
Until: 24:00, 0;  

  
This schedule is could be used to describe the cooling temperature setpoint and 
setback in a bedroom. It indicates:  
 

• Schedule is a temperature (degC).  
• No seasonal variation.  
• Weekdays and cooling and heating design days the main temperature setpoint 

data (Activity tab) is used between 5am and 9am and also between 5pm and 
midnight. Cooling operates at setback temperature setpoint data at all other 
times on these days.  

• Weekends the cooling setpoint is main temperature setpoint between 5am and 
midnight. Cooling operates at setback temperature setpoint data at all other 
times on these days.  

• Holidays and all other days the cooling is off.  
 

Setpoint temperature schedules 
Setpoint temperature can vary with the time of the day and setpoints can take on 3 
values: On, Off and Setback. 

Schedules Timing Model Option 
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Operation of heating and cooling equipment is defined by selecting a Schedule under 
the Heating, Cooling and Operation headers on the HVAC tab.  These schedules are 
used to generate both the heating/cooling availability schedule and the temperature 
setpoint schedules used in the simulations. Schedule values greater than 0.5 indicate 
the system is in full operation controlling temperature to the main heating/cooling 
setpoint, values between 0 and 0.5 indicate the equipment in setback mode and values 
of 0 indicate that the equipment is switched off. See Table below. 
 

Value Heating/Cooling Equipment Operation 
0 Equipment is off 
> 0.5 Equipment is controlled using the main 

temperature setpoint data (Activity tab) 
0 < Value <= 0.5 Equipment is controlled using the setback 

temperature setpoint data (Activity tab) 
 
Notes 

• When using 7/12 Schedules, for 0.5 read 50% etc.  
• When using 2-Single period profiles with 7/12 Schedules to generate 

temperature setpoints the 'Off' periods are modelled using setback 
temperatures, i.e. the system is not switched off. If you wish the system to 
switch off outside main heating/cooling hours use the 3-Custom profile type.  

 
Tip: If the setback temperature set does not appear to affect results, this may be 
because the heating/cooling operation schedule selected uses only 0 and 1, not the 
0.5 required to access setback temperature (see table above).  

 
Typical Workday  
You can define the operation of heating and cooling equipment by entering Typical 
workday start and end times and seasonal operation under the Heating and Operation 
headers on the HVAC tab. This data is used to generate both the heating/cooling 
availability schedule and the temperature setpoint schedule used in the simulations.  
 
The example below shows the heating system operation data and you can see that the 
equipment is switched on between the On and Off times (8am and 6pm).  During this 
time the heating equipment is controlled using the main temperature setpoint as set on 
the Activity tab. At other times and during weekends the equipment is controlled 
using the setback temperature setpoint. Weekends are defined on the Activity tab at 
the building level under Occupancy by setting the number of working days per week. 
Days that are not working days are weekends. 
 
The Seasonal control data allows you to set times when the equipment is switched off 
altogether.  For example the heating system data shown below indicates that the 
heating system will be switched on during the winter only and switched off in the 
summer. 
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Holidays 
You can add holidays to the simulation to include the effect of building shutdown 
during certain periods of the year. Do this by selecting the Holidays option under the 
Holidays header on the Activity tab at building level. Holidays defined at building 
level in this way are used for the whole simulation and are additional to any holidays, 
which may have been defined, in Compact schedules (Schedules Timing model 
option).  

The holiday data is used for Simulations only (not Heating/Cooling Design 
Calculations) and allows you to set the Holiday Schedule and the number of days of 
holiday per year. The possible holiday dates are defined in the Holiday schedule and 
the actual holidays to be used in the simulation are selected from the top of the list 
based on the Holidays per year data entered. 

If there are insufficient holidays in the holiday schedule you will receive an error 
message to this effect prior to a simulation. 

The way holiday definition works depends on the Timing model option: 

Compact Schedules 
When the Timing model option is Schedules you can use Compact schedules. The 
value of Compact schedule output during holidays can be defined explicitly using the 
Holidays day type. For example: 
 

SCHEDULE:COMPACT,  
Bedroom_Cool, 
Temperature, 
Through: 31 Dec, 
For: Weekdays SummerDesignDay WinterDesignDay, 
Until: 05:00, 0.5, 
Until: 09:00, 1, 
Until: 24:00, 0.5, 
For: Weekends,  
Until: 05:00, 0.5, 
Until: 24:00, 1, 
For: Holidays AllOtherdays, 
Until: 24:00, 0; 

 

The Holiday data in this Compact schedule indicates that the cooling is switched off 
on holidays. 

7/12 Schedules 
Holiday operation is not defined explicitly and holidays use the same data as Sundays. 

Typical workday 
Holidays use the same data as Sundays. 
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13 Glazing and Solar Shading 
This section examines the processes involved in modelling glazing and solar shading 
with a particular emphasis on avoiding overheating and reducing cooling loads. 

The data for all openings is set on the Openings tab. There are essentially 2 ways to 
define the layout of openings on a façade: 
 

• Use the Default facades mechanism. 
• Draw the openings at surface level. 

 

Modelling Facades 
Default facades provide a fast and easy way to define some typical window layouts. 
The options are: 
 

• None - there is no glazing.  
• Continuous horizontal - glazing is generated in a continuous horizontal strip 

using Sill height, Window spacing and Percentage glazing.  
• Fixed height - glazing is generated with a fixed height at the specified Sill 

height and Window spacing, and width is calculated based on the Percentage 
glazing. This option uses Window to wall % (WWR) but prioritises window 
height.  

• Preferred height - glazing is generated using the window height data and the 
Percentage glazing, but the Window height may be adjusted to achieve the 
required Window to wall %. This option uses Window height, Window 
spacing and Sill height but prioritises Window to wall %.  

• Fixed width and height - windows have fixed width and height. This option 
uses Window to wall % but prioritises Window Width, Height, Spacing and 
Sill height.  

• Fill surface (100%) - the entire surface is filled with glazing and there is no 
frame.  

  
You can use the Window to wall %  (WWR) data and Window height, Window 
spacing and Sill height to easily change the default amount of glazing and its layout 
on the walls.  
 
The Preferred height option is very versatile because it will prioritise the glazing 
area over the height of the windows, whereas Fixed height always gives a fixed 
window height and does not guarantee giving the requested % WWR. 
 
This approach to defining facades is very useful at early design stages when the exact 
configuration of the façade may not be known and the design team are talking in 
terms of  WWR. When the design is more established you might wish to include the 
detailed positions of windows/doors etc and this usually involve drawing individual 
openings at the surface level.  
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Drawing openings at surface level 
When at the surface level drawing tools become enabled to allow you to draw: 

• Windows 
• Vents 
• Doors 
• Sub-surfaces 
• Holes (this is the only way to add holes) 
 

The process involved with drawing openings at surface level is described in the help. 
 
Once a custom opening exists (even if it then is deleted) default glazing, vent and 
door layout model data is ignored. You can clear non-default façade data by using the 
Clear data command. 
 
Flat roofs do not have default glazing set up using Roof glazing layout model data. 
To create openings on a flat roof you should go to the surface level and draw them 
manually there. 

Example – Draw windows at surface level 
• Create a new project based on the Atrium example base template and using 

London Gatwick location. 
• At building level on the Openings tab remove all of the default openings in the 

main building (Ground floor and First floor blocks) using one of these 
methods: 

 
o Set the Window to wall %  to 0, or, 
o Load the No glazing external glazing template 

 
Note that the custom openings already set in the atrium will be unaffected by 
changes in façade settings made at the building level. 

 
• Go to the West surface of Ground floor > Zone 1, 
• Click on the Normal button to take the Normal view looking from outside. 
• Create a window using key ins. First move the mouse so it is near the lower 

left corner of the surface and is still over the edit screen (it must be in the edit 
screen to allow key ins to work) 

• Ensure the default 2-Rectangle shape is selected. 
• Type 5 1.2 <Enter> to position the lower left corner 5m in the x-direction and 

1.2m up.  
• Type 1 2 <Enter> to create a window that is 1m wide and 2m tall. Your 

screen should look like this: 
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• Now draw another window. With Increment snap switched on move the 
mouse cursor so it hovers over the lower right corner of the first window and 
move to the right. You will see a dimension line appear. Start the next window 
1m to the right of the first window same height of 2m.  

 
• Now select both these windows together and clone them creating the copy 2m 

from the rightmost edge of the second window (5m from the left edge of the 
first window). 

 

 
• Now repeat to create a third pair of windows. The surface should look like: 
 

 

 

Editing Openings at building level 
You can copy, move and delete existing openings when at building level. You can’t 
draw openings at building level in v.1. 
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Exercise – Copy openings at building level 
• Continuing from the previous exercise. Go to the building level and copy the 

6 windows from the Ground floor to the equivalent positions on the First floor 
West-facing zone, 3.5m up. The West façade should now look like this: 

 

 
• The next task is to copy these 12 windows to the North and East Facades. As a 

guide to help position in the z direction, first draw a construction line at 1m all 
the way round the building (see above). 

• Then select all these 12 windows and start the Clone command and copy 
them. 

 
Then copy a single pair on each south-facing surface as shown above. 
 
Save this model as a template calling it Atrium example custom glazing 

 
Tips 
• When at building level you can select blocks or openings. If you want to go 

directly to a surface you can double-click on one of the openings to take you 
there. 

• When trying to select a block sometimes it is difficult to avoid selecting 
openings instead. To force selection of a block hold the <Shift> down before 
clicking. 

• You can select all of the windows on one of the facades and move them 
together. 

• You can also delete and move openings at the building level. 
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Solar Shading 
DesignBuilder allows most of the EnergyPlus solar shading mechanisms to be 
modelled including: 

• Window shading devices placed directly in front of, behind or within the panes 
of the windows. These types are provided: 

o Internal blinds (diffusing and blades) 

o External (diffusing and blades) 

o Mid-pane (diffusing and blades) 

o Electrochromic shading systems where a pane in the window darkens 
when activated by a control system. 

All of these have a range of methods to control window shading device 
activation: schedule, solar, temperature, lighting control etc. 

• Local shading devices model obstructions local to the glazing system 
including: 

o Overhangs 

o Sidefins 

o Louvres 

You can define the surface reflection properties of the local shading devices but 
they are fixed and cannot currently activate based on controls. 

• Different glazing types, including solar control glazing 

• Component blocks with time-varying transmission (can allow trees with 
seasonal foliage to be modelled) 

• Assembly blocks allow custom shading systems to be easily set up and 
modified even in large buildings. 

• Building self-shading and reflection (if the reflection solar option is selected). 

 

Window shading devices 
Window shading data can be accessed on the Openings tab under the External 
Windows > Shading and Roof Windows/Skylights > Shading headers.  

Internal windows cannot be shaded using window shading devices. 

Position 
The window shading devices can be positioned in one of four ways: 

• 1-Inside - the window shading devices is positioned inside the zone.  

• 2-Mid-pane - the window-shading device is positioned between the inner 
pane and the second pane.  

• 3-Outside - the window-shading device is positioned outside.  
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• 4-Switchable - electrochromic glazing in which the outer pane is darkened 
based on the shading control. 

 

 

For blinds and shades, when the device is on it is assumed to cover all of the window 
except its frame; when the device is off it covers none of the window. The shading 
device does not affect the wall that the window is on.  

Example – Window shading 
• Create a new project based on the Default 20x10 Single Zone and London 

Gatwick location. 
• First run a Cooling design calculation on the base model to see the solar 

radiation transmitted without any shading. See building level screenshot 
below. 
 

 
 

You should see the graph below after having selected Data to be 4-Internal gains 
and navigated to Ground floor > Zone 1. 
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Did you notice how small the occupancy gain is? Also that it not a constant like you 
might expect from the occupancy schedule used to define occupancy on the Activity 
tab. The reason is that the zone temperature is up in the range 30-40°C where most 
human metabolic heat is given off as latent heat from sweating. The data shown in the 
heat balance is sensible heat only and will fall right down to zero when the zone 
operative temperature rises up to 35°C and above. 

 
• Also lock the Y-axis so you see subsequent results on the same scale. 
 
• Go back to the edit screen (press <F7>). At building level on the Openings tab 

open the Shading header and switch on Window shading. You should see: 
 

 
 

• Click on type and see the list of blinds and shades. Note that you can create 
your own shading devices if necessary. 

• The control type is Schedule so the Operation schedule is defined. In this 
model the blind is set to operate according to occupancy.  

• Now change the control type to 4-Solar and leave the setpoint at 120 W/m2. 
This means that when the solar radiation on the window is greater than 120 
W/m2 the blind operates (i.e. provides shading). 
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• Run a new Cooling design calculation to see the effect of this shading devices 
on solar radiation transmitted. You should see the graph below for Ground 
floor > Zone 1. 

 

 
 

The window shading has reduced solar transmission into the zone from about 13kW 
to about 9kW. 
 

Local shading devices 
To include overhangs, sidefins and/or louvres check the Local shading checkbox.  
This shows the Local shading component data.  
 
 

 
 
DesignBuilder comes with a small database of Local shading devices, but if you 
cannot find a suitable component for your model, you can create a custom local 
shading component in the usual way.  
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Note: the DesignBuilder Local shading devices allow a range of different overhangs, 
side fins and louvres to be defined, but if you need to model a shading device not 
covered by the standard mechanism, you can draw custom shading devices using 
Component blocks and/or Assembly blocks.  

Example – Local shading 
Following on from the last example, now look at the effectiveness of local shading 
devices.  

• At building level, switch off Window shading and switch on Local shading 
and select the Overhand + sidefins (1m projection) local shading type. You 
should see: 

 

 
 

• Run a new Cooling design calculation and view Internal gain  results for 
Ground floor > Zone 1: 

 

 
 

• The graph, with y-axis still locked from the Window shading tests, shows that 
the Local shading device in more effective at blocking solar radiation than the 
window shading. Take a look on the Visualisation screen below to see why. 
The shading devices effectively protect the glazing from solar radiation during 
the hottest part of the day. 



Simulation and CFD Training Guide  

DesignBuilder copyright © 2009 93 

 

 
 

• The shot below shows that no direct solar radiation is finding it’s way into the 
zone at 3pm when looking towards the South West (where the sun would be at 
the time). 

 

 
 

A model with local shading devices or component blocks can be made more accurate 
by including reflections. These are excluded by default. The exception is ground 
reflected solar that is fully included without interception by local shading devices or 
component blocks when reflection is switch off. When reflections are included the 
shading effect of local shading devices and component blocks on ground reflected 
solar is included. So select this in the Model options > Cooling design tab > Solar 
options header > Model reflections data.  
 

• Does the inclusion of reflections and blocking of ground reflected solar affect 
results?  
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The graph when compared with the previous, suggests that the Model reflections 
option affects solar gains quite a lot. So you should ideally use this option unless your 
building model is large, in which case, the extra geometric calculations involved in 
including reflections may slow the simulations too much. 
 

Component blocks 
Component blocks for shading the outside of a building should be added at the 
building level. 

Exercise – Component blocks as shading devices 
• Starting from the previous example, switch off all Local and Window shading. 
• On the Layout tab draw a large component block in front of the South-facing 

windows as shown below. The component block should be 1m from the South 
wall and 20m high. 
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• At building level on the Construction tab open the Component Block header. 

You should see: 
 

 
 
• The transmittance of 0 means that the component blocks in the model are by 

default opaque. You can allow a fractional opacity by entering a number 
between 0 and 1 for Maximum transmittance. The material defines the texture 
and surface properties of the component block for solar and visible reflection. 
Leave the default values. 

• Go to the component block by single clicking on it in the Navigator. You will 
see that the above is the only data held for it. Go back up to the building level 
(press <F2>). 

• Set the Model reflections option (if it is not already set). It is important to use 
the reflections option for this model because the component block should 
block ground reflected solar. 

• Compare your results with the graph below.  
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14 Daylighting 
You can control the electric lights according to the availability of natural daylight. 
When Lighting control is switched on, illuminance levels are calculated at every time 
step during the simulation and then used to determine how much the electric lighting 
can be reduced. The daylight illuminance level in a zone depends on many factors, 
including sky condition, sun position, photocell sensor positions, location, size, and 
glass transmittance of windows, window shades and reflectance of interior surfaces. 
Reduction of electric lighting depends on daylight illuminance level, illuminance set 
point, fraction of zone controlled and type of lighting control. 

 

Tip : Daylight control set in zones without any windows will generate errors 
preventing calculations from running.  

 

Lighting areas 
When lighting control is switched on, by default all of the lights in the zone are 
controlled by the first (main) lighting sensor and % Zone Controlled by Lighting 
Area 1 has value 100%.  

Some larger spaces may have 2 Lighting Areas, each area having its own lighting 
sensor and covering its own area of the zone. The area is not defined geometrically in 
DesignBuilder - it simply reflects the fraction of the total General overhead electric 
lighting that can be dimmed by its lighting sensor.  

If the zone has a different sensor for the back half (for example) you should check the 
Second light sensor option. 

You may wish to use 2 Lighting Areas for these situations: 

• A large zone may need more than one sensor if the output from main sensor 
does not represent the daylight available in other parts of the zone. For 
example a zone having facades in both South and East directions would need 2 
sensors (and 2 Lighting Areas), one on each facade.  

• The zone has 2 different activity areas which have been lumped into a single 
zone for convenience. The 2 activities have different visual illuminance 
requirements and the Lighting Areas for both can benefit from daylighting 
through daylighting control. An example would be a zone having both office 
and recreational space. The office space may have a lighting requirement of 
500 lux and the recreational space may need 300 lux.  

Important note: If the zone has perimeter and core areas |(perimeter lights having 
daylight control and core lights not) then you only need to use a single lighting sensor. 
The uncontrolled core lights can be modelled using % Zone Controlled by Lighting 
Area 1. If 60% of the lights in the zone are located in the core zone and do not have 
daylight control then set % Zone Controlled by Lighting Area 1 to 40. 



Simulation and CFD Training Guide  

DesignBuilder copyright © 2009 98 

Perimeter Area  
A typical perimeter area would be the areas of the zone that are close to a window. By 
convention, perimeter areas are defined as the area within a fixed distance from a 
normal to the perimeter. In the UK NCM the fixed distance is 6m. 

If you wish to create a separate thermal zone to model the different lighting and solar 
conditions in the perimeter area, you can use the Offset snap option to draw Virtual 
partitions . 

Daylight illuminance on the 'working plane' is calculated for 1 or 2 locations in each 
zone during the simulation and illuminance setpoints are maintained where necessary 
by electric lighting.  The sensor is always located in the working plane, which, by 
default, is 0.8m above the floor. Also by default, when lighting control is switched on, 
a single photo sensor monitors the daylight illuminance at the first sensor location and 
controls the lights for the whole of the zone. You can however set up 2 Lighting Areas 
in each zone, by checking the Second lighting area check box. In this case you can set 
a target illuminance for the second lighting area separately and also define the 
percentage of the zone covered by Lighting Area 2. 

Note 1: the floor area covered by the 2 sensors does not need to add to 100%. The 
lights in the remaining floor area operate without daylight control. 

Note 2: the target illuminance for Lighting Area 1 is set on the Activity tab under 
Environmental Control. 

If there is only one lighting area then a percentage equal to  

 100 - (%Zone covered by Lighting Area 1)  

is assumed to have no lighting control.. 

% Zone Controlled by Lighting Area 2 

The fraction of the zone floor-area whose electric lighting is controlled by the daylight 
illuminance on the second sensor. This data is required if Lighting Area 2 is being 
used. A percentage equal to 

100 – [%Zone Controlled by Lighting Area 1] – [%Zone Controlled by Lighting Area 
2] 

is assumed to have no lighting control (i.e. in this uncontrolled area of the space, the 
lights operate purely according to the schedule without any dimming/switching). 

Note: by default the main lighting sensor is positioned in the geometric centre of the 
zone. It is important that you check the position of all lighting sensors to obtain 
accurate results. For example, if the lighting sensor is positioned right next to a 
window receiving large amounts of daylight, the lighting sensor will signal 'enough 
daylight' even if the rest of the zone is only dimly lit and electric lighting energy will 
be under-estimated (daylight savings over-estimated). 

Continuous Control 

With Continuous control, the overhead lights dim continuously and linearly from 
maximum electric power, maximum light output to minimum electric power, 
minimum light output as the daylight illuminance increases.  The lights stay at the 
minimum point with further increase in the daylight illuminance. 
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The Minimum input power fraction for Continuous control type is the lowest 
power the lighting system can dim down to, expressed as a fraction of maximum input 
power.  For Continuous/off lighting control, this is the power fraction reached just 
before the lights switch off completely. 

The Minimum output fraction for Continuous control type, is the lowest lighting 
output the lighting system can dim down to, expressed as a fraction of maximum light 
output.  This is the fractional light output that the system produces at minimum input 
power.  For Continuous/off lighting control, this is the power fraction reached just 
before the lights switch off completely. 

Note: Continuous control provides an idealised lighting control mechanism which can 
be useful for calculating upper limits on the potential for savings using natural 
daylight. 

Continuous/Off Control 

Continuous/off control is the same as continuous control except that the lights switch 
off completely when the minimum dimming point is reached. 

Stepped Control 

Stepped control allows you to switch lighting on/off according to the availability of 
natural daylight in discrete steps.  Whereas the Continuous control described above 
provides precisely controlled illuminance by dimming the lights, the stepped control 
models blocks of lights switching on/off according to the electric lighting 
requirement. 

The electric power input and light output vary in discreet, equally spaced steps. The 
number of steps can be set. 
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Glare 
Maximum allowable glare index 

If a daylit zone has windows with window shading devices, the shades will be 
deployed if the daylight glare at sensor 1 exceeds the value of Maximum allowable 
glare index. To get this type of glare control you have to specify Shading control type 
as 5-Glare for one or more windows in the zone (see Window Shading Control). 

View angle relative to y-axis 

Daylight glare from a window depends on occupant view direction. It is highest when 
you look directly at a window and decreases as you look away from a window. This 
field specifies the view direction for calculating glare. It is the angle, measured 
clockwise in the horizontal plane, between the positive y-axis and the occupant view 
direction, i.e. it is the bearing of the persons line of sight. For example, with Site 
orientation = 0, in the Northern Hemisphere, 90 = Facing East, 180 = Facing South 
etc). 

Algorithms 

DesignBuilder offers a choice of EnergyPlus daylighting algorithms: 

• 1-Detailed is the default option and the most practical for most purposes. 
• 2-DELight does a full radiosity lighting calculation, i.e. it bounces light 

beams around each zone to calculate daylight distribution. It has some 
limitations though. 

These can be selected on the Model options dialog on the Advanced tab under 
Lighting. 

 

Daylight control procedure 
The procedure for introducing the lighting control is: 

• Check the Lighting Control On checkbox (at building level if all zones are to 
have lighting control).  

• Select the type of control as described below.  
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• Position the first sensor in each zone having lighting control. The z-position is 
set by the Working plane height on the Advanced tab of the Model options 
dialog.  

• Set the % Zone covered by Lighting Area 1. If all the lights in the zone are in 
Lighting Area 1 (i.e. they are controlled by the 1st (main) lighting sensor then 
enter 100%.  

• If there are two lighting areas then position the second sensor.  

• Set the % Zone covered by Lighting Area 2. If all the lights in the zone are in 
Lighting Area 2 (i.e. they are controlled by the 2nd lighting sensor) then enter 
100 - %Zone covered by Lighting Area 1.  

• Check for zones with lighting control specified but having no natural daylight. 

• Check hourly results and make sure they make sense! 

 

Exercise – Daylighting calculations 
To test the various daylighting settings: 

• Following on from the last exercise, at building level go to the Lighting  tab 
and switch on Lighting Control . 

• Note that the default control method is 1-Linear.With this method you can 
also define the minimum output fraction of the lights when fully dimmed and 
the corresponding power fraction. These these in their default states. 

• Now go to the Layout tab and notice that the sensor position is shown.  
• By default the sensor is placed in the middle of the zone. You can move it to a 

specific location by selecting it then moving it using the move toolbar icon. 

• Also keep the default the Detailed daylighting method and 0.8 m working 
plane height (Model options > Advanced tab > Lighting header).  

• Click on the Simulation tab and run a simulation for 6 December only. Select 
Sub-hourly results and set the Time steps per hour to 4.  

• Go to Ground floor > Zone 1, select the sub-hourly interval and show 4-
Internal gains data. Open the Detailed Display options tab and switch off the 
display of the Zone/Sys sensible heating system under the Internal gains 
header and save the selection as a template for later use by pressing the Save 
Display options toolbar button. The results should look like: 
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• Now go back to the edit screen (press F7), go to building  level and change the 
light control settings.  

• Use the 2-Linear/off  Lighting control type this time and run a simulation 
choosing the same calculation and display options as before, you should see: 
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Now test the Stepped control method using 3 steps. 
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Optional Exercise - DElight 
Use the EnergyPlus tab of the Program options dialog to change the version of 
EnergyPlus used.  If you have been able to get the exe version, go to the Advanced tab 
of the model options dialog, open the Lighting header and change the Daylighting 
method to 2-DELight . This will use the advanced DElight calculation method using 
ray-tracing to calculate the daylight illuminance. 

The DElight  method of analysing daylighting in buildings is very similar to that used 
in the Detailed method. For each point in time, DElight calculates the interior 
daylighting illuminance at specified reference points and then determines how much 
the electric lighting can be reduced while still achieving a combined daylighting and 
electric lighting illuminance target. The daylight illuminance level in a zone depends 
on many factors, including exterior light sources; location, size, and visible light 
transmittance of simple and complex fenestration systems; reflectance of interior 
surfaces; and location of calculation reference points. The subsequent reduction of 
electric lighting depends on daylight illuminance level, illuminance set point, fraction 
of zone controlled, and type of lighting control. 

There are two primary differences between the Detailed and DElight methods of 
calculating interior illuminance levels: 

• The first is that DElight includes the capability of analysing complex 
fenestration systems that include geometrically complicated shading systems 
(e.g., roof monitors) and/or optically complicated glazing systems (e.g., 
prismatic or holographic glass). 

• The second key difference is that DElight uses a radiosity method to calculate 
the effects of light reflection inside a zone. These methods are discussed in 
more detail in the engineering documentation. 

There are other important differences between the two methods: 

• One is the inability of DElight to perform the type of dynamic shading 
controls possible using the Detailed method at each point in time during the 
thermal simulation (e.g., changes in electrochromic glazing transmittances and 
blind slat angles).  

• Another is the DElight ability to include > 2 reference points in its interior 
illuminance and electric lighting reduction calculations. A third is the current 
lack of visual quality (e.g., glare) calculations performed by DElight.  

• Fourth, the modelling of interior obstructions is different in the two methods. 
In the DElight method, interior obstructions block inter-reflections but do not 
block the initial direct illuminance. In the Detailed method, interior 
obstructions block the initial direct illuminance but do not block inter-
reflections. 

Compare the results using DElight with those calculated using the Detailed 
daylighting method.  
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15 Comparing results 
There are 2 ways to compare results between different design variants and they are 
illustrated by comparing between the results for the 2 Daylighting calculation methods 
discussed earlier. The 2 comparative reporting methods currently available are: 

• Report topics and 

• Different buildings, one for each variation. 

Report topics 
The Reporting mechanism allows you to collect multiple result sets using the Report 
topic export option. Export graphs shown on the screen as report topics and compare 
results later in the Compile reports dialog. See screenshots below. 
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The Compile reports dialog above includes a list of all the report topics that have been 
exported in the project. You can generate a .doc or .pdf containing the selected report 
topics or you can use the mechanism to compare results. This approach is good from 
the memory point of view as the results for the different runs are stored in png or jpg 
format. But there is not much flexibility – just a record of results with a caption. 

Multiple buildings 
Alternatively you can set up identical buildings by copying a base building multiple 
times at site level and making edits to them to create the design variants. Note that 
most model options are stored with the building so each of the building variants could 
be exactly the same but with a different model option.  

 

 

 

You can compare results on the Simulation screen by switching between the 2 
buildings using the navigator. 
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• This approach works well for small easily managed models but you must 
make sure that the models really are the same apart from the intended 
differences.  

• Also, it will not work well for very large models because the models and their 
results are stored in memory simultaneously and this will cause DesignBuilder 
to slow down especially if you don’t have much free memory on your 
computer. 

Some new design comparison tools are in the pipeline for v.2. 
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16 Natural Ventilation 
 
Natural ventilation is the process by which the building is ventilated to provide 
cooling and fresh air driven through the building by natural forces (as opposed to use 
of fans which is called Mechanical ventilation in DesignBuilder). Two forces drive 
natural ventilation in buildings: 
 

• Stack effect, in which relatively warm air is lighter than cooler air and will 
tend to rise, leaving a region of low pressure behind it.  

 
• Wind, which is often the dominant of these two forces.  

 
DesignBuilder can be used to model natural ventilation airflows due to these effects 
through windows, vents, holes and cracks in the building fabric.  
 
Airflow through an opening can be calculated by determining the pressure differential 
that exists across the opening. The pressure differential comes from pressure inside 
the building that is mainly caused by temperature and wind pressure on the opening. 
More information on this is provided in Appendix I. 
 

 
 
In real buildings these natural ventilation airflows depend on many parameters such as 
the size, shape, position and orientation of the openings and cracks in the building 
fabric as well as the meteorological conditions such as wind-speed and outside 
temperatures.  
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Natural ventilation can be used in many climate zones to effectively cool buildings 
without over-reliance on electric driven fans, which can be expensive and polluting to 
run. Occupants of naturally ventilated buildings will often be expected to experience 
wider swings in temperature than in air-conditioned buildings but the benefit is often a 
more pleasant internal environment. Natural ventilation is not normally adequate to 
maintain good comfort conditions in very hot and humid climates or where very high 
levels of heat gain are present. 

Scheduled and Calculated natural ventilation 
DesignBuilder allows you to carry out sophisticated analyses including consideration 
of wind and buoyancy-driven flows through windows, vents, doors, cracks and holes.  
Bulk airflow movement between zones is calculated within EnergyPlus using the 
AirflowNetwork option.  This is activated using the Calculated Natural ventilation 
option (described below in Examples 3-5).  
 
Internal thermal comfort can be assisted through control mechanisms ranging from 
manual window opening to sophisticated automatic vent opening systems that 
optionally link with a mechanical HVAC system.  
 
For early design stage analysis you can take a simpler approach where you specify a 
previously estimated or calculated natural ventilation rate using the Scheduled 
Natural ventilation option (described below in Examples 1 and 2). The worked 
examples that follow take you through the steps involved with using both of these 
approaches. 
 

Scheduled Natural Ventilation 

Introduction 
If you have an approximate idea of the natural ventilation rates in the building, or if 
the natural ventilation heat flows are expected to be small relative to other heat flows 
in the building you can use Scheduled natural ventilation for a fast and easy 
calculation.  
 
To do this set the Natural ventilation model option to Scheduled. 
 
In this case simulated ventilation airflows are defined for 3 categories of flow path: 
external ventilation, internal ventilation and infiltration. 
 

• Airflow through exterior windows, vents and doors is defined directly in air 
changes per hour.  You can also set a schedule if the flow rate varies according 
to time. 

• Infiltration (flow through cracks and fabric porosity) is defined using a 
constant air change rate per hour. 

• Airflow through the interior windows, vents and doors is modelled using the 
concept of mixing where equal amounts of air transferred from one zone to 
another and vice versa.  The flow rate is directly proportional to the opening 
area. There is no way in version 1 to set specific airflow rates between zones. 
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Data Entry 
This first natural ventilation worked example is based on the Atrium example model 
template created earlier.  
 

• First create a new project using London Gatwick as the location and select the 
Atrium example base model. 

• Go to the building level and click on the HVAC tab. If you have used the 
default Hot water radiator heating, nat vent HVAC template you should see 
something like: 

 

 
 

• If you have a different HVAC template loaded then load the Hot water 
radiator heating, nat vent template.  

Note that in DesignBuilder infiltration  is unintentional, 
uncontrolled airflow entry through the fabric, cracks etc, whereas 
natural ventilation  is controlled and can have schedules, 
setpoints etc. 

Bear in mind that although the building you are modelling may 
not actually have thermostatic controlled windows and vents, the 
building occupants may open and close windows to remain 
comfortable. So it is often appropriate to use setpoint 
temperatures even for manually operated windows. 
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• Load the ‘Summer northern hemisphere’ natural ventilation operation 
schedule meaning that natural ventilation is available all summer, day and 
night. 

• The heating operation schedule is ‘Winter heating (Northern Hemisphere)’ 
preventing heating operation in the summer. 

• Also check that the Natural ventilation model option is set to Scheduled as 
shown below. It will probably be already set as this is the default option. 

 

 
 

• At building level set some effective shading for external windows and 
rooflights. Use the Window shading option, select Blind with high reflectivity 
slats and use the 4-Solar control type option. Use the same options for 
rooflights. 

 
• Now enter the following data (if the data is already set to the required value 

then leave it): 
 

 
Model Data 

 
Building Comment 

Construction tab > Airtightness 

Infiltration constant rate (ac/h) 0.5   

HVAC tab > Natural Ventilation  

Outside air definition method 1-By zone  
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Outside air (ac/h) 5 
Most important data and most 
difficult to estimate accurately. Also 
set this in the Atrium zone. 

Schedule 
Summer (Northern 
Hemisphere) 

 

Activity tab > Environmental control > Ventilation Setpoint Temperatures > Natural 
Ventilation  

Nat vent cooling (°C) 21  

Max in-out delta T (K) 2  

Activity tab > Environmental control > Heating Setpoint Temperatures 

Heating (°C) 20  

 
Note: Making these settings at building level does not affect the atrium zone as it has 
the <None> HVAC template loaded at the block level.  
 
The Max in-out delta T sets a maximum temperature difference to avoid warm air 
being introduced. A value of 2 means that the outside air must be at least 2°C colder 
than the inside air for the windows to be opened. 
 
If the schedules allow natural ventilation and heating to occur during the same 
periods, the natural ventilation and cooling setpoint temperature should be higher than 
the heating setpoint temperature to avoid simultaneous operation and wasted heating 
energy. This is why the natural ventilation cooling setpoint temperature is set to 21°C 
and free heating setpoint temperature is set to 20°C and heating is switched off in the 
summer. 
 
Start a Simulation to test the settings. Click on the Simulation tab at the bottom of 
the screen and when the Calculation options dialog is open select the Summer typical 
week period by clicking on the corresponding link on the Info Panel on the right of 
the dialog. Select only Hourly  results.  
 

Results Analysis 
When the simulation is complete select Hourly results in the Display options panel 
and go to Ground floor > Zone 1 by clicking on the Navigator panel. You should see 
results as below. 

 



Simulation and CFD Training Guide  

DesignBuilder copyright © 2009 113 

 
 

Some points to note about these results: 
 

• Looking at the purple “Mech vent + Nat vent + Infiltration” data, the 
maximum airflow rate is 5.5 ac/h. This is made up of 5 ac/h due to natural 
ventilation and 0.5 ac/h due to infiltration. 

• The natural ventilation is switched on all the time in the summer to get free 
night cooling (windows and vents are left opened) but the natural ventilation 
air-change rate is not always 5 ac/h. This is because the natural ventilation is 
being controlled to avoid overcooling the space. You can see that the 
minimum air temperature in the zone is approximately 21°C. The temperature 
is being controlled by the natural ventilation cooling setpoint temperature set 
on the activity tab. This simulates the operation of thermostatic-controlled 
vents. It also gives an idea of likely building operation for manually operated 
windows where occupants will tend to open and close windows to stay 
comfortable. 

• The dark green External Vent line in the heat balance graph shows the 
thermal cooling effect due to natural ventilation. Note that natural ventilation 
supplies up to 15 kW of cooling. 

 
 
 

What happens of you change the natural ventilation operation schedule to switch off 
at night? 
 
Now save the file as a template (File > Save > Save as template) calling it something 
like Nat Vent Example 1. 
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Scheduled Natural Ventilation with Internal Airflow  
This worked example follows on from the previous one but by allowing internal 
airflow to occur between the occupied zones and the atrium. 

Data entry 
Starting with the model you created in Example 1, follow these steps: 
 

• Open Model options dialog and click on the Advanced tab and the Natural 
ventilation header. Switch on the “Airflow through internal openings” 
option under the Scheduled header to allow airflow to pass through the 
internal opening we have just drawn.  Leave the airflow rate per opening area 
as the default value of 0.1 m3/s-m2. This will cause 0.1 x the area of each 
opening m3/s airflow mixing between the 2 adjacent zones. The Model 
options data should now look like the screenshot below. 

 

 
 

Results analysis 
Rerun the simulation for the same period by clicking on the Simulation screen and 
clicking on the OK button of the simulation options dialog when prompted.  

 
The results for Ground floor > zone 1 should look something like the screenshot 
below. Note that the purple Internal Natural Vent  data shows the ‘mixing’ heat 
transfer through the windows and vents - positive values in Ground floor > Zone 1 
show a heat gain from internal ventilation and corresponding negative values in the 
atrium show heat loss. 
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Note that this does not model the internal flow in the actual building very well 
because the atrium would really act as a stack and draw air in from the adjacent 
offices. In this case the effect of internal natural ventilation would be a benefit to the 
offices as the negative pressure created will induce cooler outside air to flow in. To 
model this we need to use Calculated natural ventilation.  
 
Now save the file as a template (File > Save > Save as template) calling it something 
like Nat Vent Example 2 
 

Calculated Natural Ventilation 

Introduction 
With the Scheduled natural ventilation option used in Examples 1 and 2 a known 
value is used to define natural ventilation flow rate in the model.  In many cases 
however the actual natural ventilation flow rate will not be known and the user may 
prefer to allow EnergyPlus to calculate flow rates based on the size, configuration, 
position and orientation of the openings and cracks in the fabric as well as the minute 
by minute simulated physical conditions of the air including wind-speed, pressure, 
inside and outside temperatures etc. This is possible in DesignBuilder by using the 
Calculated natural ventilation option. 
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Before starting, you should understand some important differences between 
Scheduled and Calculated natural ventilation: 
 

• Calculated natural ventilation requires more input data, some of which can 
be quite hard to obtain, in particular wind pressure coefficients. For this 
reason, while calculated natural ventilation is theoretically more accurate, you 
should be aware of the need for care in data entry to avoid inaccurate results 
(garbage in = garbage out). If the building is of fairly typical construction and 
configuration it can sometimes be more accurate to use empirically obtained 
ventilation rates for typical buildings if you do not have the time to spend 
carefully setting up the calculated natural ventilation model. 

• People new to building energy simulation can be surprised to find that by 
switching from Simple natural ventilation to Calculated natural ventilation the 
results are very different.  This should not be surprising when you think 
about it because the data entry is completely different. The key parameters in 
Calculated natural ventilation being window and vent opening sizes and 
operation, whereas the key parameters in Scheduled natural ventilation are the 
directly input ventilation rates and operation. There is not necessarily any 
relationship between the default window opening areas used with the 
Calculated option and the default natural ventilation flow rate used with the 
Scheduled option. 

• Calculated natural ventilation increases simulation time significantly because 
of the extra calculations required at each time step in the simulation to 
calculate airflow rates. 

Data Entry 
In this worked example we will convert the Scheduled natural ventilation model from 
Example 1 to use Calculated natural ventilation and explore the most important data 
required to achieve a realistic natural ventilation simulation. 
 

• First open the model created for Example 1. 
 

• Open the Model options dialog and switch to using Calculated natural 
ventilation. When you press OK on the Model options dialog you will be 
asked if you wish to use Compact HVAC to allow mechanical ventilation to be 
modelled.  Respond “No” because we will not model mechanical ventilation in 
this Example. 
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• Go to building level and click on the HVAC tab and check that Natural 
ventilation is switched on.  

 
• Still at the building level, click on the Openings tab and open the Operation 

header under External Windows.  This data defines the maximum extent to 
which the windows are able to open. The data is only available when using 
Calculated natural ventilation.   

 
• The operation schedule can also be defined here. This is not the schedule 

controlling the operation of the windows but rather an availability schedule 
describing the times when the windows are allowed to open, associated 
controls permitting. Leave the default ‘Summer (Northern Hemisphere)’ 
operation schedule.  This means that the window opening can open any time 
when this operation schedule has a value greater than zero (any time in the 
summer in the case).  

• Now go to the Building level and under External Windows > Operation enter 
“% Glazing area opens” to 5% meaning that each window in the building 
can open a maximum of 5% of its total area.   

• For the Atrium enter “% Glazing area opens” to 0% because atrium external 
windows do not open. 

• Answer “No” when asked if you would like to use Compact HVAC when 
closing the Model options dialog. The Natural Ventilation section of the dialog 
should look like this: 

 



Simulation and CFD Training Guide  

DesignBuilder copyright © 2009 118 

 
 

This same data can be edited under the Natural Ventilation and Options 
headers on the HVAC tab and this is the preferred way to set this data now. Be 
sure to be at building level when making the setting in this way so the edit is 
inherited to all the surfaces in the building. 

 
• Go to the building level and Click on the Openings tab and set all vent operation 

schedules to operate during the summer only. The openings tab should look like: 
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• Go to the building level and Click on the Constructions tab and under the 
Airtightness header check that Model infiltration  is switched on and check that 
the Crack template slider is set to Medium. This means that all crack sizes in the 
building will be taken from the “Medium” crack template. You can currently 
select from these options: 
 

• Very poor 
• Poor 
• Medium 
• Good 
• Excellent 

 
Note that although the infiltration rate in ac/h can be set this is only used in 
Heating and Cooling design calculations. 

 
• Click on the “Show crack data” link in the Info panel to see the definition of the 

currently selected crack template. 
• The model is now ready for the simulation so click on the Simulation tab and 

using the same options as before (Hourly results, Summer typical week) press 
OK to start the simulation.  

• Check that your hourly results for Ground block > Zone 1 are similar to those 
below.  
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The results show: 
 

• The zones have air temperature approximately controlled to the natural 
ventilation setpoint temperature of 21°C.  

• Typical total air change rates (purple Mech Vent + Nat Vent + Infiltration 
data) are between zero and 16 ac/h. 

 
Try running the simulation again but with the building external windows closed at 
night. In this case much less ventilation is possible at night and less nighttime cooling 
occurs. Infiltration rates at nighttime when the windows are closed are between 0.3 
and 0.05 ac/h. The variations are caused by variations in wind speed. More on this in 
the next Example. 
 
Now save the file as a template (File > Save > Save as template) calling it something 
like Nat Vent Example 3. 
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Advanced Calculated Natural Ventilation 

Introduction 
In this Example we will explore some more advanced calculated natural ventilation 
options including wind pressure coefficients, wind effects vs temperature effects, 
internal airflow and how to check airflow rates through individual openings. 

Wind Pressure Coefficients 
Building geometry and surroundings play a major role in determining wind effect on 
opening. The pressure caused by wind blowing on an external surface is calculated 
using wind data from weather file and the wind pressure coefficient for current 
particular wind incidence angle on the surface. This information is entered as wind 
pressure coefficient values, one for each angle of incidence in increments of 45°.  
 
Go to the North facing Wall surface in Ground floor > Zone 1 and click on the 
Openings tab and open the Wind Pressure Coefficient (WPC) header. You should see 
something similar to the screenshot below.   
 

 
 
This default data is automatically generated and loaded when the surface is first 
created from standard AIVC tables for building aspect ratios of 1:1. The data is 
approximate and suitable for early stage natural ventilation analysis only.  
 
You can see that when the wind is normal to this surface the Wind Pressure 
Coefficient is 0.4 i.e. the pressure, Pw, on the outside of the surface at any time in the 
simulation is given by the equation: 
 

Pw = 0.5.(air density).(0.40).(wind velocity)2 
 
Likewise similar pressure coefficients are given for other wind angles relative to the 
surface normal. See Appendix I for more details on this. 
 
In this example, leave the Wind Pressure Coefficient data in its default state. 
 

Testing the effect of wind 
• Try changing the Wind factor to 0 (HVAC > Natural Ventilation > Options at 

building level to effectively switch off all wind effects in the model and rerun the 
simulation.  

• Also switch on output of airflow in/out of openings by going to the Misc tab at 
building level. Select these options: 
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Making this setting at building level will mean that large amounts of data could be 
stored for each surface and each opening in the model, especially if hourly or sub-
hourly results are requested and long time periods are simulated. For the design week 
we are looking at you should not have any problems, though simulations will take 
longer when more output is requested. 
 
Reviewing hourly results for the Ground floor > Zone 1 >  Wall 67.795 - 270º > 
Window (External) 6.795m2 you should see results similar to the screenshot below: 
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Make sure to select the first window as the other 2 were ‘lumped out’ and don’t have 
any data. The results for the 1st window have been multiplied by 3 to account for the 
other 2 windows. 
 
Has the switching off of the wind reduced the fresh air delivery very much in the 
offices? 
 
You should find that air is mainly flowing into the building through the openable 
office windows giving cooling in the main occupied part of the building and is exiting 
from the vents in the roof of the atrium. Check you understand the nature and 
magnitude of the flows through all openings and surfaces. 
 
Since there are no wind effects, the natural ventilation is driven entirely by buoyancy 
effects, which in turn are driven by temperature differences between inside and 
outside.  Because hour-to-hour variations in these temperature differences are less 
marked than variations in meteorological wind speed the ventilation ac/h rates have 
less hour-to-hour variations. 
 
Switching wind off in this way can be a useful design tool to ensure that a building 
can be reasonably well ventilated even if there is no wind. It also illustrates the 
importance of harnessing natural wind pressures to ensure effective natural 
ventilation. 
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Display wind speed alongside other results 
Set the building Wind factor back to 1, rerun the simulation and view 
the results for the Block 1, which gives averages and totals for the 
whole block.  
 
On the Detailed tab of the Display options, scroll down to the bottom of 
the list, check the Wind speed option and click on the Apply button. 
Screenshot right. This includes Wind speed data alongside other results 
just for this graph (you can save the selection by using the Save toolbar 
icon on the Detailed tab). 
 
The screenshot below shows that there is quite a strong correlation 
between Wind speed and airflow rate (bearing in mind that the windows 
are shut at night and that temperature control also plays a major part in determining 
external airflow rates). You can see the influence of wind speed by observing that the 
peaks in wind speed tend to occur at the same time as the peaks in airflow rate. 
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17 Simple HVAC 
Introduction 
In DesignBuilder ‘HVAC’ refers to all elements of the building whose function is to 
provide heating, cooling and ventilation to provide comfort for the occupants. This 
includes natural ventilation, but this topic is covered in a separate section. 
 
DesignBuilder offers a range of HVAC system types and also 2 levels of detail:  
 

• Simple where the system is modelled by calculating the loads required to meet 
the heating and cooling setpoints. HVAC system energy consumption is 
calculated from these loads using seasonal system CoPs.  

• Compact using the EnergyPlus Compact HVAC. This allows a much more 
detailed model of some HVAC system types to be developed but using simple 
parametric input data that can be loaded from templates.  

 
In many cases, especially at early stages of the design process when looking at fabric, 
glazing, solar shading options, you may not want to model the details of the HVAC 
system. In these cases the heating and cooling energy consumption can be calculated 
from loads using assumed seasonal system Coefficient of Performance (CoP) values.  

Example 
This Example will introduce you to the basics of entering data for Simple HVAC. 
Starting from where you left off with the Atrium example model, you will create a 
simple model with heating and cooling, run a simulation and check daily and hourly 
results. 
 

1. Ensure Simple HVAC and Schedule natural ventilation model options are 
selected.  

2. Window shading using ‘High reflectivity slats’ and 4-Solar control with a 150 
W/m2 setpoint, T5 fluorescent lights, no daylight control. 

3. At Building level go to the HVAC tab and load the Packaged direct 
expansion HVAC template. 

4. Set the Mechanical ventilation Outside air definition method to 1-By Zone. 
This means that the Outside air ac/h rate entered on the slider below will be 
used directly. Other options will be explored in the next Example. 

5. Set the Mechanical ventilation Outside air delivery to be 2 ac/h. 
6. Leave the Mechanical ventilation Operation schedule to be 

Office_OpenOff_Occ. 
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The HVAC tab should look something like the above screenshot. Note the 
simple definition of the HVAC system. The Heating and Cooling system CoP 
values are used to calculate the HVAC energy consumption data from the 
heating and cooling loads calculated in the simulation.  
 
The Fan and pump energy consumption is modelled using the Auxiliary 
energy in kWh/m2 (default data for this comes from the UK NCM). 

7. Heating and cooling setpoint temperatures are defined on the Activity tab 
because they relate more to the activity taking place within the space (usage) 
than to the HVAC system. So still at Building level go to the Activity tab and 
open the Environmental Conditions header to show the setpoints. Set the 
heating setpoint to 20°C and the cooling setpoint as 26°C. Leave the Heating 
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and cooling setback temperatures in their default states – we’ll modify those in 
the next Example. 

 
The model is now ready for simulation. Click on the Simulation tab and when the 
Simulation options dialog is displayed select Hourly  and Daily results, and Annual 
simulation and press OK to start the simulation. After a few minutes, when the 
simulation is finished and the results have been loaded you should see the daily results 
below.  
 

 
 
Now select hourly results by selecting the Interval  as 3-Hourly  in the Display 
options panel in the bottom left of the screen. You should see:  
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Hourly results are much more useful for understanding the operation of the HVAC 
system than daily results because you can check that setpoint temperatures are met, 
see periods of the day when peak demands occur etc.  
 
The above hourly results for the year are interesting for an overview, but to get a 
clearer view it is best to display less days at a time. Try setting the Days per page to 7 
in the Display options panel and you will see results for the first 7 days in the year. 
 

 
 
The results show: 
 

1. The heating system maintains the heating setpoint of 20ºC during the daytime. 
2. The peak heating load takes place on winter mornings 
3. The HVAC system is switched off during weekends and at night and the 

temperature in the zone is allowed to ‘float’ during these times. 
4. Infiltration is the only source of fresh air when the HVAC system is switched 

off – during these time the fresh air rate is 0.5 ac/h. 
5. When the HVAC system is switched on, the fresh air rate is the 0.5 ac/h 

constant infiltration + the mechanical ventilation at 2 ac/h x 
Office_OpenOff_Occ schedule value. 

6. The thermal effect of the mechanical ventilation is shown in the heat balance 
graph separately from the cooling loads. 

7. The heat generation energy consumption is calculated as heating load 
(Zone/Sys Sensible Heating on the graph) x CoP.  

 
The thermal effect of the mechanical ventilation (External Vent) is shown separately 
from the cooling system effect (Zone/Sys Sensible Cooling). 
 
You can use the scrollbars along the bottom of the graph to move through the hourly 
results for the year. Scroll until you reach the summer period starting with June 18th as 
shown below. 
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This graph shows the cooling system meeting cooling setpoint temperatures and 
illustrates how the Chiller energy consumption = Cooling load x CoP. Check for your 
self that this is the case. Chiller CoP is 2.5. Do the same for heating. Heat generation 
CoP is 3.5. 
 
Also notice how it is the air temperature that is being controlled and that in the 
summer the radiant temperature can still rise much higher even while the air is 
being controlled to 26ºC. This leads to higher operative temperatures of 27ºC and 
higher (mean of air and radiant temperatures). The operative temperature is often used 
as a good measure of occupant thermal comfort. It is a better measure than air 
temperature because it includes radiant effects. 
 

Warning: There is an option to control to the operative temperature instead 
of the air temperature but we don’t encourage the use of this option because it 
requires an advanced understanding of the way the model works to understand 
limits of applicability and error messages that can arise when these limits are 
not respected.  
 
For zones with very high radiant temperatures, in order to control the 
operative temperature to a particular value the supply air must be very cold to 
bring the zone air temperature down the value required. Sometimes the 
required supply temperature is lower than the supply air temperature 
requested by the user and in these cases an error message is generated. If you 
do use operational control you should look out for error messages from 
EnergyPlus related to this effect. 
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More Simple HVAC 

Example 
In this Example you will modify the model created in Example 1, increasing the night 
time setback temperature for heating and using minimum fresh air per person 
mechanical ventilation.  
 

1. At building level on the HVAC tab set the Mechanical ventilation Outside air 
definition method to be 2-Min fresh air per person. This means that the 
maximum mechanical ventilation fresh air is calculated from the occupancy of 
the zone and the minimum fresh air requirement per person. Both these are 
defined by the activity. 

2. So on the Activity tab note that the occupancy density is set as 0.11 
people/m2. Also under the Environmental Control > Minimum Fresh Air 
header.  Note the Fresh air requirement per person is set to 10 l/s per 
person. The Mech vent per area data would also be used if we had selected 4-
Min fresh air (Sum per person + per area) option. 

3. Still on the Activity tab at building level change the Heating set back under 
the Heat Setpoint Temperatures header to 16ºC. This will be the setpoint 
whenever the Heating Operation Schedule has a value of 0.5.  

4. Go back to the HVAC tab and single-click on the Heating Operation Schedule. 
The schedule Office_OpenOff_Heat should be selected. The data for the 
schedule is displayed in the Data report panel in the bottom right of the screen. 
You will see the schedule has values of 0.5 between 7pm and 6am and a value 
of 1 between 6am and 7pm. Weekends and holidays have 0.5. This means that 
the heating system will use setback temperature (16ºC) during the night and at 
weekends and holidays.  

5. Likewise for cooling, the main cooling setpoint of 26ºC applies during the 
occupied period. For AllOtherDays (i.e. Cooling design days) a value of zero 
is used, that is heating is not required for cooling design. 

 
Run the simulation for the Winter design week and check the heating operation at 
nighttime. The heating system should operate to heat the building to 16ºC during the 
night. 
 
Now save the file as a template (File > Save > Save as template) calling it something 
like Simple HVAC Example 2.dsb. 
 

Radiant Heating using Simple HVAC 
Radiant heating systems supply radiant heat to surrounding surfaces and to building 
occupant. Convective heating systems heat the air only. Radiant systems are often 
considered to be more comfortable than convective systems and can be more efficient 
if the occupants directly receive the radiation. Also convective systems can dry the 
zone air. 

Example 
In this example we look at how to model radiant heating systems using Simple 
HVAC.  
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1. Following on from the last example, at the building level on the HVAC load 

the Underfloor heating system, nat vent HVAC template.  
2. Open the Heating >Type header and note that the Heating type is 2-

Radiative/convective. The Heating radiant fraction is 1 because all of the heat 
from the radiant system is to be applied in radiant form to the floor. The 
Radiant distribution is set to 2-Floor because all the heat is to be radiated to 
the floor surfaces in the zone. The net effect is that all heat from the 
radiant/convective heating system is applied via the surface of the floor giving 
a good approximation to a floor heating system.  

3. Set the Natural ventilation > Outside air definition method to 2-Min fresh air 
(Per person). 

4. On the Activity tab set the natural ventilation cooling setpoint to 10ºC to 
ensure natural ventilation continues to provide fresh air when the building is 
occupied irrespective of the temperature in the zone. 

5. Check the heating setpoint is 20ºC and the heating setback temperature is 
16ºC. 

  
Run a simulation for the design week requesting hourly results. Check that the 
building is being heated to at least 20ºC during the occupied period and to 16ºC 
during the night and weekend. 
 

 
If you experiment further with this system type, you may notice that, as with real 
underfloor heating systems, the room temperature response is slower than with 
convective systems. This is because the heating takes place through surface of the 
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relatively massive floor construction and not directly to the air as with the Convective 
option. 
 
Note that simulations with Radiant/convective heating systems run noticeably more 
slowly than the standard convective only Simple HVAC option. This can be a 
problem when these system types are used in buildings with hundreds of zones.  
 
Version 2 of DesignBuilder will have other radiant heating options including radiant 
baseboards in Compact HVAC. 
 

Night Cooling using Mechanical Ventilation 
You can use DesignBuilder Simple HVAC to model thermostatic night cooling. This 
example takes you through the steps involved in setting up a basic early stage design 
study of a building using daytime natural ventilation to provide fresh air and night 
mechanical ventilation to pre-cool the building fabric before the start of occupancy. 

Example 
 

1. Starting from the Atrium example base file, at the building level on the HVAC 
tab, check that the Mechanical ventilation, Heating and Cooling are all 
switched on. 

2. To ensure the mechanical ventilation occurs during summer nights and 
weekends only, create a new schedule. A quick way to do this is to copy the 
Summer cooling workdays (Northern Hemisphere) schedule and modify 
the copy (you can’t modify DesignBuilder library components directly).  
 

a. Click on Schedule under Mechanical Ventilation > Operation to open 
the list in the Info Data panel on the right. 

b. Select Summer cooling workdays (Northern Hemisphere) under the 
general category. 

c. Click on the Create copy icon above and immediately on the Edit icon 
to edit the copy. 

 
Make these changes to the schedule: 
 

d. Change its name to something like Summer night vent. 
e. Then change the data to. The items marked in bold have been changed. 
 

SCHEDULE:COMPACT, 
Summer vent, 
Fraction, 
Through: 31 Mar, 
For: AllDays, 
Until: 24:00,    0, 
Through: 30 Sep, 
For: Weekdays Weekends SummerDesignDay, 
Until: 06:00,    1, 
Until: 24:00,    0, 
For: AllOtherDays, 
Until: 24:00,    0, 
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Through: 31 Dec, 
For: AllDays, 
Until: 24:00,    0 ; 
 

This Compact schedule has values of 1 between 24:00 and 6:00 during 
weekdays, weekends and summer design days and zero at all other times. The 
timing will allow the fans to operate between midnight and 6am making use of 
cheap nighttime electricity tariffs. 
 

3. Select the Summer night vent schedule you have just created as the 
Mechanical ventilation operation schedule. 

4. Set the Mechanical ventilation > Outside air flow rate to 5 ac/h.  
5. Still at building level on the HVAC tab switch on Natural ventilation and 

select the Min fresh air per person option to provide fresh air for the 
occupants during the day. Leave the schedule as the default 
Office_OpenOff_Occ. 

6. Now on the Activity tab at building level under the Environmental Control  
header make these changes:  

 
a. Cooling setpoint = 26°C. 
b. Natural ventilation cooling setpoint = 18°C. 
c. Mechanical ventilation setpoint = 18°C. Night ventilation will switch 

off if the zone air temperature gets below 18°C (to prevent 
overcooling). 

d. Mechanical ventilation Max in-out delta T = 2K. This ensures 
mechanical ventilation is only activated when the outside air is at least 
2K colder than inside air temperature. 

 
The model is now ready to start simulations to click on the Simulation tab and on the 
Simulation options dialog select Hourly data and Summer typical week. Press OK 
to start the simulation. 
 
Select hourly results using the Interval drop-down list and you should see something 
like the screenshot below. 
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Note the following: 
 

1. The night-time ventilation cools zone air temperature down to 18°C when 
possible. 

2. The heating system operates first thing in the morning to raise the temperature 
of the zone from 18°C to the heating setpoint temperature of 20°C.  An 
improved mode of operation for this building would be for the heating system 
to be switched off in the summer. 

 
As an extra exercise you may like to investigate the effect of mechanical ventilation 
rate on the load reduction benefit due to night cooling. Try using this model as a basis 
for a parametric study. You could carry out annual simulations and use the annual 
CO2 emissions as the criteria. 
 



Simulation and CFD Training Guide  

DesignBuilder copyright © 2009 135 

18 DesignBuilder Compact HVAC 
 
In DesignBuilder ‘HVAC’ refers to all elements of the building whose function is to 
provide heating, cooling and ventilation to provide comfort for the occupants. This 
includes natural ventilation, but this topic is covered in a separate Tutorial. 
 
DesignBuilder offers a range of HVAC system types and also 2 levels of detail:  
 

• Simple where the system is modelled by calculating the loads required to meet 
the heating and cooling setpoints and multiplying heating and cooling loads by 
system CoPs to calculate energy consumption.  

 
• Compact using the EnergyPlus Compact HVAC (called ‘HVACTemplates’ in 

EnergyPlus v3 and later). This allows a much more detailed model of some 
HVAC system types to be developed but using simple parametric input data 
that can be loaded from templates.  

 
Compact HVAC allows you model a wider range of different HVAC types and 
control options than Simple HVAC and it can be useful in the design of the HVAC 
system itself.   
 
There is no need to draw networks of ducts and pipes. The expansion of simple 
parametric definitions in the DesignBuilder interface to detailed EnergyPlus HVAC 
description is done in the background automatically using the EnergyPlus Compact 
HVAC data. 
 
The sizing of the detailed components is carried out automatically before the 
simulation using heating and cooling design data and WinterDesignDay and 
SummerDesignDay schedule data. Summary results for these sizing calculations can 
be found in the EnergyPlus output file eplusout.eio and details in the files 
eplusssz.csv and epluszsz.csv. 
 
The 5 EnergyPlus Compact HVAC system types currently available are: 
 

• Fan coil units – for modelling fan coil units. 
• Unitary Single Zone – for modelling constant volume packaged DX systems, 

split systems. 
• Unitary Multizone – for modelling multizone DX systems where a single 

AHU supplies multiple zones. 
• CAV - Constant Air Volume systems with central AHU. 
• VAV - Variable Air Volume systems with central AHU. 
 

Zone-based Systems 
The Compact HVAC zone-based system types are: 
 

• Unitary single zone 
• Fan coil units 
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Zone-based systems have separate data for each zone and there is no central AHU. 
Data for these systems is defined at the zone level (though you can of course use 
inheritance and define data at the building and block level if most zones in the 
building/block have the same type). These HVAC system types can be used in much 
the same way as Simple HVAC in the sense that the system for each zone is self-
contained without reference to AHU data.  

AHU-based Systems 
The Compact HVAC AHU-based system types are: 
 

• Unitary multizone 
• VAV 
• CAV 

 
These system types require data to be set at the building level to define the 
characteristics of the Air Handling Unit (AHU). Data for zone terminal units, fresh air 
requirement, heating/cooling requirement and setpoints etc is set at the zone level (or 
inherited from building or block levels above in the hierarchy). 
 
More data is required to define the AHU-based Compact HVAC systems, especially 
the VAV and CAV system types, and these systems do involve more complexity than 
with Simple HVAC. Some care is therefore required in setting the model up to avoid 
simultaneous heating and cooling, under/over heating/cooling etc. It is essential to 
check the HVAC system operation by looking at hourly or sub-hourly results for short 
summer and winter periods. 

Boiler, Chiller, Fans, Pumps Fuel consumption 
DesignBuilder Compact HVAC models heating and cooling generation (i.e. boilers, 
chillers, heat pumps etc) in a similar way to Simple HVAC using seasonal CoP 
values. However unlike Simple HVAC CoP values are entered specifically for the 
heat generator (typically a boiler or heat pump) and for the chiller. They are not whole 
system CoPs as in Simple HVAC. 
 
For example, in a Compact HVAC fan-coil unit provided with heat from a boiler, 
EnergyPlus calculates the heating requirement of the heating coil and DesignBuilder 
calculates the boiler energy consumption based on the heating coil load, a distribution 
loss factor and the Heat generation CoP for the boiler entered by the user.  
 
Fans are modelled within EnergyPlus based on the supply airflow rate, fan pressure 
drops and efficiency values.  
 
Pumps are also modelled in Compact HVAC systems using hot or cold-water coils 
but there is no user access to the pump data.  Default characteristics are assumed. 
 

Fan-coil Units 
The Fan coil unit Compact option simulates a 4 pipe fan coil unit with hot water 
heating coil, chilled water cooling coil, and an outside air mixer. Fan coils contain an 
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outdoor air mixer, a fan, a simple heating coil and a cooling coil. The fan coil unit is 
connected to a hot water loop (demand side) through its hot water coil and to a chilled 
water loop (demand side) through its cooling coil. The unit is controlled to meet the 
zone (remaining) heating or cooling demand. If there is a heating demand, the cooling 
coil is off and the hot water flow through the heating coil is throttled to meet the 
demand. If there is a cooling demand from the zone, the hot water coil is off and the 
chilled water flow through the cooling coil is throttled to meet the load. 
 
You can model Fan coil unit systems with or without outside air.  If you include 
Mechanical ventilation with your Fan coil unit system then heating and cooling will 
only operate when the Mechanical ventilation operation schedule is on.   
 
If you do not want to include outside air in your system, you should uncheck the 
Mechanical ventilation 'On' check box. In this case heating/cooling availability is 
determined entirely from the heating/cooling operation schedules under the Heating 
and Cooling headers. 
 

 
 

Example 
To get started with Compact HVAC in an existing Simple HVAC model the first 
thing to do is to open the Model options dialog and set the HVAC model detail to 
Compact. In this example we will start using the Atrium example base template. 
 

1. Load Create a new project and select London Gatwick as the location and 
select the Atrium example base template. 

2. Open the Model options dialog and set the HVAC model detail to Compact 
and confirm. The model now uses Compact HVAC. 

3. At the building level go to the HVAC tab and load the Fan-coil unit HVAC 
template.  

 
You should notice at this point that Compact HVAC Fan-coil units have very little 
extra data to enter relative to Simple HVAC. The only difference in data input is use 
of Heat generator CoP, Heating and Cooling Distribution losses and the Cooling coil 
type.   
 
You will also see below the HVAC template the Type of the Compact HVAC system 
last loaded. This cannot be edited and it is important to understand that the correct 
template must be used to load the appropriate Compact HVAC type.  
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Now start a simulation by clicking on the Simulation tab, selecting hourly results and 
Winter typical week.  When the simulation finishes, select Hourly results in the 
Display options panel and you should see something like the screenshot below. 

 

 
 
The important things to notice about these results for fan-coil units are: 
 

• Unlike Simple HVAC, in Compact HVAC EnergyPlus calculates loads on the 
coils (i.e. heat transferred to air stream) and this data is displayed in the 
System energy graph (above). Heating fuel consumption is calculated from 
this by applying distribution loss and heat generation CoP factors. 

• The outside fresh air rate provided by fan-coil units is ‘full on’ when the Min 
AHU Outside Air Requirement Schedule has values greater than zero. There is 
no modulation between no outside airflow and full outside airflow. 

 
Now save the file as a template (File > Save > Save as template) calling it something 
like Fan Coil Units.dsb. 
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Unitary Single Zone - Basic 
The Unitary single zone option allows you to model simple single constant volume 
direct-expansion (DX) based HVAC configurations with several different heating 
options. Direct expansion includes single packaged rooftop systems commonly seen 
in commercial buildings and split systems commonly seen in residential buildings. In 
this system, local cooling coils are used to condition air, which is supplied to the zone 
through a local air delivery system. Air delivery can be set up to ensure minimum 
fresh air supply and there are options for economisers to provide free cooling and heat  
recovery. 
 

 
 

Example 
Starting where you left off in the Fan coil unit example, go to the HVAC tab at 
building level and load the Packaged direct expansion HVAC template. This uses 
the Compact HVAC Unitary Single Zone type.  
 
Take a look at the data on the HVAC tab. You will notice that in addition to the data 
previously mentioned for Fan coil units, Unitary single zone systems also allow 
Economisers, Fan operation mode and Heat recovery data to be entered. For now 
accept these default settings and run the simulation again to compare the results with 
the Fan coil system. 
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The most obvious differences between these results for the Packaged direct expansion 
system relative to the Fan coil results are that the mechanical ventilation fresh air rate 
is modulated according to the mechanical ventilation schedule and also that the 
heating fuel energy consumption is much lower because the packaged direct 
expansion system uses a heat pump with a high heating CoP (3.5) whereas the Fan 
coil system uses a boiler with CoP of  0.83. 
 
Now save the file as a template (File > Save > Save as template) calling it something 
like Unitary Single Zone – Basic.dsb 
 

Unitary Single Zone – Economiser 
Unitary single zone systems also allow an economisor to be specified. An economizer 
is a damper + opening that allows up to 100% outside air to be supplied to the air-
handling unit when the outside air is cooler than the return air from the zones, thus 
providing free cooling. Economisers can reduce energy use quite significantly, 
especially for buildings liable to overheat when the outside air is relatively cool.  
 
EnergyPlus automatically sizes the maximum outside airflow rate and the economiser 
can progressively open the outside air damper to maximise use of free outside air 
cooling. 
 
There are four Economiser options: 
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• 1-None where no economizer operation will be simulated and outside fresh air 
is based on the Mechanical ventilation Outside air rate and associated 
operation schedule. 

• 2-Return air temperature establishes a limit control on the return air 
temperature so that when the temperature of the air entering the mixer on the 
outside air side is greater than the return air temperature the outside airflow 
rate is set to the minimum. 

• 3-Return air enthalpy establishes a limit control on the return air enthalpy so 
that when the enthalpy of air entering the mixer on the outside airside is 
greater than the return air enthalpy the outside airflow rate is set to the 
minimum.  

• 4-Return air temperature and enthalpy where both the above limit controls 
are in operation, i.e. both temperature or enthalpy limits are used so that when 
either the temperature or the enthalpy of the air entering the mixer on the 
outside air side is greater than the return air temperature/enthalpy, the outside 
airflow rate is set to the minimum. 

 
In addition to the above checks in which return air and outside air conditions are 
compared, the economiser can also have absolute limits on outside air temperature 
and enthalpy. When the outside air conditions go beyond these limits the EnergyPlus 
economiser switches to minimum outside air mode, i.e. the outside air damper is 
closed to its minimum position and heat recovery will be enabled if available (more 
on this later).  When you select one of the Economisor options 2-4 (above), the 
temperature and enthalpy limits below are shown in the interface. 
 

• Economiser upper temperature limit is the outside air temperature high 
limit for economizer operation. If the outside air temperature is above this 
limit, the outside airflow rate will be set to the minimum. 

• Economiser lower temperature limit is the outside air temperature low limit 
for economizer operation. If the outside air temperature is below this limit, the 
outside airflow rate will be set to the minimum.  

• Economiser upper enthalpy limit is the outside air upper enthalpy limit for 
economizer operation. If the outside air enthalpy is above this value, the 
outside airflow rate will be set to the minimum. 

 
Also displayed is the Lockout control allowing the Economiser to set minimum 
outside air when heating and/or cooling is in operation.  

Example 
Now test the effect of the standard Economiser settings.  
 

1. First set the Mechanical Ventilation > Outside air rate to 3 ac/.h. This will help 
us to interpret outside fresh air rate when checking the operation of the 
economiser. 

2. Select the 2-Return air temperature Economisor type 
3. Leave the Economiser settings in their default state. 
 

The HVAC data at building level should look like the screenshot below. 
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Now run a simulation requesting Hourly results and select the Summer design week. 
 
The results should look something like the screenshot below. 
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You should see: 
 
1. The effect of the economisers providing free cooling, with large outside air 

flows being introduced when the criteria are satisfied. 
2. The separate display of the Sensible and Total (sensible + latent) coils loads. 

This is the cooling energy transfer from the coils to the HVAC air stream. The 
latent energy is essentially the moisture that has condensed out onto the cold 
coils. Sensible is the heat based on dry-bulb temperature only. 

 
Unitary HVAC systems use direct evaporation (DX) coils, i.e. the refrigerant 
is evaporated directly in the coils. DX coils usually operate at lower 
temperatures than chilled water coils served by a chiller and so the latent 
loads can be higher with more water evaporating out on the cold DX coils. 

 
Now save the example file as a template (File > Save > Save as template) calling it 
something like Unitary Single Zone – Economiser.dsb. 
 

Unitary Single Zone – Economiser + Lockout 
Lockout is where the outside air damper can be set to minimum fresh air when either 
heating or cooling is in operation. Settings are under the Mechanical Ventilation > 
Economiser header on the HVAC tab.  
 
The 3 options are: 
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• No lockout where the Lockout control is not active and heating or cooling can 
occur simultaneously with economiser fresh air. 

• Lockout with heating allows the Economiser to set minimum outside air 
when the heating system is in operation. This avoids the need to heat large 
volumes of mainly outside air when the HVAC system is active. 

• Lockout with compressor allows the Economiser to set minimum outside air 
when either heating or cooling is in operation. This avoids the need to 
heat/cool large volumes of mainly outside air when the HVAC system is 
active but can restrict the savings possible by economiser action. 

Example 
Starting from the Unitary Single Zone - Economiser Example model, select the 
Lockout with compressor Economiser option and run the simulation again (hourly 
results, summer design week). You should see hourly results like those below. 
 

 
 
Note how the Lockout control switches off the Economiser while the compressor is 
switched on. 
 
Save the example file as a template (File > Save > Save as template) calling it 
something like Unitary Single Zone – Economiser + Lockout.dsb. 
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Unitary Single Zone – Economiser + Heat Recovery 
With Compact HVAC, you can specify air-to-air heat recovery, which is available 
between the relief air stream and the outside air inlet stream. You can also combine 
economisers with heat recovery.  
 
You can select the type of air-to-air heat recovery. The choices are: 
 

• 1-Sensible - recovers sensible heat  
• 2-Enthalpy - recovers sensible and latent heat. 

 
Sensible heat recovery effectiveness - is applied as a constant effectiveness at all 
conditions. The valid range is from 0.0 to 1.0, and the default is 0.70. 
 
Latent heat recovery effectiveness - if Heat Recovery Type is Enthalpy this is 
applied as a constant effectiveness at all conditions. The valid range is from 0.0 to 1.0, 
and the default is 0.65. 
 
Heat recovery heating setpoint temperature (Unitary systems only) 
When no economiser is selected this data defines the heating setpoint temperature of 
the heat recovery device for Unitary and Unitary multizone systems. Note that the 
single value is applied throughout the year. For example enter 15C to model a system 
which heats outside air up to 15C and no higher. A high setpoint value will provide 
optimal heating but this may add to cooling loads in the summer. 

Heat recovery rules 
If an economiser option is selected, the heat recovery is bypassed whenever the 
economiser operates and the heat recovery is always bypassed if economiser operation 
would be beneficial. The heat recovery will operate when: 
 

• Heat recovery is selected in the interface AND 
• Economiser operation is off.  

  
You can have heat recovery and no Economiser action by switching on Heat recovery 
and setting economiser to 1-None. In this case the heat recovery unit heats outside air 
using the Heat recovery heating setpoint temperature. It also cools outside air when 
return air temperature is lower than outside air temperature. 
 
If the economiser is selected together with heat recovery then the Heat recovery 
heating setpoint temperature data is not shown and the effective heat recovery setpoint 
temperature is given by the lower economiser limit temperature. 

Example 
To test this, switch off the Lockout control used in the last example and open the Heat 
Recovery header and switch on heat recovery. Leave the default heat recovery 
settings (Sensible only type with Sensible heat recovery effectiveness of 0.7). The 
Mechanical ventilation part of the HVAC data should look like the screenshot below. 
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Run the simulation again (hourly results, summer design week). You should see 
hourly results like those below. 
 

 
 
Note that Sensible cooling is provided by the heat recovery on the 19th August during 
times when the outside air is warmer than the return air from the zone. At other times 
the heat recovery unit is bypassed. 
 
Now run the winter design week using the same model and check results. You should 
find that the heat recovery provides very significant savings during the heating season. 
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Save the example file as a template (File > Save > Save as template) calling it 
something like Unitary Single Zone – Economiser + Heat recovery.dsb. 
 

Unitary Multizone – Basics 
The Unitary multizone option allows you to model constant volume direct-expansion  
 (DX) based HVAC configurations with several different heating options. Direct 
expansion includes single packaged rooftop systems commonly seen in commercial 
buildings and split systems commonly seen in residential buildings. In this system, 
central heating and cooling coils are used to condition air, which is delivered to the 
each of the zones in the system through an air delivery system. Air delivery can be set 
up to ensure minimum fresh air supply and there are options for economisers to 
provide free cooling and heat recovery. 
 
The Unitary multizone system is essentially the same as the Unitary single zone 
system except that the same AHU supplies multiple zones, and one of these zones is 
used as the control zone.  
   
Only one Unitary multizone system can be defined per building and it can serve up 
to 400 zones. 
 

 
 
A Unitary multizone HVAC template must be loaded at building level and in all 
zones which are part of the system (zones that are part of the Unitary multizone 
system can of course inherit their setting from the building level). Zones that are not 
part of the Unitary multizone system can have Compact HVAC type Unitary single 
zone or Fan coil units but not VAV or CAV . 
 
When using this system type you should be careful to locate the thermostat in a 
Control zone which will have a representative temperature for the whole building, 
otherwise some zones may become over/under heated/cooled.   
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Example 
To create a basic 2-zone Unitary multizone model: 
 

1. Starting from where you left off in the last example, at building level on the 
HVAC tab load the Constant volume DX (using unitary multizone) HVAC 
template. This data should be inherited by the zones below (ie no red hard set 
data at the block or zone level). 

2. Set the Mechanical ventilation Outside air definition method to 1-By Zone. 
This means that the Outside air ac/h rate entered on the slider below will be 
used directly.  

3. Set the Mechanical ventilation Outside air delivery to be 2 ac/h. 
4. Leave the Mechanical ventilation Operation schedule to be 

Office_OpenOff_Occ. 
5. On the Constructions tab at building level set the Infiltration to be off. This 

will make it easier to focus on outside fresh air delivery through the HVAC 
system. 

6. Go to Ground floor > Zone 1 and set this as the Control zone by checking the 
Thermostatic control zone for unitary system checkbox. 

7. Run a simulation requesting hourly results and use the Summer design week. 
 
The building level hourly results should look the screenshot below. 
 

 
 
Notice how the total fresh air delivery to the building is 2 ac/h as specified. Now look 
at results for the Ground and First floor zones. 
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These show that the maximum values of fresh air delivery in each zone are not 2 ac/h 
as one might expect. The fresh air delivery in the ground floor zone is slightly higher 
than 2 ac/h and in the First floor zone it is slightly lower. To understand why this is 
you must first understand how the EnergyPlus fresh air control works. 
 
Before the start of the simulation EnergyPlus calculates the total fresh air requested 
for each zone and uses this total as the minimum outside airflow rate entering the 
AHU inlet.  During the simulation when minimum fresh air is requested (i.e. 
economiser is not in operation) the outside air damper is adjusted to provide this 
minimum fresh air to the AHU.  How this fresh air is distributed to the various zones 
in the building depends on the component sizing calculations automatically carried 
out before the simulation based on heating and cooling design days.  
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Advanced user note: see eplusout.eio in the EnergyPlus folder for a summary of 
EnergyPlus component and system sizing results. 
 
Save the example file as a template (File > Save > Save as template) calling it 
something like Unitary MultiZone .dsb. 
 

VAV Systems 
In a typical Variable Air Volume (VAV) system the AHU supplies air to the zone 
terminal units at a constant temperature. This constant temperature is achieved by 
blowing air across cooling and heating coils.  
 

 
 
VAV systems can be used for core or perimeter zones with a common fan system, air 
temperature control, and reheating devices. Heating is provided with the zone terminal 
units by use of reheat coils. 
 
The DesignBuilder VAV option allows you to model VAV systems with optional 
preheat, AHU heating and cooling coils and zone terminal reheat. You can select 
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series or parallel fan powered terminal units (also known as powered induction units 
or PIU). There are options to control the air distribution system in various ways 
including the ability to ensure minimum fresh air delivery to each zone, set VAV box 
minimum flow fraction and various outside air options including an economiser to 
provide free cooling when appropriate. You can also model heating and cooling coil 
temperature reset. 
Only one VAV system can be defined per building and it can serve up to 400 zones. 

Cooling 
During times when a zone requires cooling the volume of air supplied to the zone is 
adjusted by opening/closing the zone supply air damper in the terminal unit until the 
zone temperature setpoint is achieved. If more cooling is required then more cool air 
from the AHU is supplied. If the provision of minimum fresh air would over-cool the 
zone then a reheat coil in the zone terminal unit operates to heat the air from the AHU 
so as to achieve zone thermal comfort. This cooling and reheating can make poorly 
designed VAV systems inefficient. 

Heating 
During times when heating is required the zone terminal unit damper normally closes 
to minimum opening position and the reheat coil in the zone terminal unit operates to 
maintain comfort in the zone. 

Outside Air 
Under the Outside Air Mixing header you can specify the outside air mixing type. 
Choose between: 
 

• 1-Recirculation - the outside airflow supply to the AHU is mixed with 
recirculated return air from the zones. This is done to save energy often in 
conjunction with an economiser to ensure that optimal use is made of outside 
air. When heat recovery is used with the Recirculation outside air mixing 
option, the economiser must be selected in the interface for the heat recovery 
to be by-passed.  
 
For recirculation systems you can select the outside air control minimum flow 
type to be one of: 

 
• 1-Fixed - the minimum outside airflow rate is fixed as set above no 

matter what the actual system flow rate is. In practice even with Fixed 
outside air control minimum it is possible for the outside airflow rate 
into individual zones to be slightly different from the requested value. 
This is because the minimum outside air is controlled at the AHU level 
to ensure that the total fresh air entering the AHU is the total required 
for the building (the sum of the individual zone outside air 
requirements). But depending on the heating/cooling loads in each 
zone, some zones will require more supply air to meet the load than 
others. So the total fresh air entering the building will be as specified 
but fresh air distribution around the building may not be perfectly 
maintained.  

• 2-Proportional - the minimum outside airflow rate varies in 
proportion to the total system airflow rate. 
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The minimum outside airflow rate through the AHU outside air inlet is 
automatically calculated as the sum of the individual zone ventilation 
requirements. This is the 'design minimum'.  During the simulation, 
'minimum' and 'maximum' represent the limits for economizer operation. 
 If there is no economizer, then the minimum flow of outside air is 
delivered.  If 1-Fixed is selected, then this value will remain fixed (unless 
the total VAV system flow rate falls below this value, in which case, the 
system will deliver 100% outside air at whatever the system flow rate is). 
 If, 2-Proportional is specified, then the operating minimum falls as 
system flow rate falls.  This simulates a typical system with a fixed lower 
stop on the outside air supply damper.   
 
Notes:  

• Delivering 1-Fixed requires enhanced control systems.  

• To ensure minimum outside air is delivered you should use 1-
Fixed. 

• 2-Full fresh air - the airflow into the AHU is 100% outside air, without any 
recirculation. This is modelled in EnergyPlus by setting the supply airflow rate 
to the outside airflow rate. Note that when using this option, fixing the supply 
airflow rate to the outside air rate will in many cases mean that the system will 
not be capable of meeting the design cooling load. To increase the maximum 
cooling capacity of a Full fresh air VAV/CAV system you can increase the 
outside airflow rate (such systems could be very inefficient in energy use 
without heat recovery). When heat recovery is used with the 2-Full fresh air 
outside air mixing option, the heat recovery is by-passed when this is 
advantageous in reducing AHU cooling coil loads. The heat recovery also 
operates when the outside air temperature is less than 12°C.  

 
Important note for Full fresh air systems: to ensure that there is no 
recirculation you must also set the HVAC sizing factor on the Simulation 
options dialog under the Advanced header to 1 (the default is 1.2) 

Outside air sizing 
When the Outside air definition method is 2-Min fresh air per person, sizing for 
minimum outside air (OA) flow rate is done using the Number of People value with 
no regard for the schedules.  The total OA requirement for each zone on the air 
handler is summed and used to set the minimum OA flow rate for the air handler.  The 
OA controller sets an OA flow rate for the air handler each time step. After that, each 
zone receives a share of the total OA flow proportioned by the current supply flow 
rate to each zone. There is no further zone-by-zone allocation of OA quantities (which 
is what happens in a real system). 

VAV Terminal Units 
VAV systems control the dry bulb temperature inside a zone by varying the supply air 
volume instead of the supply air temperature. At full cooling the VAV terminal unit 
damper is fully open supplying the maximum airflow rate. As the cooling load 
decreases, the damper closes until it reaches the minimum stop specified by the 
turndown ratio (zone minimum airflow fraction).  
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The Turndown ratio (supply air minimum flow fraction) is the fraction that the zone 
VAV terminal unit can reduce flow to relative to the supply air maximum flow rate. 
The minimum flow rate to the zone while the system is operating is specified as a 
fraction of the maximum airflow rate. The turndown ratio is normally specified to 
meet the minimum ventilation requirement for the occupants.  

The reheat coil operates only when the damper is at this minimum flow rate when 
Zone damper heating action is set to 1-Nomal (the default). 

A value of 0 means the terminal unit can completely shut off flow into the zone and a 
value of 1.0 means that the terminal unit cannot reduce supply air at all (i.e. it is a 
constant volume system). For CAV systems this data is fixed at 1 and is not available 
for edit. Turndown ratio is typically in range 0.3 - 0.5. Minimum is 0 and maximum is 
1. 

VAV Terminal Unit Type – you can select from 3 types but we will only look at the 
Standard type in this example. 

Heating Data 
You should switch zone heating on if you want the zone to be heated to the heating 
setpoint temperature specified on the Activity tab. The Heating option should 
generally be on at building level for VAV systems. 
 
At the building level you can define the data for the plant, AHU and the zone defaults. 
Under the Heating header you can specify data for the Heat generator, Preheat coils 
and the main AHU heating coil as well as setting the defaults for the zone terminal 
reheat units and zone heating setpoint schedule. See screenshot below. 
 

 
 

Zone damper heating action 
During heating operation, there are two control options for the damper controlling the 
air flow in the VAV terminal unit as the zone moves above or below the zone 
setpoint. With both control options, the damper is at the minimum airflow rate 
whenever the zone temperature is between the cooling and heating setpoints.  
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• 1-Normal - the zone damper will remain at the minimum airflow rate during 
heating operation. As the heating load increases, the water flow rate in the 
reheat coil will be increased to maintain temperature in the zone until the 
maximum water flow rate is reached. The system essentially acts like a 
constant volume system during heating. 

• 2-Reverse - the airflow rate through the zone terminal unit box may increase 
above the minimum when the heating demand cannot be satisfied. As the 
heating load increases, the unit starts at minimum airflow and minimum hot 
water flow. The hot water flow is increased until it reaches maximum flow, 
then the air damper starts to open to meet the load. This option is used if the 
minimum airflow rate is not adequate to serve the maximum heating load. 

  

Cooling Data 
Under the Cooling header you can specify data for the Chiller, main AHU cooling coil 
as well as setting the defaults for the zone terminal reheat units.  
 
Note that the AHU cooling schedule is On. See screenshot below. 

 

 
 

Exercise 
The purpose of this exercise is to explore the VAV HVAC data, run a basic 
simulation and understand the results. 
 

1. The starting point is the Unitary multizone example file from the previous 
exercise. So create a new project based on that template using London 
Gatwick as the location. 

2. At building level on the HVAC tab load the VAV with terminal reheat 
HVAC template and take a look at the data. Much of the data you will 
recognise from the previous exercises but there is also some new data for 
VAV systems. 

3. Set the Min AHU Outside air requirement schedule as On. This models a 
system providing constant minimum fresh air, day and night. 

4. Set the Outside air definition method to 1-By zone and set the mechanical 
ventilation outside rate to 2 ac/h. These last 2 settings will help us understand 
HVAC fresh air delivery in the results. 

5. Building heating setpoint is 22ºC and Cooling setpoint is 24ºC. 
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Now run a simulation using the default VAV with terminal reheat options. On the 
Simulation options dialog select sub-hourly results for the Summer design week, 
select 10 timesteps per hour and start the simulation.  

Select Sub-hourly results as the Interval in the Display options panel. Viewing Sub-
hourly results over short simulation periods can provide get a clearer picture of the 
processes taking place in the model. 

 

 
 
The graph shows the operation of the VAV system under various operation regimes in 
the summer: 

1. When the return air is cooler than outside air and cooling is required the 
economiser shuts the outside air damper to the minimum position to provide 
the minimum fresh air (2 ac/h). 

2. This also happens when the economiser limits are exceeded (outside air 
temperature < 11°C or > 25°C or when the outside air enthalpy > 50,000 J/kg). 

3. When the return air is warmer than outside air the economiser opens the 
outside air damper to 2.0 ac/h. 

4. When the return air is cooler than outside air and the cooling demand requires 
more airflow the flow rate is increased to provide beneficial free cooling. 

5. There is a short heating operation time at the start of occupancy to bring the 
zone air temperature up to the heating setpoint temperature of 22°C.  This 
could be avoided by switching off summer reheat. 

6. The AHU heating coil operates briefly during 21 August. Otherwise, the 
mixed air temperature (temperature after the mixed air damper) is above the 
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AHU heating coil setpoint temperature of 14°C. This could be avoided by 
scheduling the AHU heating coil to be off during the summer. 

7. There is a cooling load when the mixed air temperature is greater than 14°C. 

8. Check the effect of the Economiser by switching it off and re-running the 
simulation. You should see that the outside fresh air is now a constant 2 ac/h 
during the occupied period. 

Check system operation for the winter design week. 

Save the example file as a template (File > Save > Save as template) calling it 
something like VAV .dsb. 

 

CAV Systems 
Constant air volume systems provide a constant volume flow rate through the AHU. 
The air may be heated and/or cooled at the AHU. DesignBuilder Constant Air 
Volume (CAV) systems are identical to VAV systems with the exception that the 
turndown ratio is set to 1 preventing the zone terminal unit damper from closing. 

Exercise 
1. Starting from the VAV example, at the building level on the HVAC tab, load 

the Constant volume HVAC template. 
2. Set the Mechanical ventilation outside air rate to 2 ac/h. 
3. Switch on the Heat recovery and use the default sensible only option at 

efficiency 0.7. 
4. Run a simulation requesting sub-hourly results for the summer design week. 

 
The results should look something like the screenshot below. 
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Exercise 
Now modify the previous example as follows: 
 

1. Select Outside air mixing as 2-Full fresh air. This means that there is no 
recirculation.  

2. The Min outside air schedule is Office_OpenOcc and the Outside air 
mechanical ventilation rate is 5 ac/h. 

3. To be sure of full fresh air (no recirculation) you must also set the Compact 
HVAC Autosizing factor on the Simulation tab of the Model options dialog 
to have a value of 1. 

4. Run the simulation again and check results. 
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1. You should find that the outside fresh air provision is 5 ac/h modified by the 

schedule without any economiser action or extra flow to boost system 
capacity.  

2. Also notice how the zone air temperature is not controlled – the airflow is not 
modulated to control the zone temperature in this variant of the CAV system. 
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Change-Over Mixed Mode 

Introduction 
This Example introduces Mixed mode control, which allows you provide a hybrid 
natural ventilation and HVAC cooling system in your models. These control systems 
aim to make best use of natural ventilation availability while maintaining optimal 
comfort for occupants. DesignBuilder can model all 3 types of mixed mode system 
defined by CBE at LBL. 
  

1. Concurrent (Same space, same time) - Concurrent mixed-mode operation is 
the most prevalent design strategy in practice today, in which the air-
conditioning system and operable windows operate in the same space and at 
the same time. The HVAC system may serve as supplemental or 
“background” ventilation and cooling while occupants are free to open 
windows based on individual preference. Typical examples include open-plan 
office space with standard VAV air-conditioning systems and operable 
windows, where perhaps perimeter VAV zones may go to minimum air when 
sensor indicates that a window has been opened. 

2. Change-over (Same space, different times) - Change-over designs are 
becoming increasingly common, where the building “changes-over” between 
natural ventilation and air-conditioning on a seasonal or even daily basis. The 
building automation system may determine the mode of operating based on 
outdoor temperature, an occupancy sensor, a window (open or closed) sensor, 
or based on operator commands. Typical examples include individual offices 
with operable windows and personal air conditioning units that shut down for 
a given office anytime a sensor indicates that a window has been opened; or a 
building envelope where automatic louvers open to provide natural ventilation 
when the HVAC system is in economizer mode, and then close when the 
system is in cooling or heating mode. 

3. Zoned (Different spaces, same time) Zoned systems are also common, where 
different zones within the building have different conditioning strategies. 
Typical examples include naturally ventilated office buildings with operable 
windows and a ducted heating/ventilation system, or supplemental mechanical 
cooling provided only to conference rooms. For many mixed-mode buildings, 
operating conditions sometimes deviate somewhat from their original design 
intent (e.g., a building originally designed for seasonal changeover between 
air-conditioning and natural ventilation may, in practice, operate both systems 
concurrently). 

 
Concurrent and Zoned systems can be modelled without using DesignBuilder mixed 
mode control. In DesignBuilder 'mixed mode' specifically refers to Change-over 
systems where the HVAC and the natural ventilation do not take place at the same 
time. The rest of this example focuses on this type of system. 
 
In change-over mixed mode buildings, natural ventilation has priority, but the cooling 
system is switched on in cases where natural ventilation is unable to cool the space 
sufficiently to meet comfort requirements. During periods where the mixed mode 
controller switches off the natural ventilation system, zones served by the HVAC 
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system have their windows and vents closed automatically to avoid the mechanical 
HVAC system running while windows and vents are open.  
 
Natural ventilation can also be shut down due to extreme weather conditions such as 
strong wind (to avoid papers blowing around), rain (so the building does not get wet 
inside) and temperature (so uncomfortably cold outside air is not introduced). The 
diagram below illustrates a typical change-over mixed mode system. 
 
 

 
 

Data Entry 
Continue from where you left off in the previous exercise or Start by loading the Nat 
Vent Example 3 template file you created earlier.  
 
To start with you will make settings for a simple temperature controlled mixed mode 
building without protection from wind, rain, low and high temperatures. The 
associated HVAC system will be VAV. 
 

1. First select Compact HVAC and Calculated Nat Vent on the model options 
dialog. 

2. Then go to the building level and load the VAV with HR + outside air reset 
+ mixed mode HVAC template. 

3. Set the Mechanical ventilation flow definition method to be ‘By zone’ and set 
the Mechanical ventilation ‘Outside air’ rate to be 3 ac/h (it will probably 
already have this value).  
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4. Set the Min AHU Outside Air Requirement  to use the On schedule. For the 

purposes of this exercise, steps 3 and 4 give a fixed 3 ac/h fresh air demand 
making it easier to see the operation of the VAV system in the results. 

5. Still on the HVAC tab at building level, open the Natural Ventilation and 
mixed mode headers and check that Mixed mode on is selected. 

6. Leave the control mode schedule as the default Mixed mode temperature 
control. 

7. Switch off the Close windows and vents when raining option – we want the 
natural ventilation to be controlled only by temperature. 

8. Leave Max wind speed as 40 m/s. 
9. Leave default Min and Max outdoor temperatures as –100°C and 100°C 

respectively. Also leave enthalpy and dew point temperature upper and lower 
limits - these won't be used because we are sticking with temperature control 
as per the Mixed mode temperature control schedule set in the control mode 
schedule data above. 

10. Go to Ground floor > Zone 1 and on the HVAC tab select this as the mixed 
mode control zone. This means that the conditions in this zone will be used to 
control the operation of the mixed mode system. For example, when the 
temperature in this zone is below the cooling setpoint but above the natural 
ventilation setpoint then the natural ventilation will be allowed to operate in all 
zones served by the VAV system. When natural ventilation is unable to satisfy 
cooling demand in this zone and temperature starts to rise above the cooling 
setpoint temperature, all the windows and vents in zones served by the VAV 
HVAC system are closed and the VAV system provides cooling. 

11. Go back up to building level and check that the ‘Natural Ventilation > Options 
> Modulate opening areas’ option is not selected. 
Data on the HVAC tab under Mixed Mode should look like the screenshot 
below. 

 

 
 

12. On the Activity tab at building level, enter the setpoint temperatures for 
Heating, Cooling and Natural ventilation. The Heating setpoint is 20°C, the 
Cooling setpoint temperature is 26°C and the Natural ventilation is 21°C. 

13. On the Constructions tab switch off the Model infiltration  for the building. 
This will make it easier to check fresh air delivery for windows, vents and 
mechanical ventilation only. 
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Now start a simulation and on the Simulation options dialog request only sub-hourly 
data. Use the same Summer typical week as set from the previous example. Also, on 
the Options tab set the Number of timesteps per hour to 4. 
 
Make sure to switch off surface and opening results (unless you are happy to wait a 
minutes or so longer for the results). 
 
When you review Sub-hourly results at building level you should see results as 
below: 
 

 
 

Extreme Weather Conditions 
Now explore some options with a view to preventing natural ventilation operation 
when extreme weather occurs:  
 

1. Go to the building level and switch on the natural ventilation wind protection 
by checking the Close windows and vents when raining checkbox under 
Natural Ventilation > Mixed Mode > Wind and Rain. 

 
2. Also set the Minimum outside temperature to 12ºC. 
 

Re-run the simulation with these options to see the effect.  
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You should see that the windows close when it rains or when the outside air is cooler 
than 12ºC and this requires the cooling to operate more frequently. This problem 
could be eliminated by either using windows that can open in the rain or by using 
automatically controlled vents that can remain open when it rains. 
 
In many climates a mixed mode HVAC system combined with good solar shading and 
insulation standards and energy efficient services would be a good starting point when 
investigating design options.
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19 Computational Fluid Dynamics (CFD) 
This section describes the various processes involved in conducting calculations using 
the DesignBuilder CFD module.  
 
Note that this CFD section is different from the rest of the Guide is that it is quite 
technical and detailed. To continue in the same flavour as the rest of the guide, 
skip forward to the CFD Examples. 
 

What is CFD? 
Computational Fluid Dynamics (CFD) is the term used to describe a family of 
numerical methods used to calculate the temperature, velocity and various other fluid 
properties throughout a region of space.   
 
CFD when applied to buildings can provide the designer with information on probable 
air velocities, pressures and temperatures that will occur at any point throughout a 
predefined air volume in and around building spaces with specified boundary 
conditions which may include the effects of climate, internal heat gains and HVAC 
systems.  
 
DesignBuilder CFD can be used for both external and internal analyses. External 
analyses provide the distribution of air velocity and pressure around building 
structures due to wind effect and this information can be used to assess pedestrian 
comfort, determine local pressures for positioning HVAC intakes/exhausts and to 
calculate more accurate pressure coefficients for EnergyPlus calculated natural 
ventilation simulations. Internal analyses provide the distribution of air velocity, 
pressure and temperature throughout the inside of building spaces and this 
information can be used to assess the effectiveness of various HVAC system designs 
and to evaluate interior comfort conditions.  
 

CFD Calculations and Convergence 
The numerical method used by DesignBuilder CFD is known as a primitive variable 
method, which involves the solution of a set of equations that describe the 
conservation of heat, mass and momentum. The equation set includes the three 
velocity component momentum equations (known as the Navier-Stokes equations), 
the temperature equation and where the k-ε turbulence model is used, equations for 
turbulence kinetic energy and the dissipation rate of turbulence kinetic energy. The 
equations comprise a set of coupled non-linear second-order partial differential 
equations having the following general form, in which φ represents the dependent 
variables: 

∂ 
∂t

(ρφ) + div(ρuφ) =div(Γ grad φ)+S 

The 
∂ 
∂t

(ρφ) term represents the rate of change, the div(ρuφ) term represents 

convection, the div(Γ grad φ) term represents diffusion and S is a source term. 
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Due to its non-linearity, the equation set cannot be solved using analytical techniques, 
which necessitates the requirement for a numerical method. The numerical method 
employed by DesignBuilder involves re-casting the differential equations into the 
form of a set of finite difference equations by sub-dividing the required building space 
(or calculation domain) into a set of non-overlapping adjoining rectilinear volumes or 
cells, which is collectively known as a finite volume grid. The equation set is then 
expressed in the form of a set of linear algebraic equations for each cell within the 
grid and the overall set of equations is solved using an iterative scheme. The non-
linearity of the equation set is accounted for by the use of a nested iterative scheme 
whereby each dependent variable equation set (velocity components, temperature, 
etc.) are themselves solved iteratively within an overall outer iterative loop and at the 
termination of each outer iteration, the most recent values of the dependent variables 
are fed back into the dependent variable coefficients. The outer iterative loop is 
repeated until the finite difference equations for all cells are satisfied by the current 
values of the appropriate dependent variables, at which point the scheme is said to 
have ‘converged’. An appreciation of the requirement for convergence and the nested 
iterative procedure used to achieve it will help in understanding the meaning of the 
various calculation options that are described in the ‘Conducting CFD Calculations’ 
section.   
 

The Iterative Nature of the Procedure 
The calculation procedure has been developed to ensure that the iterative solution of 
the equation set would be guaranteed to converge if the equation coefficients were 
constant. However, the equation set is non-linear and the coefficients actually contain 
the dependent variables themselves, and consequently convergence cannot be 
guaranteed in all cases. Although in the majority of cases, as long as the dependent 
variables and particularly the velocities only change slowly, a converged solution is 
normally achieved.  
 
The main mechanism to ensure that the variables change slowly is that of false time 
steps. The finite difference equation set is formulated in the form of a transient 
equation set although the calculations are steady state, i.e. essentially a ‘snap-shot’ in 
time. The reason for this formulation is that the transient term behaves as a very 
effective relaxation method, which can slow the change in dependent variables in 
order to arrive at a more stable solution. The false time step is the time step used in 
the pseudo-transient term of the dependent variable equation.  

Creating Model Geometry for CFD 
If you have already created a model for the purpose of an additional analysis (e.g. 
thermal simulation or SBEM calculation), you can use exactly the same model for 
CFD, although you should read the next section on the finite volume grid and 
geometric considerations. On the other hand, if you intend to conduct a CFD analysis 
from scratch, you should refer to the ‘Building Models’ section of the DesignBuilder 
Help for information on creating models. 
 



Simulation and CFD Training Guide  

DesignBuilder copyright © 2009 166 

Finite Volume Grid and Geometric Modelling 
Considerations 
The calculation method requires that the geometric space across which the 
calculations are to be conducted is first divided into a number of non-overlapping 
adjoining cells which are collectively known as the finite volume grid.  
 
When a CFD project is created, a grid is automatically generated for the required 
model domain by identifying all contained model object vertices and then generating 
key coordinates from these vertices along the major grid axes. These key coordinates, 
extended from the X, Y and Z-axes across the width, depth and height of the domain 
respectively are known as ‘grid lines’. The distance between grid lines along each axis 
is known as a grid ‘region’ and these regions are initially spaced employing user-
defined default grid spacing in order to complete the grid generation. The grid used by 
DesignBuilder CFD is a non-uniform rectilinear Cartesian grid, which means that the 
grid lines are parallel with the major axes and the spacing between the grid lines 
enables non-uniformity.  
 
For example, looking at a simple building block with a single component assembly 
representing a table: 

 
 
The resulting grid, generated with 0.3m default grid spacing would be as follows: 
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By default, grid regions are spaced uniformly using a spacing that is calculated to be 
as close to the user-defined default grid spacing as possible. Notice the narrow regions 
created between key coordinates associated with the tabletop and table legs. In this 
case, the distance between these key coordinates is of an acceptable value. However, 
very narrow regions resulting in long narrow grid cells or cells having a high aspect 
ratio should be avoided, as they tend to result in unstable solutions that can fail to 
converge. Highly detailed component assemblies can result in very large numbers of 
closely spaced key coordinates resulting in cells having high aspect ratios. Large 
numbers of key coordinates can also lead to overly complex grids and 
correspondingly high calculation run times and excessive memory usage which can be 
avoided by replacing very detailed assemblies with cruder representations for the 
purpose of the CFD calculation. However, where very narrow grid regions are 
unavoidable, adjacent grid lines formed from key coordinates can be merged together 
using the merge tolerance setting which is accessed through the new CFD analysis 
dialogs (see the ‘Setting Up a New External CFD Analysis’ and ‘Setting Up a New 
Internal CFD Analysis’ sections). For instance, in the above example, if the table 
assembly had been located closer to the edge of the adjacent window, this could result 
in unacceptably close grid lines: 
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These closely spaced grid lines can be merged by creating a new analysis and 
increasing the grid line merge tolerance setting to say 0.025m: 
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Due to the strict rectilinear nature of the grid, grid cells that lie in regions outside of 
the domain required for calculation are ‘blocked-off’ in order to cater for irregular 
geometries. It is important to take this into account when creating a model in order to 
maximise the efficiency of grid generation and/or to ensure that surface CFD 
boundaries will lie in the plane of a major grid axis to achieve accuracy of boundary 
representation. In some cases, the model may be rotated in order to ensure that most 
of the wall surfaces are orthogonal with respect to the grid axes. To take an extreme 
example, if a simple rectangular space has been drawn at a 45° angle to the Z-axis: 
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The resulting grid, generated using 0.3m default grid spacing, contains a great deal of 
redundancy in the form of blocked-off regions and inaccuracy of surface 
representation: 
 

 
 
 
If the block is first rotated, to be aligned with the X-axis: 
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The resulting grid exhibits no redundancy and there is no inaccuracy in surface 
representation:

 
The accuracy of the representation of non-orthogonal surfaces can be improved by 
using smaller default grid spacing and in some cases specific grid regions can be 
modified to increase accuracy in a more localised fashion as illustrated by the 
following example: 
 

 
 
 
Grid generated using default 0.3m grid spacing: 
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Using the ‘Edit CFD Grid’ tool, the grid spacing within just the regions spanning the 
angled section is reduced to 0.2m to improve the representation: 
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Grid regions between key coordinates can also be spaced using non-uniform spacing 
options and additional key coordinate regions can be added. Further information is 
provided on grid modification in the ‘Editing the CFD Grid’ section. 
 

Building Levels and CFD Analyses 
Internal CFD analyses can be conducted at zone, building block and building levels. 
Calculations can also be conducted for single zones that span several blocks by 
connecting them with holes and using the ‘merge zones connected by holes’ model 
option setting. External analyses can only be conducted at the site level. 
 

CFD Boundary Conditions 
An important initial concept for CFD analyses is that of boundary conditions. Each of 
the dependent variable equations requires meaningful values at the boundary of the 
calculation domain in order for the calculations to generate meaningful values 
throughout the domain. These values are known as boundary conditions and can be 
specified in a number of ways. The specification of boundary conditions for external 
analyses is relatively straightforward and just requires setting the building exposure, 
wind velocity and wind direction and this is done using a single dialog box. However, 
internal analysis boundary conditions tend to be a bit more involved and can require 
the addition of zone surface boundaries such as supply diffusers, extract grilles, 
temperature and heat flux patches and also the incorporation of model assemblies 
representing occupants, radiators, fan-coil units, etc. DesignBuilder provides default 
wall and window boundary temperatures automatically but it is important that you 
check that these defaults are appropriate ones and that you correctly specify any 
additional boundary conditions required for your project. 
 

Boundary Conditions for Internal CFD Analyses 
Internal boundary conditions can be defined in three ways: 
 

1. Default wall and window temperatures can be defined for all zone surfaces. 
2. Zone surface boundary conditions including supply diffusers, extract grilles, 

temperatures and heat fluxes can be added in the form of surface patches using 
a similar method to that used for adding windows and doors. 

3. Component blocks and component assemblies can be defined as temperature 
or heat flux boundaries. 

 
 

Default Wall and Window Temperatures 
All zone surfaces within a model have default wall and window boundary 
temperatures. These boundary temperatures are inherited from the building level 
down to the zone surface level and may be set at any intermediate level. This 
mechanism provides a convenient method for defining wall and window temperature 
boundary conditions throughout a building model in the absence of imported 
EnergyPlus boundary data (see ‘Importing EnergyPlus Output Data’). 
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Default inside and outside wall and window boundary temperatures can be accessed 
under the ‘CFD Boundary’ header on the ‘Misc’ tab: 
 

 
 

Zone Surface Boundaries 
Supply diffusers, extract grilles, temperature and heat flux patches can be added to 
zone surfaces using the Add CFD boundary tool.  
 
To add a surface boundary, move down to the surface on which you want to locate the 
boundary, either by selecting it from the model navigator or by navigating to it in the 
Edit screen. At the surface level, you can then select the ‘Add CFD boundary’ tool 
from the toolbar: 
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You can draw a CFD boundary on to the surface in exactly the same way that you 
would draw a window. Please refer to the ‘Add window’ Help section for details of 
drawing windows. 
 
After selecting the ‘Add CFD boundary’ tool, the boundary settings are displayed on 
the ‘Drawing Options’ data panel. You can select the required boundary type from the 
‘Boundary type’ drop list. The following boundary types are available for surfaces of 
all orientations: 
 

• 1 – Supply (general purpose HVAC supply diffuser) 
• 4 – Extract (HVAC extract grille) 
• 5 – Temperature (surface temperature patch) 
• 6 – Flux (surface heat flux patch) 

 
The following additional boundary types for multi-directional diffusers will appear for 
ceiling surfaces only: 
 

• 2 – Four-way (four-way supply diffuser) 
• 3 – Two-way (two-way supply diffuser) 

 
Various settings are available depending on the boundary type: 
 

1-Supply: 
 

Boundary temperature (°°°°C): Enter the required temperature of the air entering 
the space. 
 
Flow rate (l/s): Enter the supply volume flow rate. 
 
X-discharge angle (°°°°): This setting allows you to define the discharge angle 
between the local surface X-axis and an inward facing normal to the surface. At 
the surface level, taking a normal view from the inside of the zone to the 
surface, the X-axis discharge angle is positive between the normal and the 
positive X-axis (i.e. the axis pointing towards the right) and negative between 
the normal and the negative X-axis (i.e. the axis pointing towards the left). For 
example to define a discharge angle of 45° pointing towards the left of the 
centre of a diffuser, looking at it from the inside of the zone, you would enter –
45. On the other hand, to define a discharge angle of 45° pointing towards the 
right of the centre, you would enter 45: 
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Y-discharge angle (°°°°): This setting allows you to define the discharge angle 
between the local surface Y-axis and an inward facing normal to the surface. At 
the surface level, taking a normal view from the inside of the zone to the 
surface, the Y-axis discharge angle is positive between the normal and the 
positive Y-axis (i.e. the axis pointing upwards) and negative between the normal 
and the negative Y-axis (i.e. the axis pointing downwards). For example to 
define a discharge angle of 45°  pointing downwards from the centre of a 
diffuser, looking at it from the inside of the zone, you would enter –45. On the 
other hand, to define a discharge angle of 45°, pointing upwards from the centre, 
you would enter 45: 
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Minimum discharge velocity (m/s): The minimum discharge velocity is the 
minimum required velocity at the face of the diffuser. Supply diffusers are created 
using a number of elements, the areas of which are determined by combining the 
specified volume flow rate together with the minimum discharge velocity. The 
maximum linear dimension of each component element is currently 'hard-set' at 
0.2m. 
 

2–Four-way 
 

Boundary temperature (°°°°C): Temperature of the air entering the space. 
 
Flow rate (l/s): The supply flow rate. 
 
Multi-way diffuser discharge angle (°°°°): The discharge angle is the angle 
between the downward pointing normal and the diffuser jet: 
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Minimum discharge velocity (m/s): The minimum discharge velocity is the 
minimum required velocity at the face of the diffuser. Four-way diffusers are 
created using four separate elements, one located at each edge of the diffuser, the 
area of each being determined by combining the specified volume flow rate 
together with the minimum discharge velocity.  
 

3–Two-way 
 

Boundary temperature (°°°°C): Enter the required temperature of the air entering 
the space. 
 
Flow rate (l/s): 
 
Enter the supply flow rate. 
 
Multi-way diffuser discharge angle (°): 
 
Enter the discharge angle, which is the angle between the downward pointing 
normal and the diffuser jet (see illustration in ‘Four-way’ section). 
 
2-way diffuser discharge direction: 
 

Enter the local surface axis along which the diffuser is to discharge: 
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Minimum discharge velocity (m/s): The minimum discharge velocity is the 
minimum required velocity at the face of the diffuser. Two-way diffusers are 
created using two separate elements, one on either side of the diffuser along the 
discharge axis, the area of each being determined by combining the specified 
volume flow rate together with the minimum discharge velocity.  
 

2–Extract 
 

Flow rate (l/s): The extract flow rate. 
 

3–Temperature 
 

Boundary temperature (°°°°C): Temperature for the patch. 
 
4 – Flux 
 

Heat flux (Wm-2): Heat flux for the patch. 
 

Component Blocks & Assemblies as CFD Boundaries 
Component blocks and assemblies can be used for CFD analyses to simply allow for 
the effect of obstructions on the airflow. However, they also allow the definition of 
CFD boundary attributes to enable them to act as constant temperature surfaces or 
heat flux sources and can also be modified to behave as non-solids to allow air to pass 
through them.  

Component Blocks 
CFD attributes for component blocks are inherited down from the building level to 
component blocks located at both building and building block levels. CFD attributes 
for component blocks are accessed under the ‘Component block’ header on the 
‘Construction’ tab: 
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Assemblies 
The CFD assembly library that is provided with DesignBuilder contains a number of 
pre-defined assemblies that can be used to add items such as occupants, radiators and 
furniture. Some of these pre-defined assemblies already have CFD boundary attributes 
associated with them, e.g. occupant assemblies have a defined heat flux of 90W. You 
can also define your own assemblies for use in CFD analyses and you will find details 
of how to do this in the ‘Assemblies’ Help section. 
 
CFD attributes for component assemblies are inherited from the parent assembly to 
instances of the assembly at the building and building block levels. CFD attributes for 
assemblies are accessed from the ‘Construction’ tab after moving down to an 
assembly instance level by clicking on it in the navigator or double-clicking on it in 
the Edit screen. It is important to understand that if you change an attribute for a 
specific instance of an assembly, the attributes will be changed for all other instances 
of the same assembly. 
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The following CFD boundary settings are available for both component blocks and 
component assemblies: 
 
Thermal boundary type: The thermal boundary type can be set to one of the 
following: 
 

• 1–None: Component block does not act as a CFD boundary condition. 
• 2–Temperature: Component block acts as a fixed temperature CFD boundary 

condition. 
• 3 – Flux: Component block supplies a fixed heat flux to the surroundings. 

 
Temperature (°°°°C): If the thermal boundary type has been set to ‘Temperature’, enter 
the temperature of the block. 
 
Flux (W):  If the thermal boundary type has been set to ‘Flux’, enter the heat 
emission of the block. 
 
Mass: Determines whether or not the block will act as a physical obstruction to the 
surrounding flow. In some cases, it may be desirable to fix the temperature or flux of 
the component but allow air to pass through the block, e.g. to represent an occupancy 
flux throughout a large volume without needing to locate individual occupants. 
 

Setting Up a New External CFD Analysis 
To create a new external CFD analysis, first make sure that you have selected the Site 
object in the model navigator and then click on the CFD tab: 
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The ‘New CFD Analysis Data’ dialog is displayed which allows you to name the 
analysis, define grid generation variables, wind data and the extents of the domain to 
be included in the analysis: 
 

 
 

Default Grid Spacing 
On entry to the CFD screen after completing and closing the new CFD analysis 
dialog, the CFD grid is automatically generated throughout the overall external 
domain extents. The grid is created by first determining key points obtained from 
constituent model blocks along the major axes, the distance between each of these key 
points being known as regions. Each CFD grid region along each major axis is 
automatically spaced using the ‘default grid spacing’ dimension. 



Simulation and CFD Training Guide  

DesignBuilder copyright © 2009 183 

 

Grid Line Merge Tolerance 
A potential problem when generating the grid is the creation of cells with a high 
aspect ratio that can lead to instability in the equation solver. In order to avoid such 
cells, grid lines that are very close together can be merged. The ‘grid line merge 
tolerance’ is the maximum dimension that will be used in determining whether or not 
to automatically merge grid lines. 

Wind Velocity 
Enter the required free stream wind velocity in m/s (measured at 10m above ground). 

Wind Direction 
The wind direction is defined clockwise from North. The default direction is 270°, i.e. 
Westerly. 

Wind Exposure 

The free stream wind velocity is corrected for height above ground and surrounding 
terrain using an empirical relationship. Urban, suburban and open country exposures 
can be selected. 

Site Domain Factors 
The length, width and height site domain factors are multipliers that are applied to the 
overall dimensions of the building model in order to arrive at an external volume or 
domain across which the analysis is carried out. The default factors are 3.0 applied to 
the length and width and a factor of 2.0 that is applied to the model height. 
 
After clicking on the OK button, the CFD screen is displayed showing the model in 
conjunction with the site domain object: 
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Setting Up a New Internal CFD Analysis 
To create a new external CFD analysis, first make sure that you have selected the 
appropriate level object (building, building block or zone) in the model navigator and 
then click on the CFD tab: 
 

 
 
The ‘New CFD Analysis Data’ dialog is displayed which allows you to name the 
analysis and define grid generation variables: 
 

 
 

Default Grid Spacing  
On entry to the CFD screen after completing and closing the new CFD analysis 
dialog, the CFD grid is automatically generated throughout the overall external 
domain extents. The grid is created by first determining key points obtained from 
constituent model blocks along the major axes, the distance between each of these key 
points being known as regions. Each CFD grid region along each major axis is 
automatically spaced using the ‘default grid spacing’ dimension. 
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Grid Line Merge Tolerance 
A potential problem when generating the grid is the creation of cells with a high 
aspect ratio that can lead to instability in the equation solver. In order to avoid such 
cells, grid lines that are very close together can be merged. The ‘grid line merge 
tolerance’ is the maximum dimension that will be used in determining whether or not 
to automatically merge grid lines. 
 

Editing the CFD Grid  

 
 
As soon as a new analysis data set has been created, a default CFD grid is generated 
using the default grid spacing defined as part of the data set. The default grid may be 
edited using the ‘Edit CFD Grid’ tool which allows you to change the spacing used 
for default regions, insert additional regions or remove previously inserted regions.  
 
When you select the ‘Edit CFD Grid’ tool, the grid is displayed with the building 
outline overlaid as a ghosted wire frame. Grid regions are displayed along the major 
axes bounded by dark grey lines, the auto-generated grid region spacing lines being 
displayed in a lighter grey. The currently selected grid region is selected in cyan or 
yellow if the region is a non-default inserted region. To select regions on one of the 
other major axes, you can change the axis by clicking on the required axis of the axis 
selector displayed at the top right of the screen: 
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To edit a grid region, move the mouse cursor across the grid to the required region 
that will highlight to indicate that it has been selected and then click the mouse button. 
The selected region will then highlight in red and the ‘Edit CFD Grid’ data panel will 
be displayed at the bottom left of the screen: 
 

 
 
 
The following settings are available on the ‘Edit CFD Grid’ data panel: 
 

Operation: 
• 1 – Edit Region: Change the spacing of the currently selected region. 
• 2 – Insert Region: Insert a new custom key coordinate at a defined point in the 

current region to form an additional region. 
• 3 – Remove Region: This option is only available if the current region has 

been previously inserted and allows you to remove it.  

New coordinate (m) 
If the ‘Insert Region’ operation has been selected, this setting is displayed allowing 
you to define a custom coordinate within the current region. Note that the coordinate 
must lie in the range defined by the displayed start and end coordinates. 
 

Spacing Type 
The spacing type can be set to one of the following: 
 

• 1-None: The region is not sub-divided. 
 

• 2-Uniform: The region is sub-divided into a number of equal sub-divisions, 
the dimension of which is calculated to be as close to the specified ‘Spacing 
dimension’ as possible. 

 
• 3-Increasing power-law: The location of each sub-division grid line within 

the region increases as the power of the spacing number, which starts at the 
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beginning of the region. So that if  i represents the index number of the grid 
line counted from the start of the region, the coordinate of the ith sub-division 
grid line is calculated using the following relationship: xi=(region 
dimension)(i/n)power+xs 

 
• 4-Decreasing power-law: The location of each sub-division grid line within 

the region decreases as the power of the spacing number, which starts at the 
end of the region. So that if  i represents the index number of the grid line 
counted from the start of the region, the coordinate of the ith sub-division grid 
line is calculated using the following relationship: xi=(region dimension)[1-
(i/n)power]+xs 

 
• 5-Symmetric power-law: The coordinate of the ith sub-division grid line is 

calculated using both increasing and decreasing power-law relationships that 
meet at the middle of the region: 

 
o For i <= n/2: xi=[(region dimension)/2](2i/n)power+xs 

o For i >= n/2: xi=[(region dimension)/2][2-(2i/n))power]+xs 

Spacing dimension (m) 
If the uniform spacing type has been selected, this setting is displayed and allows you 
to enter the dimension used for sub-dividing the region.  

Spacing power 
If the Increasing/Decreasing/Symmetric power law spacing type has been selected, 
this setting is displayed and allows you to enter the power used in the associated 
power-law spacing relationship. 

Number of divisions 
If the Increasing/Decreasing/Symmetric power law spacing type has been selected, 
this setting is displayed and allows you to enter the number of divisions used in the 
associated power-law spacing relationship. 
 
After selecting an operation and adjusting the required settings, you then need to click 
on the ‘Apply changes’ button to update the selected grid region with the current 
settings. 
 

Setting Up CFD Cell Monitor Points 

 
 
The CFD calculation process is iterative and is considered to have completed once 
‘convergence’ has been achieved. The main indicator for convergence is the point at 
which the finite difference equations for all cells are satisfied by the current values of 
the appropriate dependent variables. However, it can be very useful in many cases to 
monitor the variation of the dependent variables at specific locations throughout the 
calculation domain in order to observe the point at which they stabilise. It may be 
acceptable, in many cases, to terminate a calculation as soon as the dependent 
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variables have achieved adequate stability but before the residuals have arrived at 
their defined termination values. When a project is first created, a default central cell 
monitor point is automatically added to the domain. The Define CFD monitor points 
tool enables you to identify up to ten cells throughout the calculation domain at which 
you want to monitor the variation of the calculated variables. After selecting the 
Define CFD monitor points tool, the cell monitor screen is displayed which includes 
the model view together with a cell selection frame, perpendicular to the currently 
selected axis. You can select a plane along the current axis by moving the mouse 
cursor across the model in the direction of the axis. To change the axis, click on the 
required axis on the axis selector tool, which is located at the top right of the screen: 
 

 
 
 
After selecting the required axis, move the cell selection frame along the axis, and 
then click the mouse button to select a plane at the required distance along the axis. A 
cell selection grid is then displayed in the selected plane allowing you to move the 
mouse cursor to the required cell in that plane: 
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After moving the mouse cursor to the required cell, click the mouse button to display 
the cell monitor data panel at the bottom left of the screen. 
 
The following settings are available on the cell monitor data panel: 
 

Operation 
This control is only active if you have selected a cell for which a monitor point has 
already been defined. The following options are available: 
 

• 1–Update cell - Add a monitor point or edit the name of a previously defined 
point. 

 
• 2–Remove cell - Remove a previously defined monitor point. 

 
Monitor location nam 
Enter name for monitor point. 
 
After changing the required settings, click on the ‘Apply changes’ button to update 
the selected cell. You can cancel the Define CFD monitor points command by 
pressing the <Esc> key or by selecting another tool. 
 

CFD Grid Information 

 
 
Information about the CFD grid can be obtained using the ‘Show CFD grid statistics’ 
tool, which displays the CFD grid statistics dialog: 
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If the maximum cell aspect ratio exceeds the allowable limit of 50 or the required 
memory exceeds the physical memory available, the ‘Check’ will indicate a failure: 
 

 
 
 

CFD Calculations 

 
 
Please refer to the CFD Calculations and Convergence section for an overview of the 
calculation methodology that will help in understanding the concepts used to 
initialise, control and monitor the calculations. 
 
To run the calculations, click on the Update calculated data tool. If a problem is 
found with the grid generation, the CFD Grid Statistics dialog is displayed showing 
the error. There are three possible error conditions: 
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Maximum cell aspect ratio exceeds the limit - you will need to delete the existing 
project and create a new one either reducing the default grid spacing dimension or 
increasing the grid line merge tolerance by a suitable amount (see the ‘CFD Results 
Manager’ section).  
 
Required memory exceeds the available memory - you will need to delete the 
existing project and create a new project with larger default grid spacing or consider 
simplifying the problem definition in terms of complexity of assemblies, etc. 
 
Flow imbalance – The total flow rate specified for supply diffusers does not balance 
with the total flow rate specified for extract grilles. You will need to add supply 
diffusers or extract grilles or edit the existing flow rates to establish the correct 
balance 
 
 If no problem is encountered in creating the grid, the ‘Edit Calculation Options’ 
dialog will be displayed: 
 

 
 
The ‘Edit Calculation Options’ dialog is divided into two main sections, the Residuals 
and Cell Monitor graphs and the Calculation Options Data panel.  There are also a 
group of buttons at the bottom of the dialog, which allow you to control the 
calculations: 

Start 
Start, or if the calculations have been paused, re-start the calculations. 

Pause 
Interrupt or pause the calculations. Once the calculations have been paused, the 
calculation dialog can be temporarily closed in order to review the results. 

Reset 
After pausing the calculations, the calculations may then be re-initialised to start from 
scratch. If the solution is found to diverge and you pause the calculations to decrease 
the velocity false time steps, you will then need to reset the calculations before re-
starting. 
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Calculation Options Data  
The calculation settings panel incorporates the following settings: 
 
Turbulence Model: 
 
The following turbulence models are available: 
 

• 1–k-ε: ε: ε: ε: This model is one of the most widely used and tested of all turbulence 
models, belonging to the so-called RANS (Reynolds Averaged Navier-Stokes) 
family of models. These models involve replacing the instantaneous velocity 
in the Navier-Stokes and energy equations with a mean and fluctuating 
component. The resulting equations give rise to additional terms known as 
Reynolds stresses and turbulent heat flux components. Reynolds stresses are 
replaced with terms involving instantaneous velocities where molecular 
viscosities are substituted for effective viscosities and a similar substitution is 
conducted for the energy equation. The effective viscosity is the sum of the 
molecular viscosity and a turbulent viscosity, which is derived from the 
turbulence kinetic energy and the dissipation rate of turbulence kinetic energy: 

 

µt = Cµ ρ 
k2

ε  

 
where k= turbulence kinetic energy and  ε = dissipation rate of turbulence 
kinetic energy 

 
k and  ε are both derived from partial differential equations which are in turn 
derived from a manipulation of the Navier-Stokes equations. 

 
• 2 – Constant effective viscosity: The constant effective viscosity model is a 

much simpler approach and involves the replacement of the molecular 
viscosity in the Navier-Stokes equations with a constant effective viscosity 
(typically in the order of 100-1000). Although this model is incapable of 
modelling local turbulence or the transport of turbulence, it is computationally 
much less expensive than the k-ε model and can be numerically much more 
stable. 

Discretisation scheme 
The following discretisation schemes are available: 
 

• 1-Upwind - The calculation process involves replacing the defining set of 
partial differential equations with a set of finite difference equations. The 
conventional approach to this is to use a Taylor’s series formulation, which 
leads to a set of central difference equations. However, although this approach 
is physically realistic for diffusion, it is not found to be realistic for convection 
because of its one-way nature, i.e. upwind conditions affect downwind 
conditions but not the reverse. The upwind scheme allows the convective term 
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to be calculated assuming that the value of the dependent variable at a cell 
interface is equal to the value at the cell on the upwind side of the interface. 

 
• 2 – Hybrid – a  more computationally expensive approach than the upwind 

scheme but it reduces numerical diffusion at high values of Pe number. 
 

• 3 – Power-Law - The power-law scheme is arguably more accurate than the 
hybrid scheme but is more computationally expensive. 

Iterations 
This is the maximum number of iterations conducted by the outer iterative calculation 
loop (see ‘CFD Calculations and Convergence’ section). The calculations will 
terminate when the number of iterations reaches this value regardless of whether or 
not the solution has converged. 

Isothermal 
Temperature is assumed to be constant throughout the calculation domain and the 
energy equation is removed from the calculations. 

Surface heat transfer 
The following surface heat transfer options are available: 
 

• 1–Calculated - Surface heat transfer coefficients are calculated by the CFD 
calculation scheme if the k-ε turbulence model has been selected.  

 
• 2–User-defined - Surface heat transfer coefficients can be defined for ceilings, 

wall and floors. 

Initial conditions 
In some cases, a faster solution can be achieved by setting the initial conditions closer 
to the final expected conditions. 

Cell monitor 
Select any defined cell monitor point and associated dependent variable to be 
displayed on the cell monitor (see ‘Setting Up CFD Cell Monitor Points’ section). 

Residual Display 
Select the dependent variables and/or mass for which residuals are to be displayed in 
the residuals monitor. The mass residual is similar to the dependent variable residuals 
but is extracted from a continuity equation mass balance for each cell. 

Dependent Variable Control Settings 
The calculations involve a nested iterative scheme whereby dependent variable 
equations are solved iteratively within an overall outer iterative loop (see ‘CFD 
Calculations and Convergence’ section).  The dependent variable control settings 
enable control inner iterative dependent variable calculations. 
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• Inner Iteration: The number of iterations used for the calculation of the 
dependent variable. 

 
• False Time Step: The finite difference equation set is formulated in the 

form of a transient equation set although the calculations are essentially a 
‘snap-shot’ in time. The reason for this formulation is that the transient 
term behaves as a very effective relaxation method, which can slow the 
change in dependent variables in order to arrive at a more stable solution. 
The false time step is the time step used in the pseudo-transient term of 
the dependent variable equation. For forced convection flows, a ‘best-
guess’ optimal false time step is automatically calculated for velocities, 
however for buoyancy driven flows, a default value of 0.2 is used. 
Reducing the false time step has the effect of slowing down the change 
in the dependent variable and can be a helpful remedy for unstable 
solutions. 

 
• Relaxation Factor: This is the ‘text book’ relaxation method, which can 

be used to allow only a proportion of the calculated value of the current 
iteration dependent variable to be assigned to the variable. However, the 
false time step is normally the preferred method of achieving under-
relaxation. 

 
• Termination Residual: The outer iterative calculation loop is repeated 

until the finite difference equations for all cells are satisfied by the 
current values of the appropriate dependent variables, at which point the 
scheme is said to have ‘converged’. The dependent variable residual is 
the maximum residual quantity for the equation balance across all cells 
in the domain. The solution is deemed to have converged for each 
dependent variable when the residual is less than the termination 
residual. 

 

Residuals and Cell Monitor Graphs 
The value of each dependent variable residual together with the mass residual is 
plotted on the residuals graph, at the end of each outer iteration of the calculation. 
You can use the residuals plot to monitor the overall convergence of the solution and 
to determine whether or not any remedial action is required. 
 
When considering the residual plots, you should bear in mind that the residuals can 
fluctuate quite markedly throughout the period of the calculations and in some cases 
rise appreciably before falling and so you need to get an idea of the overall trend after 
several hundred iterations. The following screenshot shows a plot of residuals and a 
default centrally located monitor cell plot for the internal analysis illustrated in the 
next ‘Displaying Results’ section. Notice that the monitored velocity has reached a 
steady final value. 
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If you notice that the residuals are fluctuating wildly or steadily increasing over 
several hundred iterations, you should pause the calculations and take remedial action 
(see ‘Convergence Difficulties and Troubleshooting’ section). 
 
The cell monitor graph displays the variation in the selected dependent variable for 
the currently selected monitor cell (see ‘Setting Up CFD Cell Monitor Points’ section 
and ‘Cell Monitor’ setting in the ‘Calculation Options Data’ section above). The 
variation of monitored cell point variables provides a good indication of solution 
convergence, i.e. when the variation of the variable stabilises. 
 

Convergence Difficulties and Troubleshooting 
If the plotted residuals are found to diverge or fluctuate significantly, in many cases 
you will find that the situation can be improved by reducing the false time steps for 
the velocity components. The recommended procedure is to continuously half the 
time steps until a more stable solution is found. 
 
However, in some cases a solution can be very difficult, if not impossible, to achieve 
using the standard k-ε turbulence model. Particularly difficult problems involve very 
low velocity buoyancy-driven flows where diffusion is dominated by convection and 
this can cause velocities to fluctuate around a mean value. In these cases, reducing 
false time steps may not improve the situation. In order to force a solution, you may 
consider introducing additional boundary conditions such as occupants, which can 
change the flow sufficiently to obtain a solution without the problem necessarily 
becoming unrealistic. Alternatively, you may consider using the constant effective 
viscosity turbulence model with a relatively high turbulent viscosity or turbulent 
viscosity multiplier but bear in mind that this will introduce an artificially high level 
of diffusion into the flow and also, the constant effective viscosity model is incapable 
of modelling the transport of turbulence. 
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Displaying Results 

 
 
After completing or pausing the calculations, the CFD Display Options data panel and 
the ‘Select CFD slice’ tool become active.  
 
The main mechanism for displaying results is the slice tool that allows you to select a 
slice, along one of the main grid axes and perpendicular to it, within which can be 
displayed any of the selected results display plots. After selecting the ‘Select CFD 
slice’ tool, the CFD results screen is displayed which includes the model view 
together with a slice selection frame, perpendicular to the currently selected axis. You 
can select a slice along the current axis by moving the mouse cursor across the model 
in the direction of the axis. To change the axis, click on the required axis on the axis 
selector tool, which is located at the top right of the screen: 
 

 
 
After selecting the required axis and moving the slice selector frame to the required 
position along the axis, click the mouse button to add the slice to the display. Notice 
that as you move the slice selection frame to a slice that was previously added to the 
display, the frame colour changes from green to red and if you click the mouse button, 
the slice is removed from the display: 
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Slice variable plots are selected under the ‘Slice Settings’ header on the Display 
Options data panel and controlled under the ‘Variable Settings’ header: 
 
 
 

 
 
 
Note that any modifications made to items on the Display Options data panel will 
only come into effect after clicking on the ‘Apply changes’ button. 
 
The ‘Variable Settings’ group contains groups of variable banding data for velocity, 
temperature and pressure variables. Also, under the variable settings ‘Velocity’ 
header, there are two velocity vector settings, ‘Maximum vector length’ and ‘Velocity 
scale factor’. Velocity vectors are displayed as arrows, the length of which 
corresponds to the magnitude of the velocity and with the default vector scale factor 
of 1.0, a length of 1.0m corresponds to a magnitude of 1.0m/s. The maximum vector 
length is the maximum length of a vector that will be displayed to prevent the display 
from becoming cluttered with excessively large vectors. Any vector, which has a 
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magnitude greater than this maximum, will be displayed translucently to distinguish it 
from vectors with lengths that do represent magnitude.  
 
The variable banding data comprises the defined band range, followed by twelve 
contour band values within the defined range. The band range defines the minimum 
and maximum variable values between which data will be displayed and the band 
values are the actual values within that range that are displayed in the form of 
contours or in the case of velocity vectors, vector colours. The default minimum and 
maximum variable display values are extracted from the calculated values and this 
range is then divided into twelve equal increments in order to arrive at the dependent 
variable contour bands. Each contour band can be edited or switched off altogether. 
When the band range values are modified, the individual band values are 
automatically re-calculated. 
 
The ‘Slice Settings’ group is used to select the plots required to be included in 
subsequently added slices.  
 
The last item on the Display Options data panel is the 3-D contours group that allows 
you to select any of the available variables for which a 3-D contour plot is required: 
 
 

 
 
 

Conducting CFD Comfort Calculations 

 
 
After completing or pausing the CFD the ‘Update CFD comfort’ tool will become 
enabled. After selecting the ‘Update CFD comfort’ tool, a progress bar will be 
displayed indicating that mean radiant temperature (MRT) calculations are in 
progress, followed by another progress bar for the comfort calculations themselves.  
 
Comfort calculation metabolic rates and clothing levels are obtained from the data 
entered under the ‘Metabolic’ header on the ‘Activity’ tab of the model data panel. 
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After completing the calculations, some additional comfort display variables are 
available on the Display Options data panel: 
 

• PMV 
• PPD 
• Comfort Indices 
• Mean Radiant Temperature 
• Operative Temperature 

 

 
 
 

CFD Results Manager 

 
 
The CFD results manager tool allows you to create new CFD projects, open existing 
projects or remove existing projects. For example, considering the internal analysis 
example illustrated in the Displaying Results section, you may want to conduct 
another analysis after moving the position of a radiator in order to look at the effect on 
air distribution. You would first go to the Edit screen and modify the radiator layout: 
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After returning to the CFD screen, you can then click on the CFD results manager 
tool to open the CFD Results Manager dialog: 
 
 

 
 
The CFD Results Manger dialog incorporates a list of all available projects together 
with buttons that allow you to create a new project, open a project or delete a project. 
For each project entry in the list, the first column indicates the project name, the 
second column the model domain object used for the calculations (site, building, 
building block, zone) and the third column indicates whether or not the model 
geometry contained within the results is up-to-date. In this case, you would click on 
the ‘New’ button to create a new project: 
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See the ‘Setting Up a New Internal CFD Analysis’ section for details of creating a 
new internal analysis. 
 
After creating the new analysis, you can then conduct the calculations: 
 

 
 
 
You can then use the CFD Results Manager to open the previous project in order to 
compare results: 
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Example - CFD External Analysis 
This CFD example will go through the steps required for a typical external CFD 
analysis: 
 

• Create model for external analysis. 
• Switch to the CFD screen and create a new CFD analysis. 
• Perform the CFD calculation. 
• Review the results. 

 
External analyses are simpler than internal analyses in that you do not need to define 
any internal boundary conditions. Also they are isothermal and take account 
principally of only velocity and pressure. 
 
Refer to internal analysis for details of grid editing and monitor cell selection. 

Creating the model 
The model comprises a simple rectangular block with dimensions 30.0m x 20.0m x 
30.0m.  
 
Click on the Add new block tool and change the Block type to Building block and the 
Height to 30.0m. To place the origin of the building at the site origin, type in 0 0 and 
press the <Return> key. To then create the block with a 30.0m x 20.0m perimeter, 
type in 30 20 and press the <Return> key. A block will be created with the required 
dimensions. Alternatively create the block by drawing the base perimeter in the 
normal way. 
 

 
 

Creating a new CFD external analysis 
Each DesignBuilder project can have one or more CFD analyses. Each CFD Analysis 
can be a different set of results for a different variation on the model. Unlike 
simulation data, CFD Analyses are not deleted automatically when the model is 
modified on the Edit screen. 

1. Click on the site in the navigator to move to the site level.  
 
External CFD analyses can only be conducted at the site level.  
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2. Click on the CFD tab to set up an external CFD analysis.  
3. After clicking on the CFD tab, the New CFD analysis dialog is displayed. 

Enter Wind analysis in the Name field and leave the grid spacing and grid 
line merge tolerance in their default settings.  

4. Default grid spacing and grid line merge tolerance settings are covered later. 
5. Under the Wind header, change the free-stream velocity to 12.0m/s, the 

Direction to 45°°°° and the Exposure to Urban.  The wind direction is defined 
clockwise from North, so the default of 270° represents a westerly and a 
setting of 45° a North-easterly.  

6. The Site Domain Factors are multipliers that are applied to the overall model 
extent in the X (length), Y (width) and Z (height) dimensions to derive a site 
domain across which the calculations will be carried out. Keep the defaults of 
3, 3 and 2. 

7. After clicking on OK to create the analysis data set, the CFD screen displays 
the model in wire-frame together with the site domain, which is outlined in 
dotted lines. 

 

 
 
Notice the rotation of the domain with respect to the building to account for the wind 
direction. 
 

Setting up monitor cells 
It is usually a good idea to display the state of one or more monitor cells in the 
domain so that you can ‘monitor’ the extent to which the calculations have settled 
down to a final converged solution. DesignBuilder automatically sets up a single 
monitor cell at the centre of the domain. You can add new monitor points at any time 
as follows. 

Click on the Define CFD monitor points tool and select the Z grid axis using the grid 
axis selector tool. Move the cursor along the axis to select a plane a couple of grid 
cells above the building and then move the cursor across the selected plane and select 
a cell roughly above the centre of the building. The Cell monitor data panel is 
displayed at the bottom left of the screen. Enter the name Roof into the Monitor 
location name field and click on the green tick Apply changes button. 
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Press <Esc> to cancel the Define CFD monitor points tool. 

Running the CFD calculations 
To set up calculation data and run the CFD calculations, click on the Update 
calculated data button, which will bring up the CFD Calculation options dialog. The 
left hand side of the calculation dialog contains various calculation options.  
 
Keep the default options except for Iterations which should be set to 5000 and under 
the Residual Display header, switch on the X, Y and Z-axis velocity residuals. 
 
Click on the Start button to begin the calculations. Wait until the calculation is fully 
converged when the residuals have reached the specified minimum and the “Finished 
(Converged)” indicator is displayed at the bottom left of the dialog. Notice that the 
displayed velocity for the supply monitor point becomes constant. 
 
Press the Cancel button to close the calculation dialog. 
 

Displaying CFD results 
1. Go to the Display Options panel and open the Velocity header under the 

Variable Settings header and set the Vector scale factor to 2.0 and the 
Maximum vector length to 5m.  

 
2. Under the Slice Settings header, make sure that only Velocity vectors is 

switched on.  
 

3. Click on the green tick Apply changes button. 
 

4. Click on the Select CFD slice tool. Use the grid axis selector to change the 
current axis to the Z-axis and then move the mouse across one of the side 
surfaces of the site domain along the Z-axis until the slice selection frame is 
located 25m above the ground plane. Click on the mouse to add the currently 
selected slice to the display. 
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1. Clear the current slice from the display using the Clear all slices tool.  
2. Switch off Velocity vectors under the Slice Settings header on the Display 

Options panel and switch on the Velocity contours and Filled Velocity 
contours.  

3. Click on the green tick Apply changes button.   
4. Select the Y-axis from the grid axis selector and move the cursor over the top 

surface of the site domain along the Y-axis until the slice selection frame is 
50.68m from the origin and click the mouse to add the slice to the display.  

5. To add a horizontal slice 5m from the ground, select the Z-axis from the grid 
axis selector and move the cursor over one of the side surfaces of the site 
domain along the Z-axis until the slice selection frame is 5.0m above the 
ground plane and click the mouse to add the slice to the display. 

 

 
 

Display 3-D contours 
3-D contours can be displayed to show the values of a variable throughout the 
domain. 3-D contours can display a lot of data: 

1. Clear the current slice from the display using the Tools > Clear all slices 
menu option.  

2. Under the 3-D Contours header on the Display Options data panel, switch on 
Pressure. Click on the green tick Apply changes button.   
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Example - CFD Internal Analysis Basics 
This internal CFD example will guide you through the basic minimum steps required 
for an internal CFD analysis: 
 

• Create a simple single zone model. 
• Add CFD surface boundaries to the model including a simple sidewall supply 

diffuser and ceiling mounted extract grille. 
• Switch to the CFD screen and create a new CFD analysis. 
• Perform a CFD calculation using default calculation options and grid. 
• Review the results. 

Creating the model 
The model comprises a simple rectangular block housing a zone with dimensions 
6.0m x 4.0m x 3.5m.  
 
Create a new site and add a new building using default settings. From the building 
level Click on the ‘Add new block’ tool and change the “Block type” to “Building 
block”, the “Height” to 3.5m and set the wall thickness to 0.25m.  
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Default wall and window boundary temperatures 
Default wall and window boundary temperatures can be defined from the building 
level down to the surface level. As with other DesignBuilder attribute data, these 
attributes are inherited from the level above unless deliberately overwritten. 
 
The default wall and window boundary temperatures can be accessed under the CFD 
Boundary header under the Construction header on the Construction tab of the Model 
data panel. 
 
At the building level, change the default window temperature to 20°C. 
 

 
Boundary conditions shown on a display with “Learning mode” switched off. 

 
Go down to the zone surface facing North and change the default wall temperature to 
18°C and the default window temperature to 10°C. Go through the same procedure for 
the west facing zone surface. 

Adding surface supply diffuser and extract grille 

Supply grille 
1. Click on the zone in the navigator and select the North-facing surface in the 

Edit screen. Double-click to drop down to the surface level.  
2. Click on the Normal view button to obtain a normal view of the surface.  
3. Click on the Add CFD boundary tool. The CFD boundary data panel is 

displayed at the bottom left of the screen.  
4. Select Supply from the Boundary type drop list. Keep all of the remaining 

boundary defaults but change the Y discharge angle to 45°°°° in order that the 
supply jet will be projected upwards at an angle of 45° from the horizontal.  

5. The supply diffuser is to be 1.0m x 0.2m and is to be located midway between 
the North and South surface edges, 0.4m from the top edge of the surface. 
With the Increment snap switched on, move the cursor to the top left corner 
of the surface and press <SHIFT> to lock the origin to the surface corner, 
move the cursor away from the corner until the cursor is snapped 0.4m from 
the top edge and 1.5m from the left edge and click the mouse button to place 
the top left corner of the boundary. Move the cursor to place the bottom right 
corner of the boundary 1.0m to the right and 0.2m below the top left corner 
and click the mouse to place the supply. 
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Extract grille 
A 0.5m x 0.5m extract grille is to be located in the corner of the ceiling 0.5 m from 
the North and east surface edges.  
 

1. Click on the zone roof surface in the navigator and again click on the Normal 
view button to obtain a normal view.  

2. Click on the Add CFD boundary tool and select Extract  from the Boundary 
type drop list. Keep the default flow rate of 200 l/s to match the supply flow 
rate.  

3. Move the cursor until it is snapped 0.5m from the top edge of the surface and 
0.5m from the right edge and click the mouse to place the top right corner of 
the extract, move the mouse 0.5m to the left and 0.5m below the top right 
corner of the extract and click the mouse to place it. 

 

 

Creating a new CFD internal analysis 
Click on the building in the navigator to move to the building level and click on the 
CFD tab to set up an internal CFD analysis. An internal analysis can be set up for any 
level from a single zone up to the whole building. In this case, because we are dealing 
with a single zone building, the analyses for each level would be identical. After 
clicking on the CFD tab, the New CFD analysis dialog is displayed. Enter Basic 
Vent in the Name field and leave the grid spacing and grid line merge tolerance at 
their default settings. More on grids in the next exercise. 
 
Click OK to create the analysis data set. 
 
You will see the model in wire-frame mode by default and at this stage the CFD 
analysis has been created including the default grid and the model is ready for 
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calculations. If you were going to edit the grid now is the time – before starting the 
calculations, but for now we will use the default grid. 

Running the CFD calculations 
To set up calculation data and run the CFD calculations, click on the “Update 
calculated data” button, which will bring up the CFD Calculation options dialog. 
The left hand side of the calculation dialog contains various calculation options. Keep 
the default options except under the Residual Display header, switch on the X, Y and 
Z-axis velocity residuals. 
 
Click on the Start button to begin the calculations. Wait until the calculation is fully 
converged when the residuals have reached the specified minimum (1x10-5 is the 
default for all variables) and the Finished (Converged) indicator is displayed at the 
bottom left of the dialog. Notice that the displayed velocity for the default Centre 
monitor point becomes constant (bottom graph). 
 

 
 
Press the Cancel button to close the calculation dialog. 

Displaying CFD results 
After the calculations have been completed, the CFD results display options data 
panel is enabled allowing you to set various results display options. Use default 
Display options.  
 
Click on the Select CFD slice tool. Click on the Y-axis of the grid axis selector (top 
right of screen) and then move the cursor over the ceiling surface along the Y-axis to 
move the slice selection frame midway between the North and South-facing walls, 
2.0m from each wall and click the mouse button to add the currently selected slice to 
the display. 
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Notice that as you move the slice selection frame to a slice that was previously added 
to the display, the frame colour changes from green to red and if you click the mouse 
button, the slice is removed from the display. 
 
Try adding more slices in other planes to see the key characteristics of temperature 
and velocity distribution in the zone. 
 
Press the ESC key to cancel Select CFD slice tool. 
 

Example - CFD Internal Analysis Including Assemblie s 
In this second internal CFD exercise, the model is modified to include radiators as 
well as the supply and extract vents entered in the first tutorial. Also some more 
advanced features of the CFD calculations and display are explored. You will learn 
how to: 
 

• Create a component representing a constant temperature radiator, convert the 
component to an assembly, assign CFD boundary conditions to the assembly 
and add the assembly to the model assembly library. 

• Place the previously created radiator assembly within the zone. 
• Edit the CFD grid. 
• Add cell monitor points for calculation monitoring purposes. 
• Edit the CFD Calculation options. 
• Deal with common errors and non-convergence. 
• Perform comfort calculations. 
 

Creating the radiator assembly 
Assemblies consist of 1 or more component blocks combined and are used to create 
boundary conditions inside or outside blocks. They can be used to create furniture, 
heat generating equipment, airflow supply and extract etc.  
 
In this exercise a radiator assembly is to be created from a single component block, 
which is to be drawn using a rectangular extrusion.  
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1. Click on the Add new block tool and change the Block type on the Drawing 
Options panel to Component block and the Height to 1.0m.  

2. To place the origin of the radiator component block at the site origin, type in 
0 0 and press the return key.  

3. Now to create the radiator component with a length of 1.0m and say a 
thickness of 60mm to represent a single panel convector type radiator, type in 
1.0 0.06. The component block will then appear with the specified dimensions. 
Alternatively use the mouse to define the component block dimensions in the 
usual way. 

 

 
 
To convert the component block to an assembly and add the resulting assembly to the 
model assembly library: 
 

1. First select the component block and then click on the Add assembly to 
library  tool. The selected component block will be displayed with a wire 
frame bounding-box and the Add assembly to library data panel is displayed 
at the bottom left of the screen.  

2. Set the Assembly creation mode to Delete because the original component 
block will not be needed after the conversion and type the name Radiator into 
the Name field.  

3. Set the Thermal boundary type to Temperature in order to create a constant 
temperature radiator and set the Temperature to 75.0°°°°C.  

4. Make sure that the Mass check box is checked to ensure that the assembly will 
represent a solid boundary and that air will not be able to pass through it.  

5. The next stage is to select the attachment plane for the assembly, which is the 
surface plane of the assembly that will be used when attaching the assembly to 
a model surface during the assembly placement process. In this case, the base 
(bottom) surface of the radiator should be selected as the attachment plane. To 
select the attachment plane, move the cursor over the radiator assembly and as 
you do so, each surface of the assembly bounding-box will highlight in 
yellow, move the cursor to the base surface of the bounding-box and click the 
mouse. The assembly will then be automatically added to the model assembly 
library and because the Delete creation mode has been selected, the original 
component will be deleted. 
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Positioning radiators within the block 
Assemblies inside the building must be placed at Block level (not zone level) so to 
place a radiator assembly first click on the block in the navigator to move down to the 
block level.  
 
To position assemblies accurately you must use construction lines. 
 
To do this, orbit the model to get a clear view of the west-facing end wall from the 
inside of the block and then click on the Place construction line tool.  
 
To position the construction line accurately, switch on the Increment snap under Point 
Snaps on the Drawing Options data panel. Move the cursor to snap to the lower 
surface edge at the bottom of the North-facing wall and move the cursor to obtain an 
edge snap 0.3m from the end nearest the west-facing wall. Click the mouse to start the 
construction line and move the mouse to the opposite edge at the bottom of the South-
facing wall, snapped to the Y-axis and click the mouse once the edge snap is 
established on the opposite edge to place the construction line. 
 

 
 

Click on the Place assembly tool and as you move the cursor back across the Edit 
screen, you will see that a copy of the previously created radiator assembly is attached 
to the cursor and the Place assembly data panel is displayed at the bottom left of the 
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screen. Set the Offset to 0.1m to offset the base of the radiator 0.1m above the floor 
level, set the Width to 2.0m, the height to 0.6m and leave the Depth at 0.06m. Move 
the cursor to establish a snap on the construction line and click the mouse to place the 
radiator origin. Once the radiator has been placed, a protractor is displayed at the 
assembly origin enabling you to define the rotation. Rotate the radiator assembly until 
it is parallel with the nearest wall and then click the mouse to set the rotation.  
 

 
 
Repeat this procedure to place a 3.0m radiator adjacent to the North-facing wall. 
 

 
 

Creating a new CFD internal analysis 
We are now ready to start a new CFD calculation so again click on the building in the 
navigator to move to the building level and click on the CFD tab. If you have just 
finished the first CFD exercise, the analysis results for these calculations will be 
displayed. You should now create a new analysis because the model has changed with 
the addition of the radiators. To do this click on the CFD Results Manager toolbar 
icon. This displays the dialog below. 
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Note that the first Basic Vent analysis is flagged as not up-to-date. This is because 
the model has been edited since the last calculation was made. 
 
Click on the New button to create a new analysis using the model in its current state. 
The New CFD analysis dialog is displayed. Enter Radiators and Vent in the Name 
field and leave the default grid spacing and grid line merge tolerance at their default 
settings. The default grid spacing and grid line merge tolerance are used in generating 
the CFD grid. During the process of creating a new CFD analysis data set, a 3-D CFD 
grid is automatically generated by extracting key points from the model geometry 
along each of the major axes. The spaces between the key points are known as grid 
regions and are automatically divided into sub-regions using the default grid spacing 
entered on the Calculation options dialog. The grid line merge tolerance enables key 
point grid lines that are very close together to be merged in order to prevent very high 
aspect ratio cells from being created which can lead to calculation instability.  
 
Click OK to create the analysis data set. 
 
You will see the model in wire-frame mode by default and at this stage the CFD 
analysis has been created including the default grid and the model is ready for 
calculations.  

Editing the CFD grid 
But before starting the calculations we will explore the edit grid capability. First click 
on the Edit CFD grid  tool. Move the cursor across the displayed CFD grid to select 
grid regions along the current grid axis. Selected grid regions are highlighted in cyan.  
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To change the current grid axis, click on one of the major axes in the grid axis selector 
tool that is displayed at the top right of the CFD screen. To edit a selected region, 
click the mouse on the currently selected region. The selected region will turn red and 
the Edit CFD grid region  data panel will be displayed at the bottom left of the 
screen. You can select Edit region from the Operation drop list to change the default 
spacing of the region or Insert region to create a new region and in the case of a 
previously inserted region, you can select Remove region to remove it. 
 

 
 
To cancel the Edit CFD grid  tool press the <Esc> key. 
 
After editing the default grid, you can reset it to the default by clicking on the Reset 
CFD grid  tool. Also, to obtain information about the grid, you can click on the Show 
CFD grid statistics tool which brings up a dialog indicating the number of cells, 
required memory, available memory and maximum cell aspect ratio. 
 
For the purpose of this tutorial, the default grid will be used. 

Setting up monitor cells 
In order to monitor the convergence of the solution, it can be useful to set up a 
number of monitor points throughout the calculation domain. During the calculation it 
is then possible to enable a plot of the variation of the various dependent variables for 
each of the defined monitor points in order to see if the variables have reached a 
constant value as the CFD calculation proceed. 



Simulation and CFD Training Guide  

DesignBuilder copyright © 2009 217 

 
1. To set up a monitor point, click on the Define CFD monitor points tool.  
2. Move the cursor along the current grid axis to select the plane in which the 

monitor cell is to be selected. You can change the current grid axis using the 
grid axis selector tool as before.  

3. Once the plane has been selected, you can the move the cursor to select the 
required cell in that plane. With the current grid axis set to the default X axis, 
move the cursor along the axis to select a plane about 1.0m from the supply 
diffuser and then move the cursor across the selected plane and select a cell 
directly in front of the diffuser.  

4. The Cell monitor data panel is displayed at the bottom left of the screen. Enter 
the name Supply in the Monitor location name field and click on the green 
tick Apply changes button 

 

 
 
When a monitor cell has been added, a cell marker is displayed together with the cell 
name. 
 

 
 
You can press <Esc> to cancel the Define CFD monitor points tool. 
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Running the CFD calculations 
To set up calculation data and run the CFD calculations, click on the Update 
calculated data button, which will bring up the CFD Calculation options dialog. 
The left hand side of the calculation dialog contains various calculation options. Keep 
the default options except under the Residual Display header, switch on the X, Y and 
Z-axis velocity residuals. 
 
Click on the Start button to begin the calculations. Wait until the calculation is fully 
converged when the residuals have reached the specified minimum and the “Finished 
(Converged)” indicator is displayed at the bottom left of the dialog. Notice that the 
displayed velocity for the default Centre monitor point becomes constant (bottom 
graph). 

CFD Display options 
In the CFD results slices, velocity vectors are displayed as arrows, the length of which 
corresponds to the magnitude of the velocity and with the default vector scale factor 
of 1.0, a length of 1.0m corresponds to a magnitude of 1.0m/s. The maximum vector 
length is the maximum length of a vector that will be displayed to prevent the display 
from becoming cluttered with excessively large vectors. Any vector, which has a 
magnitude greater than this maximum, will be displayed translucently to distinguish it 
from vectors with lengths that do represent magnitude.  
 
The default minimum and maximum dependent variable values are extracted from the 
minimum and maximum values found in the domain and this range is then divided 
into twelve equal increments in order to arrive at the dependent variable contour 
bands. Each contour band can be edited or switched off altogether.  
 
In this tutorial the maximum temperature will be 75.0°C (the temperature of the 
radiators), which is well above the mean temperature of the space, and consequently 
the default contour bands would be far from the mean and the resulting display would 
not be very informative. So in order to compress the contour bands to be within the 
likely temperature range throughout the domain DesignBuilder automatically sets the 
Maximum Temperature under temperature bands range to 24.0°C and the minimum 
value to 18°C.  
 
You can manually change these maximum and minimum values in the Display 
options panel. Note that you need to click on the green tick Apply changes button in 
order for the display attributes to take effect. Notice also that the temperature contour 
bands are updated using the new temperature range. 
 
You can revert to the absolute minimum and maximum values in the model by using 
the Tools > Reset CFD display variables menu command. 
 

Comfort calculations 
Click on the Update CFD comfort tool to carry out comfort calculations. After the 
calculations have been completed, various comfort variables are available for display, 
PMV, PPD, operative temperature and mean radiant temperature. Clear all slices from 
the display using the Clear all slices tool. Switch off Velocity vectors and Filled 
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temperature contours under the Slice Settings header on the Display options panel and 
switch on the PMV contours and Filled PMV contours. Click on the green tick 
Apply changes button.   
 
Click on the Select CFD slice tool and click on the Y-axis of the grid axis selector. 
Move the cursor over the ceiling surface along the Y-axis to move the slice selection 
frame again to be midway between the North and South-facing walls and click the 
mouse button to add the slice to the display. 
 
 

 
 
 

Change CFD Analysis 
You can now switch between the 2 CFD analyses you have carried out using the CFD 
Result Manager dialog. Select the analysis you wish to switch to and use the Open 
button to load results. Any slices associated with the analysis will be restored. These 2 
analyses will be stored in the dsb file by default and are not deleted when changes are 
made to the model. 
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APPENDIX I - Calculated Natural Ventilation 
 
This section is provided for background information. 
  
The ventilation rate (q) through each opening and crack in the model is calculated 
based on the pressure difference using wind and stack pressure effects: 
  

q = C.δPn 
  
Where: 

q  is the volumetric flow through the opening/crack. 
δP is the pressure difference across the opening/crack. 
n  is the flow exponent varying between 0.5 for fully turbulent flow and 1.0 for 
fully laminar flow. 
C is the flow coefficient, related to the size of the opening/crack. 

 

Wind-Driven Ventilation 
When wind impinges on the surface of a rectangular building, a positive pressure is 
induced on the upwind face.  The flow separates at the corners resulting in negative 
pressure regions on the side of the building and a negative pressure distribution on the 
leeward facade. The pressure distribution on the roof varies according to pitch - the 
pressure on the upwind face being negative for roof pitches of 30° and positive for 
steeper pitches.  
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The DesignBuilder CFD screenshots above show examples of this for 2 typical 
building configurations. Positive wind pressure is shown in red and negative pressure 
in blue. 
 
The pressure on any point on the surface of a building facade can be represented by: 
  

Pw = 0.5.ρ.Cp.vz
2 

  
Where: 
  

Pw is the surface pressure due to wind,  
ρ is the density of air,  
Cp is the wind pressure coefficient at a given position on the surface and  
vz is the mean wind velocity at height z. 

  
The wind pressure coefficient, Cp, is a function of wind direction, position on the 
building surface and side exposure.   Some typical approximate values for buildings 
subjected to varying degrees of shelter and wind directions is given in an AIVC 
publication A guide to energy-efficient ventilation. This data is also quoted in the 
CIBSE A Guide. DesignBuilder uses this data to populate the Wind Pressure 
Coefficients (WPC) templates and provide default pressure coefficients suitable for 
use in basic design calculations for buildings having no more than three stories. The 
WPC data is entered at the surface level. 
  
For more detailed analysis, or for buildings having 4 or more stories you should 
ideally obtain specific pressure coefficient data from: 
 

1. Wind tunnel measurements on a physical model or  
2. CFD analysis of from wind tunnel measurements  
 

Enter the data for each surface under the Pressure Coefficients header on the 
Openings tab. It will be possible to directly calculate wind pressure coefficients using 
DesignBuilder CFD external analysis in future versions. 
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